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Note: Much of this book is general in nature; general to the point that on occasion I have oversimplified. It is not that I
want to lie to you; I just don’t want your head to explode. Future books, classes, and experience will refine the topics
introduced here.

To paraphrase a Jack Nicholson character, “You can’t handle the truth.”
Well, not just yet.
For Classes taught by R. Craig Collins
Labs 1-9 are due at Noon Friday
Some labs require all related files to be zipped
You will use the following model to name those files yourname-labx.zip
(ie My lab 1 would be zipped as craig-lab1.zip)
Lab 10 is due the last Wednesday of the regular semester, at Noon.
This original term paper will be submitted unzipped for plagiarism detections.
Late work is barely tolerated, and if accepted, will be penalized.
Tests are conducted in class, no make up tests.
Check your email on a regular basis for updates.
Check D2L for the course syllabus and syllabus appendix, as well as for
exact due dates, directions on how to submit items,
and class related tutorials and orientations

Windows 10Windows 11 Cheat sheet
Windows 11 functions just as Windows 10 did, though visually there are a
few minor differences, like the centered task bar
But starting a program is still the same: hit the Windows Start button on
your screen
or press the Windows Start key
or
on your keyboard,
then start typing the name of the program you want to start.

2

Zipping a file Windows 10,
right click the folder or file you wish to zip,
and
select Send to >, then select Compressed

Zipping a file Windows 11,
right click the folder or file you wish to
zip, and
select Compress to Zipped file

(Zipped folder)

Viewing full file names Windows 10,
Open File Explorer
select the View menu,
click the box labeled
File name extensions

View full file names Windows 11,
Open File Explorer,
select the View menu,
select Show> and select
File Name extensions

Old Windows icons

New Windows icons
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For tips in older versions of Windows you
could use the search tool,
or Windows Help and Support

To find Tips in Windows 11,

Sign out in Windows 10,
RIGHT CLICK Start button on the screen

Sign out in Windows 11
RIGHT CLICK Start button on the screen

,
click Shut down or sign out>
select Sign out

Click Shut down or sign out>
select Sign out

click
then click
To organize windows on your monitor,
hover above the Restore button, then
select the layout you wish to use
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For Classes taught by R. Craig Collins
Labs 1-9 are due at Noon Friday
Some labs require all related files to be zipped
You will use the following model to name those files yourname-labx.zip
(ie My lab 1 would be zipped as craig-lab1.zip)
Lab 10 is due near the last day of the regular semester, at Noon.
This original term paper will be submitted unzipped for plagiarism detections.
Late work is barely tolerated, and if accepted, will be penalized.
Tests are conducted outside of class, no make up tests.
Check your email on a regular basis for updates.
Check D2L for the course syllabus and syllabus appendix, as well as for
exact due dates, directions on how to submit items,
and class related tutorials and orientations
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DOS 1 Part One: Other Resources
While this text might be of interest to anyone interested in using a computer to
manage files, those people using it as a text book for a class should be aware
that quite a bit of addition material will be made available to you, including the
syllabus, video examples, and instruction on how to use your Classroom
Management system. These are kept separate from the text book in order to
keep these other resources current and up to date. Check your student email for
information on where there resources are, and start reviewing them as part of
your class, if applicable.
Note: while the book implies use of DOS, the Windows CMD program is a great
way to master command line skills without actually using an OS (Operating
System) from 1994.
The command prompt is often how ‘Power Users’ quickly take care of tasks; just
because DOS went away does not mean the command line, and its versatility,
did.
Lab Summaries.
Just reading a book is not the best way to master operating systems, it is also
best if you practice the skills described, and then quiz yourself. If using this
book as part of a class, the lab activities and quizzes are part of the class, but
everyone should take advantage. Here is a list of the labs to be covered
Command Line
Lab 1: Learning basic commands to get help, to create and navigate directories
(also known as folders), and to create and display documents (also called files).
Lab 2: File Management; duplicating files, renaming files, changing file
attributes, plus coverage of deleting files and directories.
Lab 3: Managing hard drives, automation (Recording a series of commands to
accomplish multiple tasks, in sequence).
Windows
Lab 4: File and folder creation, basic navigation, word processing and graphics,
as well as copying and renaming files.
Lab 5: Customization of Windows, managing hard drives and programs,
automation, and recovering from problems.
Lab 6: Navigation over networks, sharing information between users and
programs.
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Linux/Unix
Lab 7: Basic commands to get help, to create and navigate directories, to create
and display documents, plus file management; duplicating files, renaming files,
changing file properties, as well as deleting files and directories.
Lab 8: Graphical user interfaces for Linux; comparison of the Windows interface
and various Linux distros
(Note: many distros can be downloaded, and the computer can boot to the OS
on the download device… and when finished the computer can boot normally to
its original OS.
Lab 9: Many Linux systems are used as Web Servers, so Lab 9 discusses
networks and the Internet, and creation of web pages.
Capstone Lab :
Comparison of Operating Systems
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DOS 1 Part Two: Interacting with the computer
Controlling file names
Locating Files
Zipping
Command Prompt at Home
Before we start with the Command Prompt, there are a few things you need to
do and understand about your Windows computer.
Controlling File Names
While the reasons for this are covered later, you really need to understand how
to tell Windows to show you the FULL file name, and extension.
Windows 7 and earlier: Open Windows Explorer, also known as My Computer or Computer
• Left click the Start button on your screen, and select ‘Computer’
• 1) Tap [Alt] key to reveal Menus, 2) select Tools, then 3) select Folder options…
• 4) Choose the View tab
• 5) De-select the check mark next to 'Hide extensions for known file types'
• Click OK

Windows 8.1 or later: Open File Explorer, also known as Computer or This PC
• Right click the Start button on your screen, and select File Explorer
• Choose View tab
• On the right of the ribbon, Select ‘File Name extensions’ to see the extensions
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Locating Files
Again, the tool used to locate files has different names:
Windows XP: Windows Explorer or My Computer
Windows Vista or Windows 7: Windows Explorer or Computer
Windows 8.1 or 10: File Explorer or This PC
… but they all refer to the same tool.
Typically you start selecting a file by first scrolling down the left hand window
until you see
Computer (Windows 7 and earlier)
or
This PC Windows 8 and later) and

then choose the hard drive, network drive, or thumb drive you wish to open.
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Zipping
You cannot email folders, nor can you submit folders to most
Classroom Management systems.
However, you can zip files or folders to email, or submit.
Zipping compresses an item or items into a small package which can be emailed
or submitted…
To do this
1) right click the file or folder,
2) select Send to 
3) choose Compressed (Zipped) folder
The resulting new item will have a zipper icon to let you know you succeeded.

Your zipped icon may vary in appearance.
Never change the extension from .zip
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Using the Command Prompt
While the best way to practice the Command Prompt is to use DOS and a floppy
disk (A:\>), this is not always an option.
Instead, you could use the Windows Command Prompt, and a Thumb Drive or
network drive.
1. Insert your Thumb Drive
2. note the drive letter assigned, such as E:\
if you miss the notification of which letter is being use, open Computer or This PC
and look to see what icon has been added.
3. Click Start and type cmd to search for the command prompt
4. DO NOT FORMAT your thumb drive, hard drive, or network drive.
5. Change to the thumb drive by typing the drive letter, followed by a colon ( : )
example E:
press the enter key
6. If you have other items on the thumb drive, you might create a folder for this class
example md floppy
7. Change to the new folder, using cd floppy
8. Your prompt should look something like below

E:\floppy>_

9. Continue your lab as directed, knowing that your prompt will display as
E:\floppy>
instead of A:\>
More on use of the command prompt shortly.
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Why learn Command Line?
Question: How do you rename a file in Windows?
Right click, select rename, type in the new name, and then hit enter.
Question: How do you rename a million files in Windows?
Right click, select rename, type in the new name, hit enter…then repeat 999,999,999 times
OR drop to the command prompt and do it with ONE command.
Windows can show you all the files in ONE folder;
the command prompt can show you EVERY file in EVERY folder.
Premise: folks who can drive a manual transmission car can drive an automatic better than
people who don’t understand what the transmission is trying to do.
So, the command line is often the fastest way to accomplish a job, and sometimes the
ONLY way to apply a command to multiple objects… such as renaming hundreds of files at
once. In some environments, the command line is the only method of taking control of the
task at hand, such as troubleshooting, or advanced networking. Plus, learning ‘paths’ from a
command line is of great benefit when writing HTML, so these skills apply to many advanced
classes or computer topics to come.
Why use DOS instead of the Windows Command Prompt?
The command prompt is the full power of Windows, implemented with commands instead of
menus and dialog boxes. When modern users open the command line, they are not faced
with the limitations of DOS, just a different way to accomplish a task. So, why use DOS if it
is available, instead of the command prompt?
Well, it is not because major differences in the commands or what they do. Most DOS and
Windows commands are identical in purpose and usage; for our purposes there are only two
commands in DOS mentioned that do not occur in Windows, simply because Windows
provides a different solution. (Most of the commands that occur in Windows, and not in
DOS, are advanced networking commands and are beyond the scope of this introduction.)
So why use real DOS if it is available? While learning the command line, it would be too
simple for students to simply switch to a Window to rename files, copy documents, create
folders, or use the Windows clipboard. Students learn the tool if that is the only tool
available.
So, DOS is an instructional, pedagogical, choice. Once mastered, you may implement the
exact same syntax in the Windows command prompt, and later, with minor tweaks, to the
Linux Terminal. But the best way to learn command line is to use it.
Having said all that, most of you, most of the time, will use the Windows Command prompt.
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The BIG PICTURE

You are part of the computing system: Hardware+Software+the User
But what is meant by hardware and software?
Hardware is what you can touch and used to be: Input+Processing+Output
but modern computers go a step further with: Input+Processing+Output+Store
that is, saving something so it doesn’t disappear when the computer is turned
off.
Software is the part of the computer you can’t touch, the data and instructions
zipping around the computer’s RAM until they are STORED as a file. But, what is
RAM? And, are there different kinds of software, just like there are different
kinds of hardware?
It turns out, before we can start talking about computers, we need to
understand some of the terms computer folks use. So, we’ll take a little time to
discuss some terms.
Don’t worry, the definitions follow.
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Glossary
BIOS
Bit
Boot
Byte
CPU
Disk
Giga...
Hardware
Hertz
Input
Kilo...
Mega...
Monitor
Output
Peripheral
RAM
ROM
Software
Zip
Next are my definitions, which are explained a little differently than your books do. Hopefully
the combination of my definitions, and the book definitions, will help you master the terms.
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Definitions
Access

Locating a file
Random access, like disks or memory, is like a music, CD, you may skip to
a favorite song;
Sequential Access, like backup tapes, is like a music cassette, you have to
go through songs to get to your favorite

Bandwidth

Transmission capacity, often incorrectly referred to as transmission speed

BIOS

Basic Input/Output System, a ROM chip used at boot up, as the OS loads

Bit

Binary Digit, a 1 or a 0, the only item a computer can understand

Byte

Binary Term, usually 8 bits, enough information to represent a typed
character

CPU

Central Processing Unit, the brains of the computer
a type of Microprocessor made up of the Control Unit (CU)
and the Arithmetic Logic Unit (ALU)

Computer
Proficiency

In order to use a computer, you don't have to be an expert, just proficient...
Being able to do basic functions with a computer

CRT

Cathode Ray Tube, a old fashioned boxy TV style monitor

Data

Facts that can be processed into useful information, input
(the user communicating with the computer, such as entering items on the
keyboard)

Desktop

The metaphor used in a Windows computer to show what files and
programs you may use, and how they are organized

DOS

Disk Operating System, a command line OS that came before Windows

File

In databases, a collection of related records; in computers in general, the
name given to a collection of stored data / instructions

Hard Disk

Long memory that keeps content even when the computer is turned off…
Auxiliary or Secondary Storage

Hardware

The part of the computer you can touch, if outside the case it is a
'peripheral'
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Hertz

Repetitions, or cycles; often related as cycles per second, as in megahertz ,
about a million cycles

Icon

A graphical element on a desktop that represents an object, such as a file
or program

I/O

Input/Output, typically a used as a hardware term.

Information

Data that has been processed info something useful; output (the computer
communicating with the user, such as results displayed on a monitor)

Kilo...

about 1000, exactly 1024; can be used with bits, bytes, or hertz

Mega...

about a million, exactly 10242; can be used with bits, bytes, or hertz

Microprocessor another name for CPU

O/S

Operating System; a subset of System software; the OS provides the
interface between the hardware, application software, and the user; i.e.
DOS or Windows

Program

A file that contains instructions, such as a word processor, Application

RAM

Random Access Memory, (should’ve been Read Write Memory)
Main Memory
Short term Memory that can hold new information
RAM is erased when the computer is turned off

ROM

Read Only Memory, memory that holds unchanging information

Software

Instructions or data in RAM; the part of the computer you can't touch;
includes System software (manages the computer, such as the Operating
System, or Utilities, or Programming) and
Application software (does something useful for the user, such as word
processing)

User Interface How the user interacts with the system software; Windows is a Graphical UI

www

World wide web; the area of the Internet that uses http protocol to transfer
files written in html;
also, the normal host name assigned to a web site, such as the www in
http://www.templejc.edu
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ZIP: A file that can contain multiple files, or more importantly, a file that is compressed to take up less
space; useful for emailing attachments, or for uploading. (See page 10)
NOTE: the ZIP contents are not always usable as is. Thus, you should not try to read or edit zip files
until you download them and extract them. If redoing a lab, delete the zip, and edit the original files.

Hardware
Computer System
Hardware  Software  You, the user
Computer Model
Input  Process  Output
Fast Food Restaurant
Input
 Process  Output
Raw Meat  Cook  packaged Hamburger
Computer
Input
 Process
 Output
Raw Data  Manipulated  Useful Information

Input
The user communicating with the computer
Input: Raw Data
Keyboards and/or Source Data Entry
Keyboards

Typewriter differences
• Note: Function Keys may be used as shortcuts for commands
• Note: [Ctrl] modifies a keyboard selection into a command
• Note: [Alt] allows you to choose an alternative

Reserved Device Name: CON Console (keyboard)
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Input
Keyboard, Continued
Enter
Execute
Ctrl + Brk
Cancel
Ctrl + S
Pause screen
F3
Re-type last DOS command
Print screen
Sends the screen to the default printer
or shift print screen
Source Data Entry
MAY NOT BE AVAILABLE IN DOS*
Source Data Entry basically refers to any input that is not a keyboard.
Source Date Entry devices include the Mouse, Track balls, and/or touch
pads; modern devices include scanners, digital cameras, microphones,
etc.)

Right mouse button: execute

Left mouse button: select

(*many source date entry devices require a driver.
Drivers are the instructions to the operating system on how a device
works. Drivers are often loaded and configured during boot;
see DOS 9, Batch files, for details on autoexec.bat and config.sys )
Reserved Device Name
AUX Auxiliary Serial Port
COMx Serial Port, x= 1, 2, 3 or 4
Serial ports move information a bit at a time, in sequence
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Process
CPU + Memory
CPU
Control Unit + Arithmetic Logic Unit
Manager
+ Workers
Scheduling + Math and Comparisons
+-*/
<=>
Machine Cycle: Fetch Decode Execute Store
Fetch: retrieve and load information
Decode: convert 1s and 0s into computer usable instructions
Execute: carry out the instructions
Store: place results of execution where it can be used
Measuring CPU speed. The number of times a computer can repeat the
machine cycle process is roughly how fast the computer is, also known as
the Clock rate, measured in Megahertz (MHz., millions of repetitions) or
Gigahertz (GHz., billions of repetitions) See page 29 for CPU comparisons.
Memory
Just as a person may use a white board for a complicated math problem
or keep a book of instructions, a computer needs two kinds of memory to
keep up with things… one changeable, and on fixed.
ROM
Read Only Memory
The contents normally don’t change.
Example: the BIOS is a ROM chip, used to boot the computer.
(Transferring the OS from disk to working memory; these direction don’t
normally change, and must always be available)
ROM is similar to a book; if you close a book; all the words will still be
there, in the same order, tomorrow, or in three years.
RAM
Random Access Memory,
perhaps should have been called Read/Write Memory
(Working memory, like a white board… new material can be added or
removed when no longer needed. RAM is typically volatile, or temporary)
RAM is like a white board; you may add a new math problem, or remove
an old math problem when solved… but it is not permanent. In most
computers, when you turn off the system, everything in RAM goes away.
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Measuring RAM
Consider a horizontal line, - .
By itself, it conveys no meaning. But if you string together /, then the -,
then a \... you can form a typed character… / - \ together forms an A.
It is the same with an operating system… a single one or zero conveys no
meaning, but if you put together a series of 1s and 0s… you can form a
typed character.
A single 1 or 0 is called a bit, short for Binary Digit.
Enough 1s and 0s to form a typed character is called a byte… short for
Binary Term.
Typically, a single word does not convey a story. You need sentences,
paragraphs, and chapters. In RAM, we signify a number of bits or bytes
using the prefixes of kilo, mega, and giga.
(There are more, but these will meet our needs for the moment.
Kilo in computer terms is 1024.
(Roughly a thousand, but that is not precise enough for this class)
So a kilobyte is 1024 typed characters.
Mega in computer terms is 1024 times 1024, or 10242.
(Roughly a million, but that is not precise enough for this class)
So a megabyte is 10242 typed characters.
A floppy disk is 1.44 MB or 1.44 Megabytes
A compact disk is 600-800 MB or 800 Megabytes
Giga in computer terms is 1024 times 1024 times, or 10243.
(Roughly a billion, but that is not precise enough for this class)
So a gigabyte is 10243 typed characters.
A DVD is 2-17 GB or 17 Gigabytes
A hard disk is 80+ GB or often in excess of 80 Gigabytes
DOS and RAM
DOS natively can only use 640 KB of RAM
In the old days, 1 MB of RAM was installed; DOS used the first 640 KB,
and the video system used the rest, called upper memory.
As more memory was needed for video, video memory was moved to the
video card, leaving more RAM available for DOS. New utilities allowed
DOS to use upper memory, and any additional memory, called extended.
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Output
The computer communicating with the user.
Soft copy
Soft copy is computer dependent, as in video on the monitor
A Monitor works with a video card to display images;
The image is a series of glowing dots of light called pixels
Monitor terms
Refresh rate: how often pixels are lit, often measure in Megahertz
(that is, each pixel is re-lit millions of times per second)
Resolution: the number of pixels across or up and down
(the more dots, the smoother the image,
more pixels requires more video memory;
DOS typically works at 640 wide by 480 high, called VGA)
Color depth: the number of colors that can be displayed
(the more colors, the more video memory is needed)
Other softcopy output
Speakers, or computer controlled devices such as lathes or auto welders
Hard copy
Hard copy is tangible (touchable) without a computer, as print on paper
A Printer often places dots of ink on paper to form typed characters, so
the term resolution, measure in dots per inch, or dpi, applies to printers.
Reserved Device Name
LPTx parallel Port, x= 1, 2, or 3
PRN Printer (if attached to LPT1)
Parallel ports move information one byte at a time.
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Storage
Four Functions of a Modern Computer
Input  Process  Output  Store
Since material cannot be added to ROM, and since RAM is volatile and
may go away, storage is needed to save data or instructions long term.
Further, storage devices may be used as an input, or an output.
RAM is primary, so storage devices are often called Auxiliary or
Secondary Storage. Most often, these devices are Disks.
Magnetic Disks, such as floppy disks or hard drives
Positive magnetic charge can be a 1, a negative charge can be a 0.
Formatting prepares a disk for use; adds organizational storage areas
A hard disk is a metal or glass disk coated with a magnetic material. As
an area of the disk could have a positive or a negative charge, this could
be interpreted as a 1 or a 0, suitable for computers to record data on.
Diagram of a disc
showing the invisible
tracks and sectors
created during
formatting.
(Actually there are many
more tracks and sectors
than shown).
Tracks are the circular
lines, similar to a bulls
eye. The tracks are
divided into sectors,
which act as 'buckets'
that can hold
information.
Sectors typically are too
small to hold an entire
file.
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The very first sector on the very first track is often used for record
keeping, an address book of sorts; in DOS, the system is called FAT.
Fragmented files take
longer to locate and load
into memory, so many DOS
and Windows disks need a
defragmentation utility to
optimize disk access.
Sectors from time to time
lose the ability to reliably
store data. This is called a
bad sector; bad sectors on
a disc volume may be
repaired with DOS’s chkdsk
or scandisk, or the Windows
Error Checking tool.

Note: the gap between the
read-write head is smaller
than smoke, hair, and even
dust. If something gets
lodged in the gap, magnetic
material is removed,
destroying the data
Floppy disks, if present, are typically called the A: and the B: drive.
The first hard drive, if present, is typically called the C: drive.
Optical Disks, such as CDs or DVDs (May not be read by DOS)
Light reflected one way can be a 1, light reflected the other can be a 0.
The first optical drive, if present, is typically called the D: drive.
NOTE: Many computers that run both DOS and Windows place DOS on the C: drive, and
Windows on the D: drive. Therefore, any optical disk assignment may start with E:

Disk Capacity

Recall, from the discussion on bits and bytes and kilo, mega, and giga:

Floppy Disk 1.44 MB
CD 800-600 MB and DVD 1.2-17 GB
Hard disk 10 MB-80 GB (old) or 80 GB and up.
10244 (Terabyte, trillions of bytes) are common, but unusable by DOS)
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ADVANCED TOPICS
Note: the following items may apply to Non-DOS command prompt
operating systems.
Non-disk storage (May not be read by DOS)
Flash drives, thumb drives, jump drives, etc. are all versions of a solid
state (no moving parts) storage concept that doesn’t require electricity
(non-volatile). Typically these devices are treated as a disk drive, and are
assigned drive letters following any hard disk and optical disks.
Other storage devices (prior to DOS)
Recall, computer storage simply requires one of two possible states that
can be read as a 1 or a 0… such as positive charge or not positive charge;
light bounced here or light did not bounce here.
An early storage method was punch card, as in 1s and 0s being assigned
as hole punched here or no hole punched here.
Magnetic tape preceded magnetic disks.
Remote Disk access: Networks
Computers read storage devices, and it doesn’t matter if the disk is in the
computer or not.
A series of computers that share information are called a Network.
LAN: If the computers are close together, they may form a Local Area
Network. Typically these computers connect via a Network Interface Card
(NIC) and cable.
WAN: If the computers are not close together, they may form a Wide
Area Network. Typically these computers connect via telephone or
wireless access.
Older systems used analog phone lines, which required a modem to
modulate or demodulate the binary signals to analog.
Note: a 4 lane freeway can move more cars that a single lane road, even
if the speed limit is the same. So often fast networks are called
broadband networks, which actually measures capacity… or how much
information is moved per second, rather than how fast it is being moved.
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Note: Hardware continues with the Motherboard, beginning on page 28.
Dial up Phone line (Cat 3 Twisted Pair) uses RJ11 connectors
Ethernet network line (Cat 5 or Cat 6 Twisted Pair) uses RJ45 connectors

Cable TV networking implement Coax (coaxial) cable and BNC connectors

Fiber Optic cable (normally many cables bundled) and FDDI connector

An analog phone line's 'speed' is measured from about 28 kilobits to 56 kilobits per second. A digital
phone line can be about 128 kilobits per second. But most broadband connections all can move at
about 1.544 megabits per second. What separates DSL from T1 and T3 broadband connections is
the additional capacity... a T1 has perhaps the capacity of about 24 ISDN 'hoses' while a T3 has the
capacity of perhaps 28 T1 'hoses.'
Connection
Dial Up
ISDN
DSL/Cable
T1
Wireless LAN
T3
Wired LAN
Fiber Optic

Capacity
14.4 to 56 Kb
~128 Kb
128 Kb~1.544 Mb
1.544 Kb
to 10 Mb
44.736 Mb
100 Mb
to 2.488 Gb

Time to download 3 MB
7 minutes to 31 minutes
3 minutes
37 seconds at 640Kb
15 seconds
1 second
less than one second
less than one second
less than one second

Notes:
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69 minutes to 5 hours
30 minutes
6 minutes at 640Kb
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Motherboard
In its most simple terms, the motherboard connects the CPU and memory
to all the other input, output, and storage devices.
The motherboard typically is stored inside a system case.
Other items typically found on a motherboard:
ROM BIOS

The ROM BIOS is the chip responsible for booting the
computer. That is, loading the operating system from disk to
RAM. THE ROM BIOS is a Read Only Memory chip that
contains the Basic Input Output System that allows the
computer to interface with the keyboard, monitor, etc.

CPU

The Central Processing Unit, the brains of the computer.

RAM

Working memory, RAM is changeable read/write memory for
short term use. RAM is volatile, and the contents are lost
when power is removed.

CMOS

The Complementary Metal Oxide Semiconductor
Think of the CMOS as a little chunk of RAM that is kept
current by a battery, and keeps track of certain settings
when the computer is off. The battery also powers the clock.
Reserved Device Name
CLOCK$ the system clock

Devices that reside outside the system case (often called peripherals)
connect to the motherboard through slots or ports.
Slots hold adapter cards for non-standard or specialized devices.
Ports connect standard devices to the motherboard.
Typical Ports:
Serial Ports
Parallel Ports
PS/2 Ports
USB or
IEEE 1394
Firewire Ports

(obsolete) for 1st generation keyboard, mouse or
modem
For 1st generation printer
For 2nd generation keyboard or mouse
For 3rd generation keyboard and mouse
Can also provide high speed access to printers and
(Non-DOS) devices such as cameras, networks, and
removable storage devices
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Note: The egg crate looking items are where cables are connected.

Aside from the video port connected to the video adapter, many modern
computers don’t have any of the above ports. They instead use multiple
USB ports for the mouse, keyboard, printer, and network card.
Many laptop computers used to use PCMCIA PC-cards, but now use USB.
The term often used for non-USB peripheral devices is legacy. Legacy slots used to
include ISA, EISA, and VESA… each slot was a different shape and color, and accepted
different kinds of adapter cards. Currently, if a computer has any slots, they typically are
PCI.

BONUS: Brief Intel CPU History
4004-8088 class
1971-1979
80286 class
1982
80386 class
1985
80486 class
1989
Pentium class (1-4)
1993-2000
Multiple Core (i3-i7)
2007-

Clock Speed
400 KHz (.4 MHZ) -5 MHz
8-16 MHz
16-40 MHz
20-100 MHz
60MHz – 1.5 GHz (~1500 MHz)
2.5 GHz and up, per core
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Software
Software is the part of the computer you can’t touch. True, you can touch
a disk on which an instruction or data is saved; this is called a file. But
touching a saved file is NOT touching software in the true meaning.
Software is the intangible data and instructions a computer is processing.
People alone can’t manipulate software. A user directs hardware to
process software.
Software is typically classified as system software or application software.
System Software
System software doesn’t really do much for users; it runs the computer.
System software includes Operating Systems, Utilities and Programming.
Operating Systems Software (OS)
Texas is part of the US, not the other way around. The OS, the topic of
this class, is a member of the larger System software family.
OS role in the computer system:

User - Operating System <

Hardware
Application Software

Aside from Operating systems provide the user access to hardware and
applications, they also provide housekeeping tools, such file location, and
the ability to create, edit, rename, copy, move, or delete files.
A user can interact with the Operating System through a command line
which, while exacting, offers the most control.
A user can also interact with the Operating System via a Graphical User
Interface (GUI). A GUI typically is easier to use, but is limited in what it
can do.
OPERATING SYTEM
DOS
Windows
Mac X
UNIX\Linux

INTERFACE
Command line only*
Graphical user interface with Command line access
Graphical user interface with Command line access
Command Line or
Graphical user interface with Command line access

*While there were tools that gave DOS a graphical look, DOS Shell and Windows 3.1 had
all the limits of DOS. These limits are covered in Chapter 2 and 3.
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Reminder: While DOS is a very simple, and limited command line OS,
many of the commands are identical to the Windows command prompt.
And both DOS and the Windows command prompt can do things that
CANNOT be done through Windows Graphical User Interface.
Thus this workbook: in order to extend Windows to its full capabilities you
need to understand the command line. In order to get the most out of
UNIX, Linux, or the Mac, you need to understand the command line.
You can learn the command line using DOS, or the Windows command
line, but using DOS sort of forces you to learn the command line…
Windows lets you bail out to the GUI. Use DOS if it is available.
Utility Software
Tools that provide computer support beyond the interface and file
management are often called utilities. Again these programs don’t really
do anything for the user, at least not directly… they keep the computer
running so the user can use it. Some utilities are purchased separately,
such as anti-virus software. However some utilities come with the
operating system; a few of these are covered in Chapter 7.
Programming support
The tools used to create operating systems, or other programs, falls in
this area. Again, these programs don’t really do anything for the user.
Programming is well beyond the scope of this book, but at the lowest
level, programming is giving the computer instructions… a simple way to
deliver a series of instructions is a Batch files, covered in Chapter 8.
Application software
Application software does some real world task for the user, such as
typing a letter, adding numbers, or listening to music. Many times
applications are called programs.
Note: a program file contains the instructions to make your word
processor work, for example. The letter you create with the word
processor can be saved in a data file.
This workbook will discuss applications only in passing, to illustrate
operating system concepts: operating systems start applications,
operating systems send what you are typing on the keyboard to the
application, and the operating system take information from the
application and delivers it to monitor or printer
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Overview 2
DOS 2-3-4

Command Prompt; Lab 1

DOS 2
Booting
IO
Command Execution
File Management
Common File extensions
Directories
Directory Trees
DOS 3

HELP

command /?
FORMAT
Optional parameters
Syntax
Changing Drives
Command Prompt change
Exploring and using Directories
DIR
MD
CD
CD .. and CD \
RD
Intro to COPY
TYPE
DEL
Paths
Limits of DOS
NOTE: IF YOU ARE NOT USING A FLOPPY DISK, PAY ATTENTION TO EXTRA NOTES IN THE LABS

DOS 4

Lab 1 Commands
Lab 1 Activities
Lab 1 Questions
To Start the WINDOWS Command Prompt: Press Start ( or
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The big three jobs of the OS are input/output (I/O), starting programs or
applications (also known as command execution), and file management.

Booting

While the ROM BIOS provides a POST (Power On Self Test) to verify the
minimum required I/O devices are present, and the BIOS has enough
control of basic I/O devices to use a disk as an input and direct the OS
files to RAM, at some point the BIOS is no longer up to the job; however,
by then there is enough of the OS in memory to control the rest of the
job, and load specific files designed to handle configuration and setup.
This is often called Real mode. Even Windows starts life just like a DOS
computer going from BIOS to Real mode… as more of the OS gets loaded
into RAM, more features become available, and Windows shifts into
Protected mode.
If the computer is completely off, the start up is called a cold boot, and
RAM is blank.
If for some reason you want or need to restart the computer (Control+Alt+Delete can force a reboot if the
computer is hung), this is called a warm boot. There is still information in RAM, which may or may not be a
good thing.

Warm boots are easier on the computer mechanically; cold boots ensure
nothing troublesome in RAM is there to interfere with the computer.

I/O

Again, while the ROM BIOS provides basic access to the keyboard,
monitor, etc., the BIOS cannot provide access to individual applications…
that is the job of the OS. Further, there are many devices that the OS can
recognize and use that the BIOS does not understand. So, some of the
files DOS loads during the end of the boot process are specifically to deal
with input and output and allows the OS to act as middleman between
hardware and applications; these files include MSDOS.SYS and IO.SYS.
Further setup and configuration will be dealt with in Chapter 8, Batch
files. Batch files don’t change the operating system, they simply
automate any tweaking a user may wish to make to the system.
Advanced topic: You may view what the BIOS can control by using the
BIOS setup. Newer BIOS chips support power saving, etc., that may not
be supported by your OS; the BIOS setup can let you turn some features
on and off… and your choices are saved in the motherboard CMOS.
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Command Execution

Starting programs is another domain of the OS. As a matter of fact, the
whole boot process is about starting a program… the OS itself. In DOS,
the main program file is named COMMAND.COM. But, there are other
small programs that are part of the OS, too, and they are called
commands.
A command is just a small program that carries out a specific task of the
operating system. And, of course, there are the larger application
program files that the OS can start as well.
The model typically used to describe starting a program is
‘Select, then do.’
In DOS, this means type out the command that starts the program or
application, and press the Enter key to let DOS know you are ready to
execute.
Commands are typed at a flashing cursor on the monitor called the
command prompt or the system prompt; the flashing cursor indicates
DOS is ready. More about the command prompt in Chapter 3.
In Windows, ‘select, then do’ may mean to click on an icon to select it, then press the
Enter key… or double click… basically the first click selects and the second click replaces
the enter key function.

File Management

When you save a file, the OS usually wants to know three things:
1) where you will save the file 2) what you want to name the file, and
3) what type of file it is. Then the File Allocation Table, or something
similar, for that disk will record where the parts of the file are stored.
These pieces, the location, file name, and file type are all assembled
using a combination of back slashes ‘\’ and periods ‘.’, called a path.
Location\File name.File type
such as

C:\test.txt
C: is the location, a ‘\’ connects the drive to the file name.
Test is the file name, and it is connect to the file type txt using a ‘.’
There is NEVER a space within a file path. (More on paths later.)
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Full file names include the file name and the file type. File types are also
called the extension, and are for DOS typically three characters, such as
the .SYS extensions for MSDOS.SYS and IO.SYS mentioned in the IO
section.
Common file type extensions
Executable files (commands and programs) end with:
bat
com or
exe
Text
txt
ltr
bak
doc
ini
hlp

files that may be read by DOS, and displayed on the screen
(perhaps used for backup copies of a text file)
(was used as documentation… now used by Microsoft Word )
(initialization files)
(help files)

Proprietary extensions used by applications or operating systems
sys for DOS system files
pdf (Adobe acrobat file)
gif
(graphic file)
jpg (image file)
htm (web page file)
rtf
(word processing file)
zip
(Zipped, compressed file)
doc (Microsoft Word word processing file, now docx)
xls
(Microsoft Excel spreadsheet file, now xlsx)
ppt (Microsoft PowerPoint presentation file, now pptx)

Directories (Folders)

Just as you wouldn’t dump all of your tax receipts into one shoe box, you
shouldn’t throw all of your program and data files randomly onto a disk.
DOS uses directories to organize files. Windows calls these folders, but
they are the same thing.
When you format a disk, part of the process is to create the ‘root
directory.’ The root directory become your filing cabinet, and will then
hold any directories or files you wish to create and store there.
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Think how paper files are organized. You open a filing cabinet drawer,
and flip though folders until you locate the logical place to drop your file.
Just as you can place a folder inside of another folder, you can place a
directory inside another directory. This is called a subdirectory.
Perhaps you are doing your taxes. After looking through your file cabinet,
you have no good place for all the receipts. You make a directory called
Taxes, and in that directory create a subdirectory called 2008 for the
year. In that directory, perhaps you create subdirectories to hold tax
forms, another for bank statements, and perhaps another for receipts.

A graphical representation of above, using a tree structured chart

The tree, as described in DOS

(root of C) C:\┐
├taxes ┐
│
├2008 ┐
│
├stmt ┐
│
│
├ file1.txt
│
├ file2.txt

Path to file1.txt

c:\taxes\2008\stmt\file1.txt

41

DOS and the Art of the Command Line
Notes

42

Overview 2 Command Prompt

DOS and the Art of the Command Line

Overview 2 Command Prompt

DOS 3

HELP

command /?
FORMAT
Optional parameters
Syntax
Changing Drives
Command Prompt change
Exploring and using Directories
DIR
MD
CD
CD .. and CD \
RD
Intro to COPY
TYPE
DEL
Paths
Limits of DOS
NOTE: IF YOU ARE NOT USING A FLOPPY DISK, PAY ATTENTION TO EXTRA NOTES IN THE LABS

To Start the WINDOWS Command Prompt: Press Start ( or

) , then type CMD

A note about the command prompt:
The command prompt is two things
1) an indicator or what the computer is looking at
and
2) a place to enter commands.
Everything to the left of the > is the path to which drive and directory the
computer is looking at…
You enter commands at the flashing line to the right of the >
Path



Where commands are entered



C:\DOS>_

Your prompt may differ from that shown in the book, as your path may differ
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HELP

The first command you need to remember is HELP.
Type in HELP at the command prompt; then press the Enter key to start a
small program that lists all the commands that are available.
DOS Help
Choose the command and press the Enter key; a description of the
command is displayed.
Note: This workbook focuses on only a few of the available commands
DOS 6.22 Help Window
File

Search

Help
MS-DOS Help: Command Reference
Use the scroll bars to see more commands. Or, press the PAGE DOWN key. For
more information about using MS-DOS Help, choose How to Use MS-DOS Help
from the Help menu, or press F1. To exit MS-DOS Help, press Alt, F, X.
<What’s New in MS-DOS 6.22?>
<ANSI.SYS>
<Append>
<Attrib>
<Batch commands>
<Break>
<Buffers>
<Call>
<Cd>
<Chcp>
<Chdir>
<Chkdsk>
<CHKSTATE.SYS>
<Choice>
<Cls>
<Command>
<Alt+C=Contents> <Alt+N=Nest>

<EMM386.EXE>
<Erase>
<Exit>
<Expand>
<Fasthelp>
<Fastopen>
<Fc>
<Fcbs>
<Fdisk>
<Files>
<Find>
<For>
<Format>
<Goto>
<Graphics>
<Alt+B=Back>

<Multi-config>
<Nlsfunc>
<Numlock>
<Path>
<Pause>
<Power>
<POWER.EXE>
<Print>
<Prompt>
<Qbasic>
<RAMDRIVE.SYS>
<Rd>
<Rem>
<Ren>
<Rename>

There are many more commands than will fit on the screen. If you are
using DOS with no mouse, you use the arrow keys to move into the
command you wish to find out about, and then press the enter key.
DOS and Windows HELP alternative
If you know the command you wish to find out about, instead of starting
HELP, you may type out the command followed by a space, then /?
Example (Note: do not type the C:\>… that part of the prompt is the current path)
C:\>FORMAT /?
This will display HELP for just this command, including optional
parameters and syntax, then return to the command prompt.
More on optional parameters and syntax after the Windows HELP screen, in FORMAT.

44

DOS and the Art of the Command Line

Overview 2 Command Prompt

Windows Help
If using Windows command prompt, the HELP screen will look similar to:
C:\>help
For more
ASSOC
AT
ATTRIB
BREAK
CACLS
CALL
CD
CHCP
CHDIR
CHKDSK
CHKNTFS
CLS
CMD
COLOR
COMP
COMPACT
CONVERT

information on a specific command, type HELP command-name
Displays or modifies file extension associations.
Schedules commands and programs to run on a computer.
Displays or changes file attributes.
Sets or clears extended CTRL+C checking.
Displays or modifies access control lists (ACLs) of files.
Calls one batch program from another.
Displays the name of or changes the current directory.
Displays or sets the active code page number.
Displays the name of or changes the current directory.
Checks a disk and displays a status report.
Displays or modifies the checking of disk at boot time.
Clears the screen.
Starts a new instance of the Windows command interpreter.
Sets the default console foreground and background colors.
Compares the contents of two files or sets of files.
Displays or alters the compression of files on NTFS partitions.
Converts FAT volumes to NTFS. You cannot convert the
current drive.
COPY
Copies one or more files to another location.
DATE
Displays or sets the date.
DEL
Deletes one or more files.
DIR
Displays a list of files and subdirectories in a directory.
DISKCOMP Compares the contents of two floppy disks.
DISKCOPY Copies the contents of one floppy disk to another.
DOSKEY
Edits command lines, recalls Windows commands, and creates
macros.
ECHO
Displays messages, or turns command echoing on or off.
ENDLOCAL Ends localization of environment changes in a batch file.
ERASE
Deletes one or more files.
EXIT
Quits the CMD.EXE program (command interpreter).
FC
Compares two files or sets of files, and displays the differences
between them.
FIND
Searches for a text string in a file or files.
FINDSTR Searches for strings in files.
FOR
Runs a specified command for each file in a set of files.
FORMAT
Formats a disk for use with Windows.

Again, this is not the full list, just what may fit on the screen.
To find Windows usage, use HELP command-name or command-name /?
Note: You may use lower case or upper case when typing commands.

A list of all the DOS commands & usage is in the DOS Appendix, near end of book

FORMAT (Not to be used on hard disk or thumb drive)
Since it is not a good idea to mess around with files on the hard drive, it
would be a good idea to use a floppy disk, if available. To prepare a
floppy disk for use with DOS or Windows, it needs to be formatted.
The way this workbook will relay information on commands will following this model:

Command Name:
Purpose:
Syntax, including common parameters.
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Example of command, purpose, and syntax:
Command Name
FORMAT
Purpose
To prepare a disk for use
Syntax
FORMAT drive:
Common parameters
/q (quick format on a previously formatted disk)
Example
FORMAT A: or FORMAT A: /q
Note: you have the option to label the disk
Make sure your prompt is NOT A:\>
Note
You can’t format a disk that is in use

What is syntax?

Syntax the rules of using a command; that is, how a command can be
used, but using generalities or place holders instead of specifics...
it should be more of a guide, or a fill in the blank starting point.
In the format command above, the syntax includes the required
elements, but uses the word drive as a place holder for an actual drive
letter. Later, items in brackets are optional.
In this workbook, the syntax is similar to what HELP would provide;
future syntax examples will include optional items that may be included.

What are common parameters?

Common parameters may be added at the end of the command to tweak
the command.
In the example above, you may add /q IF the disk has previously been
formatted, and IF you prefer to do the quick format instead of the regular
format.
Other brief examples of syntax and common parameters
md
md makes directories... but you can't just type in md by itself;
the syntax is md foldername, indicating you need to use the command,
and provide the name of the directory you are making
an example would be md lab1
dir
dir generates a directory listing
you can use dir by itself, but you can also do
dir /w for a wide directory listing
or
dir /p for a directory listing that pauses after each full screen;
so you might put the syntax as
dir [/w] [/p]
with the bracket items being optional
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Changing Drives

To tell the computer to begin paying attention to a different drive is to
change drives; type in the drive letter and a ‘:’, then press the enter key.
Example (Note: do not type the C:\>… that part of the prompt is the current path)
C:\>A:
If using a thumb drive, use the drive letter it was assigned when inserted such as e:

You will know your computer is now paying attention to the floppy disk as
the system prompt will change to reflect the current drive and directory
A:\>_
Note: in the above example, the current drive is A: and the current
directory is the root… recall, you connect drives to directories using the ‘\’
If no other directory is showing, you must be viewing the root…
so read A:\ as the root of the A drive.

Exploring and using Directories

Now that the computer is paying attention to the A: drive, we need to see
what is on the A: drive… this is done using the DIR command.
Command Name
Purpose
Syntax
Common parameters
Example

DIR
Generates a directory listing
DIR [drive:\][directory-name]
/w (wide directory listing)
/p (directory listing pauses after each full screen)
DIR
or

DIR /w
or

DIR /p
Go ahead and try DIR.
Example (Note: do not type the A:\>… that part of the prompt is the current path)
A:\>DIR
If you do not specify a drive or directory, DOS used the path in the prompt, in this case A:\
You should get a message that no files were found… this shouldn’t be a surprise as the disk was just
formatted. If using a thumb drive, or network drive, you may see some items added previously to the drive.

Let’s make a directory named test.
Command Name
MD (or MKDIR)
Purpose
Makes a directory
Syntax
MD [drive:\][directory-name\] directory-name
Common parameters
n/a
MD TEST
Example
Example (Note: do not type the A:\>… that part of the prompt is the current path)
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A:\>MD test
No news at the system prompt is usually good news… as we often do not
get confirmation that anything happened.
To verify the directory was created run DIR again… you should see
something like the following:
A:\>DIR
03/19/2008

10:26 AM
<DIR>
test
0 File(s)
0 bytes
1 Dir(s)
1.400 bytes free

You should see buried in all the information: <DIR> test.
This verifies a directory named test exists. Let’s see what is inside
Command Name
Purpose
Syntax
Common parameters
Example

CD
To change directories
CD [drive:\][directory-name\] directory name
n/a
CD TEST

A:\>CD test
Should yield the new system prompt
A:\TEST>_
Indicating the computer is now paying attention to the test directory on
the root of A: (Your results may differ if using a different drive letter.)
Fire off a DIR. You may expect to see an empty directory, but instead you
see something like:
A:\TEST>DIR
03/19/2008
03/19/2008

10:26 AM
10:26 AM

<DIR>
<DIR>

0 File(s)
2 Dir(s)

.
..

0 bytes
1.400 bytes free

For now, ignore the . Try the following
A:\TEST>CD ..
Your system prompt should show the root of your drive, A: in my case.
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So, CD directory-name changes us into a directory, and CD .. changes
us back out of the directory.
If we had something like the following:

And our prompt indicated we are in the stmt directory
A:\taxes\2008\STMT>_
Then CD .. would back us out of STMT to 2008
A:\taxes\2008\STMT>CD ..
Changing the system prompt to
A:\taxes\2008\>_
What if we quickly wanted to change to the root directory ?
Recall, the root directory of A: is indicates as A:\
So to change directories to the root, use CD \
A:\taxes\2008\STMT>CD \
Careful, cd \ on a hard drive would change to where important files are.
You may need to use cd .. repeatedly to get back to where you started.
And our prompt will then indicates we are now in the root directory
A:\>_
Let’s modify our CD syntax to include the following
Command Name
CD
Purpose
To change directories
Syntax
CD [drive:\][directory-name\] directory name
Common parameters
n/a
CD TEST
Example
CD .. to change out of the current directory
CD \ to change to the root directory
Now, let’s get rid of that empty directory; but first, an analogy.
If a farmer has an old barn that may fall over, he may instead decide to
demolish the barn. So, he loads up the barn with TNT.
Do you suppose he wants to be in that barn when he blows it up? No.
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The same logic is applied to formatting drives and removing directories…
your system prompt MUST indicate you are NOT in the directory…
so use CD .. first
Command Name
Purpose
Syntax
Common parameters
Example

RD (or RMDIR)
To remove an empty directory
RD [drive:\][directory-name\] directory name
n/a
RD TEST

Up until now, all we have dealt with are directories, and directories are
only used to organize files. We need some files to look at. The problem is
of course, a newly formatted disk has no files. Our solution is to use copy.
Note: a more detailed discussion of copy will follow.

Intro to COPY
Command Name
Purpose
Syntax

Common parameters
Example

COPY
Duplicates files

COPY [drive:][\directory-name\]source [drive:][\directory-name\]destination

COPY source destination
n/a
COPY file1.txt file2.txt

Any place you see Source in this book, it means the path to
“where is the file now, and what is it called?”. (more on paths on p. 48)
Destination means the path to
“where is the file going, and what will it be called?” You may specify
exactly where the file is, but you may omit anything that is part of your
prompt… so from here on out I’ll use COPY source destination instead of
COPY [drive:][\directory-name\]source [drive:][\directory-name\]destination

with the understanding that I can include specifics, if needed.

At first glance, the syntax seems lacking. Let’s say for the time being
source simply tells the computer where to find the data to be copied and
destination tells the computer where you want the file to be copied, and
what you want to call it.
But this still seems to leave us short, as now we don’t have data to copy.
The magic solution? The keyboard can be a source; recall the reserved
device name for the keyboard, (in the Hardware section of Orientation) is
CON.
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Now we can plug in CON for source, and let’s call the file we are copying
from the keyboard to the disk test.txt.
Change the syntax of
COPY source destination to
COPY CON test.txt
When the command is entered, you get a flashing cursor without a
prompt… this is where you type the source data.
A special keyboard sequence will be used to signal the end of typing.
Example
A:\>COPY CON TEST.TXT
At the flashing cursor, type in something like your name
A:\>COPY CON TEST.TXT
_
A:\>COPY CON TEST.TXT
Craig
When finished, press and hold the Control key, press the Z key, and let
go.
Recall, the Control key turns other keys into commands.
One way to remember this sequence is to say you are finished typing in
your data from A to Z… Control+Z
Note: The computer displays ^Z, but you can’t type ^Z… it is [Control]+Z
When finished you should see something similar to
A:\>COPY CON TEST.TXT
Craig ^Z
One file copied
A:\>_
To verify the file was created, at the flashing system prompt type in DIR
A:\>DIR
03/19/2008

11:29 AM
1 File(s)

5 test.txt
5 bytes

Recall, a byte is a typed character.
Craig has 5 typed characters, hence 5 bytes for my example.
But how can we read the contents of the file, to verify it contains what we
typed?
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TYPE
To display the contents of a text file
TYPE [drive:\][directory-name\] file-name
n/a
TYPE TEST.TXT

To verify the file, at the flashing system prompt type TYPE TEST.TXT
The contents of the text file will display, then return to the prompt
A:\>TYPE TEST.TXT
Craig
A:\>_
Finally to wrap up our introduction to commands, let’s get rid of the
test.txt file
Command Name
Purpose
Syntax
Common parameters
Example

DEL
To delete a file
DEL [drive:\][directory-name\] file-name
n/a
DEL TEST.TXT

A:\>DEL TEST.TXT
A quick DIR should verify the file is gone… and your disk should be back
the way it was before you began.

Paths

Any place you encounter
[drive:\][directory-name\] file-name
in syntax, this means you may supply a drive letter, or directory names.
If our prompt is
A:\directory1\>
But we wish to type out file1.txt
We could
cd ..
cd taxes
cd 2008
cd stmt
type file1.txt
Or we could simply use the path, and tell the computer where to look in
on statement by suppling the drive and directories info
type a:\taxes\2008\stmt\file1.txt
Anything that is part of the system prompt may be left out of the command.
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Visualizing a path in Windows using ‘My Computer or This PC'
If you were to do the above example in Windows
• Open My Computer, also called Computer or This PC
• Select (double click) the 3 1/2 Floppy (A:) to see the lab1,.
• Select (double click) the lab1 folder to see the taxes folder
• Select (double click) the taxes folder to see file1.txt, and file2.txt
As you do double click to open drives and folders, the address bar keeps
track of where the computer is looking...
The \ (backslash) is used to connect the drive to a folder, a folder to
another folder, or a folder to a file. The full path for file1.txt would be:
A:\LAB1\TAXES\file1.txt
start

end

Limits of DOS

While for pedagogical reasons, DOS is a great way to start command
lines, DOS went away for a reason… it was limited in what it could do.
DOS can only do one thing at a time.
DOS file names are limited to 8 characters, with 3 characters for the extension…
no spaces allowed.
DOS cannot efficiently use more than 640KB RAM
DOS cannot efficiently use large hard drives
DOS cannot use many modern input and output devices
No modern software is designed to run on DOS.

None of these limits prevents one from using DOS as a learning tool.
The Windows command prompt does not have the above limits, but really
doesn’t add anything from a learning point of view.
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DOS 4

Lab 1 Commands
Lab 1 Activities
Lab 1 Questions
To Start the WINDOWS Command Prompt: Press Start ( or

) , then type CMD

At the end of this process, there is a quiz based on the following questions and
activities. So, to get the best score, fill in all the answers in this document first.
1. FORMAT
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command is entered into DOS
2. MKDIR or MD
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command is entered into DOS
3. CD
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
What does cd .. mean? What does cd \ mean?
Write out one example of how the command is entered into DOS
4. DIR
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Are there any common parameters mentioned in class? List them
Write out one example of how the command is entered into DOS
While we haven’t used this command yet, get help by typing tree /?
5. TREE
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Are there any common parameters mentioned in class? List them
Write out one example of how the command is entered into DOS
More on the TREE command in the following Overview.

A list of all the DOS commands & usage is in the DOS Appendix, near end of book

See Overview 3 for other useful commands, such as copy and type.
Check Class website or YouTube for a short video similar to Lab1
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Activity
Recreate the following in DOS or the Windows command prompt,
using these steps.
A:\>tree /f
Folder PATH listing for volume
Volume serial number is
A:.
└──lab1
└───taxes
├───2007
│
├───qtr1
│
├───qtr2
│
├───qtr3
│
└───qtr4
│
bankstmt.txt
└───2008

Don't type the part of the instruction that represents the prompt, such as C:\> or A:\>
Optional: Format your floppy disk, if needed; DO NOT FORMAT C: or thumbdrives
C:\>format a:

□ 1. Change to your drive (any available drive; examples use A:, If working with no floppy
C:\>a:

use network drive, or USB drive , ie f:or O:,perhaps md floppy, then cd floppy)

Once you have accessed where you will be doing your work:

□ 2. Make a Directory (folder) named lab1
A:\>md lab1

(Again A:\> is not part of the command, your prompt may differ.)

□ 3. Verify the Directory was created by requested a Directory Listing
A:\>dir

□ 4. Change into the Directory named lab1
A:\>cd lab1

□ 5. Make a Directory (folder) named taxes
A:\lab1>md taxes

□ 6. Verify the Directory was created by requested a Directory Listing
A:\lab1>dir

□ 7. Change into the Directory named taxes
A:\lab1>cd taxes

□ 8. Make a Directory named 2007
A:\lab1\taxes>md 2007

□ 9. Make a Directory named 2008
A:\lab1\taxes>md 2008

□ 10. Change into the Directory named 2007
A:\lab1\taxes>cd 2007

□ 11. Make a directory for Quarter 1
A:\lab1\taxes\2007>md qtr1
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(continued)

□ 12. Make a directory for Quarter 2
A:\lab1\taxes\2007>md qtr2

□ 13. Make a directory for Quarter 3
A:\lab1\taxes\2007>md qtr3

□ 14. Make a directory for Quarter 4
A:\lab1\taxes\2007>md qtr4

□ 15. Change into the Directory named qtr4
A:\lab1\taxes\2007>cd qtr4

□ 16. Copy data from the Console to a file named bankstmt.txt

A:\lab1\taxes\2007\qtr4>copy con bankstmt.txt (then Enter)
Type your name
Press [Ctl]+Z to end the file, and return to DOS
1 file(s) copied.

□ 17. To read the contents of the file

A:\lab1\taxes\2007\qtr4>type bankstmt.txt

□ 18. Change into the directory one step higher than qtr 4
A:\lab1\taxes\2007\qtr4>cd ..

□ 19. If using a floppy, change to the root directory (\) in one step

A:\lab1\taxes\2007>cd \
(if not using floppy, cd .. and repeat until at the starting point, such as e:\floppy> )

□ 20. Display the entire disk structure with files
A:\>tree /f

Your screen should look like the image.
A:\>tree /f
Folder PATH listing for volume
Volume serial number is
A:.
└──lab1
└───taxes
├───2007
│
├───qtr1
│
├───qtr2
│
├───qtr3
│
└───qtr4
│
bankstmt.txt
└───2008

Quiz on Hands On Activity (the Quiz in D2L is 60% of your grade)
Answer the following questions based on this lab to prepare you for the D2L quiz
Question 1 (2 points)
The format command
a) displays the contents of a directory, including sub-directories
b) prepares a disk for use
c) changes into to a directory
d) generates a listing of the specified directory
e) creates a directory
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Question 2 (2 points)
Syntax: format
a) format source destination
b) format [drive]:
c) format directoryname
d) format source
Question 3 (2 points)
What is typed after the C:\> prompt to format the floppy?
a) a: format
b) a:\ format
c) format a:
d) format a:\
Question 4 (2 points)
The MD (or MKDIR) command:
a) changes into to a directory
b) prepares a disk for use
d) generates a listing of the specified directory
c) displays the contents of a directory, including sub-directories
e) creates a directory
Question 5 (2 points)
Syntax: MD
a) md /w
b) md directoryname
c) md source destination
d) md [drive]:
Question 6 (2 points)
What would you enter after the prompt to make or create a directory named junk?
a) md a:
b) rd junk
d) cd junk
d) md junk
Question 7 (2 points)
The command CD
a) creates a directory
b) changes into to a directory
c) displays the contents of a directory, including sub-directories
d) prepares a disk for use
e) generates a listing of the specified directory
Question 8 (2 points)
Syntax: CD
a) cd /w
b) cd source destination
d) cd directoryname
d) cd [drive]:
Question 9 (2 points)
The following is the correct use of change directory cd a:
a) True
b) False
Question 10 (2 points)
The DIR command
a) creates a directory
b) displays the contents of a directory, including contents of sub-directories
c) changes into to a directory
d) generates a listing of the specified directory
e) prepares a disk for use
Question 11 (2 points)
Syntax: DIR
a) dir [directoryname] [/w] [/p]
b) dir source destination
c) dir
d) dir [drive]:
Question 12 (2 points)
To get your directory listing in columns across the whole screen is
a) dir /p
b) dir /w
c) dir
d) p /dir
e) w /dir

58

DOS and the Art of the Command Line

Overview 2 Command Prompt

Question 13 (2 points)
The tree command
a) displays the contents of a directory, including sub-directories
b) creates a directory
c) generates a listing of the specified directory
d) changes into to a directory
e) prepares a disk for use
Question 14 (2 points)
Syntax: TREE
a) tree [directoryname] [/f]
b) tree /w
c) tree [drive]:
d) tree source destination
Question 15 (2 points)
Which DOS command shows the contents of a directory, as well as the file contents of any
sub-directory?
a) tree /f
b) dir
c) tree
d) dir /f
Question 16 (3 points)
What would be typed after the prompt to get help with all the DOS commands?
a) man
b) DOS /?
c) help
d) F1
Question 17 (3 points)
What is the command you would enter in DOS to format the floppy, if needed?
Not just the command but what needs to be typed after the prompt to actually format the
floppy c:\>____________
Question 18 (3 points)
Enter what would be typed after the prompt change from the C drive to the A drive
c:\>___
Question 19 (3 points)
Enter what would be typed after the prompt to generate a directory listing
c:\>____
The remaining questions assume you are using the floppy disk to complete the activity
DO NOT INCLUDE THE A:\> prompt when choosing your responses.

Question 20 (1.5 points)
What would be typed after the A:\> prompt to change from the root to the lab 1 directory?
a) md lab 1
b) cd lab 1
c) rd lab 1
d) lab1
Question 21 (1.5 points)
What would be typed after the A:\lab1> prompt to change from the lab1 directory to the
taxes directory?
a) md taxes b) cd taxes c) rd taxes
d) taxes
Question 22 (1.5 points)
What would be typed after the A:\lab1\taxes> prompt to change from the taxes directory to
the 2007 directory?
a) cd taxes\2007
b) cd 2007 c) 2007
d) md taxes\2007
Question 23 (1.5 points)
What would be typed after the A:\lab1\taxes\2007> prompt to change from the 2007
directory to the qtr4 directory?
a) cd qtr4
b) md taxes\2007\qtr4 c) cd taxes\2007\qtr4
d) qtr4
Question 24 (3 points)
What would be typed after the prompt to display the contents of the bankstmt.txt file?
a:\lab1\2007\qtr4>____ bankstmt.txt Only supply the missing command.
Question 25 (3 points)
Enter what would be typed after the prompt to change from the qtr4 directory to the 2007
directory NOTE: the cd command is already there... what goes after cd?
a:\lab1\2007\qtr4>cd __
Question 26 (3 points)
Enter what would be typed after the prompt to change from the 2007 directory to the root
directory Note: the cd is already there, what goes after the cd?
a:\lab1\2007\>cd __
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This page is for Collins classes, check with other faculty if this book is used for a class;
In Windows, zip the entire lab1 directory & rename in the form of yourname-labx.zip. ie craig-lab1.zip

Zipping files, if required to turn in, zip as follows:
When you wish to email or upload several files and folders, the best way to do this is
to 'zip' them.
Using My Computer or This PC in Windows:
1. select the file(s) you wish to zip (hold down the control key to select multiple files)
1. Right click the selected item
(if you have selected several items, right click one of them)
2. Choose Send To
3. Choose Compressed (zipped) Folder
4. The new file will be created in the same location
5. Rename the file to the form yourname-labx.zip

Renaming files

When you wish rename a file:
1. Select the file you wish to rename
2. Right click the file
3. Choose Rename
(Note the three character extension if visible, before proceeding)
4. Once the name is selected you type in the new filename to replace the old
5. Make sure the extension, if visible, remains the same
6. When finished, press the [Enter] key.

Submitting Files and/or Folders

1. If using D2L, Choose the class for which you want to drop off an assignment.
2. Find the Dropbox tool, click on it.
3. Choose the appropriate Dropbox folder, click on it.
4. Choose [Add a File], then choose [Browse] or [Upload] Button
You then may need to choose Computer to browse for your file
5. Find the file that you would like to upload and click [Open], then choose [Add]
6. Type in a short description or comment about the file, if you like.
7. Select [Add] for any additional files that may be pertinent, and repeat
8. After your files have been selected, click [Submit].
9. Some files may take a long time to upload (especially if graphics are in the file).
Check your class web site for specifics on how to upload files and or take quizzes.

Submitting the Quiz

1. If using D2L, Choose the class for which you want to take the quiz.
2. Choose the Quizzes menu, and locate Lab 1.
3. Answer the questions based on this documentation.. SAVE EACH ANSWER.

4. WHEN FINISHED, PRESS SUBMIT
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DOS 5 Internal and External Commands

Internal Commands
External Commands
TREE
Wildcards
DOS 6
Lab 2 Commands
Lab 2 Activities
Lab 2 Cheat Sheet
Lab 2 Questions
End chapter 3

To Start the WINDOWS Command Prompt: Press Start ( or
Note: Command Reference in Appendix A

61

) , then type CMD

DOS and the Art of the Command Line Overview 3 External Commands
DOS 5

Internal Commands
External Commands
As DOS must fit in a very small chunk of RAM, it probably is not
surprising that not all DOS commands get loaded into memory during the
boot process. Only the commands that are a part of command.com are in
RAM at all times. The remaining DOS commands typically reside in a
directory on the C: drive called DOS (C:\DOS), and are loaded into RAM
when the command is actually used.
For all practical purposes, the most common commands are internal, and
the newer or less frequently used commands are external.
As far as usage goes, however, there is no difference.

INTERNAL DOS COMMANDS

A short list of the most frequently used internal commands, many of
which were covered in Chapter 3.
CLS, used to clear the screen
Syntax CLS
COPY, used to duplicate files
Syntax, see Chapter 3
DATE, used to display or change the system calendar
Syntax DATE [mm-dd-yy]
DEL, used to remove a file
Syntax, see Chapter 3
MD, used to make an empty directory (may use MKDIR)
Syntax, see Chapter 3
RD, used to remove an empty directory (may use RMDIR)
Syntax, see Chapter 3
DIR, used to generate a directory listing
Syntax, see Chapter 3
REN (RENAME), used to rename a file
Syntax REN source destination
TIME, used to display or change the system clock
Syntax TIME [hh:[mm:[ss]]]
TYPE, used to display the contents of a text file
Syntax, see Chapter 3
VER, used to display the DOS or Windows version
Syntax VER
VOL, used to display the volume label
(labels are normally set with FORMAT, and changed with LABEL)
Syntax VOL [drive:]
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Really useful ‘new’ Internal commands.
After entering a lot of DOS commands, your screen is junked up with a
record of previous commands given; to wipe the screen clean and get
back to a pristine system prompt, use CLS
Command Name
CLS
Purpose
Clears the screen
Syntax
CLS
Common parameters
n/a
CLS
Example
While COPY technically was introduced in lab 1, we used a very limited
subset of COPY… copying from the keyboard (CON).
Command Name
Purpose
Syntax
Common parameters
Example

COPY
Duplicates files
COPY [path\]source [path]destination
n/a
COPY file1.txt file2.txt

A few rules.
1. Memorize copy source destination, you will use it often.
2. If no path is specified, it is assumed you mean the path shown in the
system prompt.
3. No files can have the same full filename in the same directory,
but files in different directories may have the same full file name.
Some examples of COPY
A:\> COPY file1.txt file2.txt
copies file1.txt in the current directory (A:\), to the same directory (A:\)
and calls the duplicated file file2.txt (the full file name is different)
A:\> COPY file1.txt file1.ltr
copies file1.txt in the current directory (A:\), to the same directory (A:\)
and calls the duplicated file file1.ltr (the full file name is different)
A:\> COPY file1.txt C:\file1.txt
copies file1.txt in the current directory, (A:\), to C:’s root (C:\)
and calls the duplicated file file1.txt
A:\> COPY C:\file1.txt file1.txt
copies file1.txt in C:’s root (C:\) to the current directory (A:\),
and calls the duplicated file file1.txt
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Rename behaviors in a similar fashion, REN source destination, but there
is one caveat… you identify where the file is with the source, so
no path is allowed for the destination… just what it will be called.
Command Name
Purpose
Syntax
Common parameters
Example

REN or RENAME
Renames files
REN [path\]source destination
n/a
REN file1.txt file2.txt

Some examples of REN
A:\> REN file1.txt file2.ltr
takes file1.txt in the current directory (A:\),
and renames the file to file2.ltr
A:\> REN C:\file1.txt file2.ltr
takes file1.txt in the C:’s root (C:\),
and renames the file that is the previously specified directory to file2.ltr

EXTERNAL DOS COMMANDS

Available commands not loaded into RAM at boot include the following:
ATTRIB, used to display or change attributes
Syntax ATTRIB [±R or A or S or H] [filename]
CHKDSK, used to display a status report of a disk, or
Fix errors in the File Allocation table
Syntax CHKDSK [drive:] [/f]
Replaced by SCANDISK
*DELTREE, not available in all versions of Windows, used to remove
non-empty directories DANGEROUS, use with caution
Syntax DELTREE [path]
DISKCOPY, used to copy a floppy
Syntax DISKCOPY source destination
LABEL, used to change a disk’s volume label
Syntax LABEL [drive:] [new volume label]
TREE, used to display directories, but unlike DIR,
Tree can also display the contents of subdirectories (files)
Syntax TREE [path] [/f]
*UNDELETE, not available in Windows (replaced by the recycle bin)
May be able to recover recently deleted files
Syntax UNDELETE [path\] [filename]
XCOPY, used to copy files and directories, including empty directories
Syntax XCOPY source destination [/e]
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Attrib is for attributes. The attributes a file can have are
Read Only: the file cannot be deleted nor existing material changed
Archive: the file has never been backed up and is in need of archiving
System: a DOS file
Hidden: the file is not visible to any DOS command aside from ATTRIB
Neither read only or hidden files can be deleted, so if you are getting an
error, check attrib.
Command Name
Purpose
Syntax
Common parameters
Example

ATTRIB
used to display or change attributes
ATTRIB [±R or A or S or H] [path\][filename]
n/a
ATTRIB +R file1.txt

Some examples of ATTRIB
A:\> ATTRIB
RA

file1.txt

Displays all the attributes of files in the current directory;
In this case file1.txt is Read Only, and has never been backed up.
A:\> ATTRIB -R file1.txt
Removes the Read Only attribute from file1.txt
A:\> ATTRIB +H file1.txt
Adds the Hidden attribute to file1.txt
Not only is the file protected from deletion, it will not list using DIR, etc.
DELTREE is worth mentioning, even if it is no longer used in Windows.
As RD will not delete a directory with contents, DELTREE was how you could quickly
delete a bunch of stuff… and perhaps including items you didn’t want to get rid of.

DISKCOPY is handy if you want to make copies of floppies. It is what is called a
bit copy, that is, instead of copying files, it copies the pattern of 1s and 0s on
the disk. The disks must match, as in 3.5 inch 1.44MB floppy and another 3.5
inch 1.44MB floppy. As many computers only have one drive, half way through
you are prompted to replace the source with the destination… meaning the copy
temporarily resides in RAM. If a disk has bad sectors and CHKDSK has marked
those sectors to be avoided, the copy will also avoid the same sectors.

Command Name
Purpose
Syntax
Common parameters
Example

DISKCOPY
Duplicates floppy disks
DISKCOPY source destination
n/a
DISKCOPY A: A:

65

DOS and the Art of the Command Line Overview 3 External Commands

TREE

A great command, snuck in to Lab 1, is TREE. By itself, it is little more
than a glorified DIR… but jump to the root and add the /f, and this
command can show you every directory on your disk, and every file in
those directories… DIR can only show you the contents of the current
directory. This command has no equal in Windows.

Compare the following:
A:\>tree /f
Folder PATH listing for volume
Volume serial number is
A:.
└──lab1
└───taxes
├───2007
│
├───qtr1
│
├───qtr2
│
├───qtr3
│
└───qtr4
│
bankstmt.txt
└───2008

In the Windows My Computer or This PC view, the folders button has
been turned on to let you see all of the subdirectories stored in the 'taxes'
folder... the problem is, that is all you can see... folders. You still must
open each folder to see if there are any files.
Now look at the tree /f command results to the right. Not only can you
see the directories in taxes, but you can also see the single file that is
there.
Command Name
Purpose
Syntax
Common parameters
Example

TREE
To display a tree structure
TREE [drive:\][directory-name\]
/f (will display directories and directory contents)
Tree /F
or tree a:\ /f
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WILDCARDS

So while your GUI is handy, that TREE command is unequaled in
Windows. And there is another trick in the command line that makes it a
required skill for power users.
Before we begin discussing the next generation copy command, what if
you wish to copy more than one file at a time, or for that matter, delete
more than one file at a time, or perhaps rename more than one file at a
time.
Windows finds it impossible to rename multiple files.
A wildcard can be used when a DOS command should be applied to
multiple files.
The two wildcard are * and ?
*, the asterisk (computer people call it star) can mean anything, or
nothing, and range over multiple characters in a filename.
?, the question mark can mean something, for a specific character
position in a filename or file type.
Some quick examples.
If you wish to delete all files in a directory
DEL *.*
Read this as DEL any filename with any file type extension.
If you wish to delete all the files that end in .txt, use
DEL *.txt
Read this as DEL any filename as long as it ends in .txt
IMPORTANT RULE: If using a wildcard for the source, duplicate
the same wildcard pattern for the destination.
If you wish to copy file1.txt and file2.txt, but not file10.txt or file.txt use
COPY a:\file?.txt c:\file?.txt

Note: the ? is in the 5th character spot. ? wont get file10.txt as it doesn’t cover the 6th
spot, and wont get file.txt because there is no 5th spot in the filename.

Read COPY a:\file?.txt c:\file?.txt as copy from the root of A: anything
that starts with file followed by one character, that ends with .txt, and
copy it using the same names to C:
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Wildcard scenarios
Scenario:
A:\
file.txt
file1.txt
file2.txt
file3.txt
file4.txt
file10.txt
fred.txt
file.doc
file1.doc
file2.doc
file3.doc
file4.doc
file10.doc
fred.doc

If you wished to select any file, as long as it ends with .txt you would use:
*.txt (could be read anything.txt)
This would select
file.txt
file1.txt
file2.txt
file3.txt
file4.txt
file10.txt
fred.txt
but not any file that ends with .doc

Scenario:
A:\
file.txt
file1.txt
file2.txt
file3.txt
file4.txt
file10.txt
fred.txt
file.doc
file1.doc
file2.doc
file3.doc
file4.doc
file10.doc
fred.doc

If you wished to select any file, as long as it starts with the letters file you would use:
file*.* (could be read fileanything with any extension)
This would select
file.txt
file1.txt
file2.txt
file3.txt
file4.txt
file10.txt
file.doc
file1.doc
file2.doc
file3.doc
file4.doc
file10.doc
but not fred.txt or fred.doc

Scenario:
A:\
file.txt
file1.txt
file2.txt
file3.txt
file4.txt
file10.txt
fred.txt
file.doc
file1.doc
file2.doc
file3.doc
file4.doc
file10.doc
fred.doc

If you wished to select any text file, as long as it includes a single digit number you would
use:
file?.txt (could be read file something if only in space number 5.txt)
This would select
file1.txt
file2.txt
file3.txt
file4.txt
but not
file.txt (no 5th character in the filename) or file10.txt (? works only for space 5, not space 6)
or any file that ends with .doc

If you wished to select any txt file, as long as it starts with file you would use:
file*.txt (could be read fileanything.txt)
This would select
file.txt
file1.txt
file2.txt
file3.txt
file4.txt and file10.txt
but not fred.txt or any file that ends with .doc

If you wished to select any file, with any extension, (all) you would use:
*.* (could be read any file with any extension)
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Before we got sidetracked discussing wildcards, a newer version of the
COPY command was mentioned. COPY is great at copying files, but not so
good at copying directories, especially empty directories.
You never mess with an existing command, you come up with a new
command that does what you want. That command is XCOPY.
This doesn’t mean you abandon COPY. You don’t drive a 2 penny nail with
a 12 lb. sledge hammer… you use the appropriate tool for the job. When
copying files, use COPY, when copying directory structures, use XCOPY.
And just as tree works best with /f, XCOPY works best with /e
(think Everything, including Empty subdirectories).

XCOPY

Command Name
Purpose
Syntax
Common parameters
Example

XCOPY
Duplicates files and directories
XCOPY [path\]source [path]destination
/e
XCOPY dir1\*.* dir2\*.* /e

Note that the example above is copying dir1 AND all the files in dir1,
using wildcards for the source; so the same wildcard pattern is used in
the destination, followed by the /e.
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DOS 6

Lab
Lab
Lab
Lab

2
2
2
2

Commands
Activities
Questions
Cheat sheet

To Start the WINDOWS Command Prompt: Press Start ( or

) , then type CMD

Make a folder named Lab2 on your floppy, thumb drive, or network drive, ie f: or o:

At the end of this process, you will be taking a quiz based on the following
questions. So, to get the best score, fill in all the answers in this document first.
Documentation 30%
COPY
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command was entered in this lab
XCOPY
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Are there any common parameters mentioned in class? List them
Write out one example of how the command was entered in this lab
ATTRIB
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Are there any common parameters mentioned in class? List them
Write out one example of how the command was entered in this lab
RENAME or REN
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command was entered in this lab
UNDELETE (DOS ONLY)
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command was entered in this lab
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DOS Activity (There is a cheatsheet on the next page…)

□ 1. Create a file called test.txt (put your name for the file contents)
Refer to Lab 1, for a reminder on creating a file.

□ 2. Create a directory named LAB2
□ 3. Create a directory named TEST inside of LAB2
□ 4. Copy test.txt from the root of A: to inside LAB2
□ 5. Copy test.txt from the root of A: to inside LAB2, but call the new copy test.ltr
□ 6. XCOPY LAB2, and its files, to a new folder named LAB2BKUP
Verify the empty TEST folder was copied as well
At this point, if you run tree /f it should look like

A:\>tree /f
Folder PATH listing for volume
Volume serial number is
A:.
│
test.txt
│
├───lab2
│
│
test.txt
│
│
test.ltr
│
│
│
└───test
│
└───lab2bkup
│
test.txt
│
test.ltr
│
└───test

□ 7. Set a:\test.txt to be a hidden file
□ 8. Generate a directory listing to verify the file is hidden
□ 9. Set a:\test.txt to no longer be a hidden file
□ 10. Type out the contents of test.txt
□ 11. Rename all of the files in LAB2 from test.something to homework.something,
but leave the extensions the same (ONE command, using a wildcard)

□ 12. Rename a:\test.txt to test.doc
* DOS only, skip if using command prompt: Delete test.doc then undelete test.doc
Clear your screen, then run a tree /f to see if your screen is similar to mine
If you are required to submit items for grading, Select ALL items created:
test.doc, lab2, and lab2bkup. Zip them together & submit as instructed .
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Lab 2 Cheat sheet

□ 1. In lab 1, we created a FILE by misusing the copy command. Instead of copying from one file, we can also
copy from the keyboard, called con.

Copy syntax copy source destination
In lab one, we did copy con bankstmt.txt, so for lab two it would be copy con ____.txt

□ 2. After Making a Directory md ___
□ 3. if we wish to make another directory inside of it, we should first open, or Change Directors, or specify
where it is going, and what it would be called md lab2\ ___

□ 4. To copy your file from the root directory to a spot inside the lab2 directory, again consider the Copy
syntax:
copy source destination which could be expanded to
copy [path\]source [path\]destination

The path is the where we look, perhaps starting with the drive, and directories, in order to point to a file.
Now look at what we are trying to make
A:\>tree /f
Folder PATH listing for volume
Volume serial number is
A:.
│
test.txt
│
├───lab2
│
│
test.txt
│
│
test.ltr
│
│
│
└───test
│
└───lab2bkup
│
test.txt
│
test.ltr
│
└───test

To locate the source, take your finger, and start at the upper left. That gives us the beginning of the path: A:
Remember, the directory that holds everything is the root directory, and it is represented with \
so, the root of the A drive is A:\
Every time you want to connect a drive to a directory, a directory to a directory, or a directory to a file, you are
moving down the tree, sort of like
, so use \
So, the path to our source, where test.txt is right now, is
A:\test.txt
So, the path to where we want to copy that file would be A: + \ + lab2 + \ or A:\lab2\
and since I didn’t specify a different name, we would just reuse test.txt for a destination of
A:\lab2\test.txt
Plug this in to our syntax,
copy [path\]source [path\]destination
and you get
copy a:\test.txt A:\lab2\test.txt

□ 5. If we want to rename the file as we copy it, plug the new name in to our syntax,
copy [path\]source [path\]destination
and you get
copy a:\test.txt A:\lab2\test.ltr

□ 6. If we want to copy files and directories, including empty directories, the syntax is

xcopy [path\]source [path\]destination /e, or with wildcards an example would be
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Cheat Sheet, continued
xcopy lab2\*.* lab2bkup\*.* /e

□ 7. ATTRIB

[±R or A or S or H] [path\][filename] leads to ATTRIB +h test.txt

□ 11/12. If we want to rename a single file, the syntax is

ren [path\]source destination
So to rename a single file in the lab2 folder from test to homework, you would use
ren A:\lab2\test.txt homework.txt
But, to rename multiple files, we need to use a wildcard.
The logic is “I am trying to rename test files, regardless of the extension”, so the wild card pattern would be
test.*
The logic continues “I am trying to rename test to homework, regardless of the extension”, homework.*
So, the command should be
ren A:\lab2\test.* homework.*
A:\>tree /f
Folder PATH listing for volume
Volume serial number is
A:.
│
test.doc
│
├───lab2
│
│
homework.txt
│
│
homework.ltr
│
│
│
└───test
│
└───lab2bkup
│
test.txt
│
test.ltr
│
└───test

After completing the activity, answer the following to prepare for D2L quiz:
Question 1 (2 points)
The copy command
 duplicates files and directories, even empty directories
 renames files
 displays or changes attributes
 perhaps can retrieve an erased file
 duplicates files
Question 2 (2 points)
Syntax: copy
[remember, items in brackets are optional]
 copy [+r][-r][+a][-a][+s][-s][+h][-h] filename
 copy /w
 copy [filename]
 copy [path\]source [path\]destination
Question 3 (2 points)
An example of the proper use of the copy command is
 copy a:\test.txt a:\lab2\test.txt
 copy a:\test.txt a:\lab2\test.ltr
 All of the above
 none of the above
Question 4 (2 points)
The XCOPY command:
 duplicates files and directories, even empty directories
 renames files
 perhaps can retrieve an erased file
 displays or changes attributes
 duplicates files
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Question 5 (2 points)
Syntax: XCOPY
 xcopy /w
 xcopy [+r][-r][+a][-a][+s][-s][+h][-h] filename
 xcopy [filename]
 xcopy [path\]source [path\]destination [/e]
Question 6 (2 points)
The command copy everything including empty subdirectories is
 xcopy lab2\*.* lab2bkup\*.* /f
 xcopy lab2\*.* lab2bkup\*.* /e
 xcopy lab2\*.* lab2bkup\*.*
 copy lab2\*.* lab2bkup\*.* /e
Question 7 (2 points)
The command ATTRIB
 duplicates files
 perhaps can retrieve an erased file
 renames files
 displays or changes attributes
 duplicates files and directories, even empty directories
Question 8 (2 points)
Syntax: ATTRIB
 attrib [path\]source destination
 attrib [path\]source [path\]destination
 attrib [+r][-r][+a][-a][+s][-s][+h][-h] [filename]
 attrib [filename]
Question 9 (2 points)
The following is the correct use of attribute command attrib +ra test.txt
 True
 False
Question 10 (2 points)
The REN command
 renames files
 duplicates files
 displays or changes attributes
 perhaps can retrieve an erased file
 duplicates files and directories, even empty directories
Question 11 (2 points)
Syntax: REN
 ren [path\]source [path\]destination
 ren [filename]
 ren [path\]source destination
 ren [+r][-r][+a][-a][+s][-s][+h][-h] filename
Question 12 (2 points)
To rename a:\red.txt to green.txt, you would type
 rename a:\red.txt a:\green.txt
 ren a:\red.txt a:\green.txt
 ren a:\red.txt green.txt
 rename a:\red.txt green.txt
Question 13 (2 points)
The undelete command
 displays or changes attributes
 perhaps can retrieve an erased file
 can retrieve any erased file
 duplicates files
 renames files
 duplicates files and directories, even empty directories
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Question 14 (2 points)
Syntax: undelete
 undelete [+r][-r][+a][-a][+s][-s][+h][-h] filename
 undelete [path\][filename]
 undelete [path\]source [path\]destination
 undelete [path\]source destination
Question 15 (2 points)
The command to undelete a:\test.doc is
 undel
 undelete
Question 16 (6 points)

Current situation

Desired result

C:\

C:\
│
homework.txt
│
├───DOS
│
homework.txt
│

│
│
├───DOS
│
homework.txt
│

Scenario, your prompt is C:\>, there is a file called homework.txt in C:\DOS. Give the command
to copy the file to the root of C without changing directories… that is, write out a copy command
with a full path statement for the source and a full path statement for the destination.
 copy c:\dos\homework.txt c:\homework.txt
 copy c:\dos\homework.txt ..\homework.txt
 copy c:\homework.txt c:\dos\homework.txt
 This cannot be done with one command
Question 17 (6 points)
What is the command you would enter in DOS to copy all the files that are named homework in
the lab2 directory to a lab3 directory, if that directory existed?
 copy lab2\homework.txt>ltr lab3\homework.txt>ltr
 copy lab2\homework.? lab3\homework.?
 copy lab2\homework.* lab3\homework.*
 copy lab2\*.* lab3\*.*
Question 18 (6 points)
What is the command you would enter in DOS to copy a directory and all its contents, as in from
lab2 to lab2bkup?
Only fill in the missing command
A:\>________lab2\*.* lab3\*.* /e
Question 19 (6 points)
What is the command you would enter in DOS to change the attributes of a file named fred.txt to
hidden?
A:\>_______ _____ _______
Question 20 (6 points)
What is the command you would enter in DOS to rename a file from test.txt to test.doc?
A:\>ren test.txt _______
Can you use a full path statement for the destination?
Yes
No?

Submit files and quizzes as directed
See page 57 for details if taking a Collins class. Again, select test.doc & lab2 & lab2bkup by holding down the
Ctrl key, then right click and zip and save as yourname-lab2.zip
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Check Class website or YouTube for a short video similar to Lab2
Note: Command Reference in Appendix A
End of chapter 3
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Overview 4
DOS 7-9

Utilities; Batch Files; Lab 3

DOS 7 Utilities
Hard Disk Management

Utilities
Redirection
DOS 8

Executable files
Batch files
Autoexec.bat
EDIT
ECHO
PAUSE
REM
mov.bat
(replaceable parameters)

DOS 9
Lab 3 Commands
Lab 3 Activities
Lab 3 Questions
Note: Command Reference in Appendix A
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DOS 7

Utilities

Hard Disk Management

Redirection

To Start the WINDOWS Command Prompt: Press Start ( or

) , then type CMD

Utilities

While utilities are a different family of System Software than Operating
Systems, a few utilities should be covered in this discussion of the
Operating System simply because these days a few of them are included
when you install an Operating System. The following utilities address
specific situations described earlier in the book.
Earlier in this book, defragmentation was described as parts of files
scattered across the hard drive in non-adjacent sectors.

The solution for this situation is the DOS-included defrag command.
DEFRAG used to defragment files into contiguous (adjacent) sectors
Syntax DEFRAG [drive:]
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Another previously mention item is CHKDSK, which technically is a utility.
However, a better solution is available now, SCANDISK.
SCANDISK used to check and repair a drive
Syntax SCANDISK [drive:] [autofix]
MSBACKUP © Symantec 1993, shipped with later versions of DOS to back
up or restore files, but this was the era of 10 MB hard drives and floppies;
Windows or 3rd party versions are much better suited to modern media.
Both of DEFRAG and SCANDISK tools are also available in Windows, along
with the Windows backup or History utility. (Recall ATTRIB? One of the
ways a backup utility locates files to archive is by looking for the A
attribute).

Hard Disk Management

Hard disks are used to store files, but directories actually organize all of
these files. COPY and DEL can actually manage all the files on your disk,
including rearranging files in various directories.
If a file is in directory A, but the file should be in directory B,
1) COPY the file in directory A to directory B, and then
2) DEL the original file
The problem was, if you didn’t pay attention the copy didn’t get created
and the original would be deleted, leaving nothing… so most careful users
actually made this a three part process… checking to see if the copy was
made before the deletion was executed; making the actual command
sequence COPY-DIR or TREE-DEL.
In the early days of DOS, this was sufficient. But as the OS matured, a
one step solution that took the guesswork out of it was made: MOVE
Command Name
Purpose
Syntax
Common parameters
Example
Full paths may be used

MOVE
To move a file from
MOVE source destination
n/a
MOVE A:\DIRA\file1.txt A:\DIRB\file1.txt
for both the source and destination.

As this was a new command, it was not added to command.com, instead,
the executable command MOVE was added to the DOS directory as an
external command, move.exe.
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But even though the move command is in C:\DOS, we did not type in
A:\>C:\DOS\MOVE.EXE A:\DIRA\file1.txt A:\DIRB\file1.txt
we simply typed in
A:\>MOVE A:\DIRA\file1.txt A:\DIRB\file1.txt
This raises interesting questions. 1) How did the OS know where MOVE
was, in order to execute it? The answer lies in a command DOS normally
executes when it first starts up (Windows too, for that matter). PATH
Don’t confuse the PATH command with the generic term path, which tells
the computer where to go for a source or destination. The PATH
command tells the computer in advance where to find the DOS directory.
Command Name
Purpose
Syntax
Common parameters
Example

PATH
Directs the OS to external commands.
PATH [external file storage location] [; other]
n/a
PATH C:\DOS

While we are at it… originally the system prompt would only show the
flashing cursor.
_
Now the command prompts includes current drive, directory path, and
the > to separate the system prompt from the cursor
A:\> _
This again is another command normally executed when the system first
starts up: PROMPT
Command Name
Purpose
Syntax
Common options
Example

PROMPT
Displays info in the system prompt
PROMPT [option 1] … [option n]
$P Current Drive AND path
$G > (greater than sign)
PROMPT $p$g
includes the directory Path and a >

Other PROMPT characters:
$Q =
$$ $
$T time
$D date
$N just the current drive
$L <
$_ start a new line
More on MOVE, PATH and PROMPT in Chapter 8, Batch files.
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While the book has made constant reference to the notion that DOS could
only do one thing at a time, let us think about something… when you run
DIR for example… several things happen:
locate the command
execute the command
display the results.
So actually, DOS can do a few things, but only one at a time. But still, we
can start to leverage the fact that does can do a series of steps in a row
to complete one task. One example is to change where the results go.

Redirection

Redirection with the greater than sign ( > )
If you enter the command DIR, the information is directed to the
standard output device… in this case, the monitor.
Redirection simply over-rides the default devices by using the > (not to
be confused with the > at the end of the system prompt… think of it as a
pointer, as in goes to).
Example: DIR > PRN (think DIR goes to PRN) would redirect the output
to the printer instead of the monitor.
You may also redirect to a file, using DIR > c:\dirA\dir.txt
Now what if instead of sending the output someplace, we just left it in
RAM, then grabbed the contents to do a second, related command?
Sequences, with the pipe: | (may also look like ¦)
A different way of redirecting output is to grab the output and use it as
the input of a different command. This is called piping, as you use the
pipe [|] or [¦] key… (often the shifted [\]).
About the best example of this is using ¦ MORE.
The MORE command displays the contents of RAM, one page at a time.
DIR comes with a /p to pause, but TREE does not. But, if you enter
A:\> TREE /f ¦ more
The output is redirected to a holding spot in RAM, and is then fed to the
monitor a page at a time.
So you could think of this as
TREE /f goes to ‘MORE’
‘MORE’ goes to MONITOR, to display a page at a time.
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DOS 8
Executable files
Batch files
Autoexec.bat
EDIT
ECHO
PAUSE
REM
mov.bat
(replaceable parameters)

To Start the WINDOWS Command Prompt: Press Start ( or

) , then type CMD

Executable files

If you have access to DOS, type in
C:\> DIR C:\DOS\help.*
to locate the external command HELP that we used earlier.
If using the Windows command line, type in
C:\> DIR C:\windows\system32\help.*
instead.
Either way, DIR will locate a program that starts with help, regardless of
how it ends. But what you will see is not just HELP, but HELP.EXE
Recall, earlier in the book, there was a discussion of file type extensions,
and the list started with .exe, .com, and .bat.
On page 76, we discovered MOVE was actually MOVE.EXE. All external
commands actually have an extension.
These are the so called executable file types… so you don’t need to
include the extension as DOS or the command prompt expects when you
type something in at the system prompt that it will be either an internal
or external command, or an application. But for all practical purposes, an
external command IS an application… albeit a small one.
Therefore, the OS is SO expecting a program that it assumes what you
type in will end in .exe, .com, or .bat! So, if you type in HELP, the OS will
append .exe and give it a try; if no luck, it will append .com and give it a
try; if still no luck, it will append .bat and give it a try before it give up
and flashes an error message.
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EXE and COM files are not normally readable by people… they have been
converted into the 1’s and 0’s that computers like. But batch files are
different.

Batch files

A batch file is simply
a series of commands,
listed in a text file,
whose extension is bat.
When a batch file is executed, DOS or the COMMAND prompt reads one
line of the file at a time, and does whatever it says. Again, DOS can only
do one thing at a time, but earlier we learned we can build a sequence of
single tasks for DOS to tackle, one at a time… such as with tree /f | more.
So, if you wanted to ‘move’ a file before DOS included the MOVE
command, as mentioned in the last chapter, you could create a batch file
named a:\MOV.bat with the following lines:
copy a:\dirA\file1.txt a:\dirB\file1.txt
del a:\dirA\file1.txt
At the command prompt A:\>, if you typed in MOV,
file1 would be copied to dirB,
once complete
the file would then deleted… just like the MOVE command.
But it would be ridiculous to create a batch file unless you planned to
reuse it. After all, it would take more time to type the batch file than it
would to simply type in the two commands. So, batch files should be
created when you plan to do the same thing over and over.
Recall in Chapter 7 how it was mentioned that PATH and PROMPT are
normally executed when you start your system? Did you wonder how the
C:\DOS argument for PATH was delivered, or how the $p$G argument
was delivered for the PROMPT command? If you suspect it was done
using a batch file, you are on the right track.
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Autoexec.bat

As its name implies, autoexec.bat is automatically executed when a DOS
computer is booted. The most common lines in autoexec.bat are:
@echo off
PATH C:\DOS
PROMPT $P$G
There are often other instructions, but this is the near universal standard.
If you are running a DOS system, run a DIR on the root of C:\, you’ll
probably see it. Run TYPE autoexec.bat to compare your system to the
universal.
The next trick, how are batch files created? Well, as they are plain text
files, you could use our lab 1 standby COPY with the CON as the source…
but this solution gets tricky, as you can’t go back for making changes…
you’d have to retype the whole thing if you didn’t like one item. The key
is a small application that is available from the system prompt: EDIT.

EDIT

EDIT is like a small, plain text word processor… the DOS version of
Notepad. (If your computer doesn’t have edit, you’ll use notepad.)
As you may not have a mouse, press the [Alt] key to highlight menu
items… just as in DOS help, when you are finished you choose
[Alt]+[F]+[X] to open the File menu, and select the eXit command.
File Edit Search View Options Help
┌───────────────────── UNTITLED1 ────────────────────┐↑

F1=Help
The advantage of using EDIT is you can change items anywhere by using
the arrow keys or your mouse and save your change, rather than having
to use COPY CON to retype the entire file.
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You can also edit an existing text or batch file. If EDIT is running, choose
[Alt]+[F]+[O] to get to the open dialog box.
If EDIT is not running, type in EDIT [path\] filename, such as in
C:\> EDIT a:\test.bat
or C:\> NOTEPAD a:\test.bat
to open test.bat
Even better, if test.bat does not exist, EDIT will create it, and then allow
you to edit it.
Example
C:\> EDIT a:\test.bat

or

C:\> NOTEPAD a:\test.bat

to open test.bat Type in PROMPT $P$T$G to add the time to the prompt.
File Edit Search View Options Help
┌───────────────────── TEST.BAT ─────────────────────┐↑
PROMPT $P$T$G

F1=Help
Type [Alt]+[F]+[S] to save the file, then [Alt]+[F]+[X] to close EDIT.
Test the batch file with
A:\> TEST
to execute test.bat
Your prompt should change to include the time. Manually reset it with
A:\ 12:00:00:00> PROMPT $P$G
NOTE
Modern computers no longer run 16 or 32 bit programs such as EDIT.
If not using real DOS, simply substitute NOTEPAD where ever you see EDIT.

Example: if the book says EDIT MOV.BAT
at the command prompt in Windows enter NOTEPAD MOV.BAT
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Building better batch files
The reason you probably never saw the PATH and PROMPT being set is in
the first line of the most standard autoexec.bat.
@echo off
PATH C:\DOS
PROMPT $P$G
Command Name
Purpose
Syntax
Common parameters
Example

ECHO
To control what displays on the monitor
ECHO [off] [message] [on]
n/a
@ECHO OFF immediately suppresses display,
not even @ECHO OFF will be seen
ECHO OFF will suppress the batch file
display immediately after the command
ECHO off is run.
ECHO HELLO will display HELLO, even if
the ECHO is off
ECHO ON reverses ECHO OFF

Another batch file command is PAUSE.
PAUSE, temporarily halts the batch file execution,
and displays the message Press any key to continue.
Once a key is pressed, execution continues.
I often use PAUSE immediately after a copy command, to give the system
a chance to finish before attempting the next line in the batch file, or if I
wish to inspect something on the screen during testing of a batch file.
The last batch file command is REM, for remark. This has two purposes…
to temporarily skip a line in a batch file, or to leave yourself a note.
Let’s say you want the screen to be wiped clear, but not during testing of
the batch file. REM CLS leave the line in place, but the batch will skip that
command. Take out the REM when finished testing.
Another use is to leave yourself notes… documenting part of the batch
file.
REM $T is to add time to the prompt
The above line is not executed by the computer; but you can read it a
year later and understand what the $T in the PROMPT command does.
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Basically, any line that begins with REM is skipped by the computer, so it
can be used to temporarily turn off part of a batch file, but most is there
for you to be able to leave notes to yourself.
Command Name
Purpose
Syntax
Common parameters
Example

REM
To prevent a line in a batch file from executing
REM [DOS command]
n/a
REM CLS
tells the batch file to skip CLS
Or
REM $T is to add time to the prompt

Can be a note to you to explain PROMPT $T

Mov.bat

Let’s get back to that early attempt to create something that works like
the MOVE command.
copy a:\dirA\file1.txt a:\dirB\file1.txt
del a:\dirA\file1.txt
The problem was, you specified the file names, making it a one time only
batch file.
So, in DOS, how does COPY or REN work? These commands don’t know
what you are going to use for source, or for destination.
As a matter of fact, you cannot type COPY and hit the enter key… you get
an error indicating you did not specify the source or destination.
There must be something built into these commands that basically is a
place holder for source, and something that is a placeholder for
destination. These place holders, or parameters, must be replaced at the
time of execution… hence the name:
replaceable parameters.
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Replaceable parameters
"The user will provide a filename when the command is used".
Actually, this makes sense. Just as in COPY, you can't just type MOVE, hit
the enter key, and expect it to work.
If you just type MOVE and hit the enter key, DOS tells you it was
expecting a filename (source).
If you just type MOVE filename and hit the enter key, DOS tells you it was
expecting a filename (destination).
What is used in DOS is:
%1 to act as a place holder for the first filename to be entered (source)
and
%2 to act as a place holder for the first filename to be entered
(destination).
So, we change our single use batch file from this
copy a:\dirA\file1.txt a:\dirB\file1.txt
del a:\dirA\file1.txt
to the following:
COPY %1 %2
DEL %1
This batch file will now work for any file names you specify,
WHEN you execute the command.
Here's how it works
If you have a file named a:\folder1\junk.txt, and you want to move it to
a:\folder2, you could use the MOV.BAT command
Syntax for MOV
(recall, executable files don't require you to include the extension)
MOV source destination
Example of MOV
(recall, executable files don't require you to include the extension)
MOV a:\folder1\junk.txt a:\folder2\junk.txt
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What happens
1) DOS grabs the first filename given (the source),
a:\folder1\junk.txt,
and replaces every %1 with
a:\folder1\junk.txt
2) DOS grabs the second filename given (the destination),
a:\folder2\junk.txt,
and replaces every %2 with
a:\folder2\junk.txt
3) DOS executes each line in the batch file, using the replaced filenames
COPY %1 %2 turns into COPY a:\folder1\junk.txt a:\folder2\junk.txt
DEL %1
turns into DEL a:\folder1\junk.txt
The result is the original file is copied, then that original file is deleted,
leaving only the copy... net effect, moving the file.
Note: if you improperly state the destination, the first line of the batch file
will not be able to make the copy, but the second line will still delete the
original... leaving you with no file at all.
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DOS 9

Lab 3 Commands
Lab 3 Activities
Lab 3 Questions
To Start the WINDOWS Command Prompt: Press Start ( or

) , then type CMD

Make a folder named Lab3 on your floppy, thumb drive, or network drive; ie f: or o:

At the end of this process, you will be taking a quiz based on the following
questions. So, to get the best score, fill in all the answers in this document first.
RD (RMDIR)
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Are there any common parameters mentioned in class? List them
Write out one example of how the command was entered in this lab
DELTREE (DOS Only, similar to the dangerous RD /S Windows command)
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command was entered in this lab
PROMPT
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Are there any common parameters mentioned in class? List them
Write out one example of how the command was entered in this lab
PATH (Usually in autoexec.bat)
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Are there any common parameters mentioned in class? List them
Write out one example of how the command was entered in autoexec.bat
ECHO
What does this BATCH file command do?
@ECHO OFF What is displayed?
ECHO OFF What is displayed after the line is processed?
ECHO ON What is displayed after the line is processed?
ECHO Message What is displayed?
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PAUSE
What does this BATCH file command do?
What is displayed?
REM
What does this BATCH file command do?
What is displayed?
DOS Activity
(Examples use A:\, modify accordingly if not using A:\)
Using EDIT or Notepad, create a batch file setpromt.bat that does the following
(edit a:\lab3\setpromt.bat or notepad a:\lab3\setprompt.bat
or
cd lab3
edit setpromt.bat or notepad setprompt.bat)
Turns the echo off immediately
Sets the prompt to include the time,
it should still start with the current path and end with the greater than sign
Displays the text message, "Do you like my prompt?"
waits for you to continue
Clears the screen
Makes a directory called test
Copy your batch file to setpromt.bak

Optional, have your batch file run tree a:\ /f to let you see what happened

IF YOU HAVE CODED THIS PROPERLY, YOU WILL BE ABLE TO SELECT A BATCH FILE
CHOICE that accomplished the goal of setpromt.bat IN THE QUIZ

Using EDIT or Notepad, create another batch file named mymove.bat
that does the following
(edit a:\lab3\mymove.bat or notepad a:\lab3\mymove.bat
or
cd lab3
edit mymove.bat or notepad mymove.bat)
• Makes a copy of any file you specify (%1)
• Copies that to any filename or location you specify (%2)
• Deletes the original file (%1)
see page 84/85

IF YOU HAVE CODED THIS PROPERLY, YOU WILL BE ABLE TO SELECT A BATCH FILE
CHOICE that accomplished the goal of mymove.bat IN THE QUIZ
I suggest you test your batch file
Example of a test: setpromt.bat is moved from lab3 to the root using
a:\lab3\>mymove a:\lab3\setpromt.bat a:\setpromt.bat
or if in lab 3,
a:\>mymove setpromt.bat a:\setpromt.bat

Check Class website or YouTube for a short video similar to Lab3
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You will then submit your quiz and files as directed.
Question 1 (2 points)
The RD command
 is used only in BATCH files
 tells the computer where to locate the external DOS command directory
 deletes a directory, and its contents
 changes the tools displayed in the DOS prompt
 deletes a single, empty directory
Question 2 (2 points)
The DELTREE command:
 deletes a single, empty directory
 deletes a directory, and its contents
 is used only in BATCH files
 changes the tools displayed in the DOS prompt
 tells the computer where to locate the external DOS command directory
Question 3 (2 points)
Syntax: RD or DELTREE
 rd [path\]DOS or deltree [path\]DOS  rd $[tool] or deltree $[tool]
 rd [source] [destination] or deltree [source] [destination]
 rd [path\]directoryname or deltree [path\]directoryname
Question 4 (1 point)
The command to delete an empty directory named junk is
 format junk
 rd junk
 deltree junk
 del junk
Question 5 (1 point)
The command to delete a directory named junk AND its contents is
 deltree junk
 del junk
 format junk
 rd junk
Question 6 (2 points)
The command PROMPT
 deletes a directory, and its contents
 tells the computer where to locate the external DOS command directory
 changes the tools displayed in the DOS prompt
 is used only in BATCH files
 deletes a single, empty directory
Question 7 (2 points)
Syntax: PROMPT
 prompt [path\]directoryname
 prompt [path]\DOS
 prompt [source] [destination]
 prompt $[tool]
Question 8 (2 points)
The following is the correct use of attribute command: attrib $p$g
 True
 False
Question 9 (2 points)
The PATH command
 is used only in BATCH files
 deletes a directory, and its contents
 deletes a single, empty directory  changes the tools displayed in the DOS prompt
 tells the computer where to locate the external DOS command directory
Question 10 (2 points)
Syntax: PATH
 PATH [path\]random-directory  PATH [source] [destination]
 PATH $[tool]
 PATH [path\]DOS-directory
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Question 11 (2 points)
To set the path to DOS on most computers
 path c:\command.com
 path c:\DOS
 prompt c:\DOS
 path %1
Question 12 (10 points) Match the batch file command with what it does
suppresses display after displaying echo off
1. @echo off
lets you leave a remark that is not executed
2. echo off
immediately suppresses display
3. echo [message]
displays your message
4. pause
interrupts the execution of the batch file
5. rem
Question 13 (20 points) Choose the correct code that makes mymove.bat
copy %1 %2
del %1
move %1 %2
copy $1 $2
del %1
copy %1 %2
del %1
del $1
Question 14 (20 points) Which accomplishes the goals of setpromt.bat?
@echo off
@echo off
prompt $p$t$g
prompt $p$t$g
echo Like prompt?
echo Like prompt?
cls
cls
md test
rd test
copy setpromt.bat setpromt.bak
copy setpromt.bat setpromt.bak
@echo off
@echo off
prompt %p%t%g
prompt $p$t$g
echo Like prompt?
echo Like prompt?
cls
cls
md test
md test
copy setpromt.bat setpromt.bak
move setpromt.bat setpromt.bak
Question 15 (6 points)
The actual command is tree.com, not tree. So, if presented an instruction DOS
automatically tests to see if the instruction ends with what three extensions?
(leave out the period) _______
_________ ___________
Question 16 (6 points)
What is a batch file? A series of ____ commands executed in order, from a plain ______
document whose extension is _______
Question 17 (6 points)
Where is the prompt and path typically set?
command.com
 A dumpster in Brazil
 config.sys
 autoexec.bat
Question 18 (6 points)
What is the prompt statement to show the standard prompt that includes path and
greater than sign? Example C:\>
 prompt %p%g
 path $p$g
 prompt $p$t$g
 prompt $p$g
Question 19 (6 points)
What is the prompt statement to show the prompt that includes path, the time, and
greater than sign?
 path $p$g  prompt %p%g  prompt $p$g  prompt $p$t$g
Submit files and quizzes as directed
See page 57 for details if taking a Collins class. Only use the dropbox if you missed a big item on the
quiz… in that case zip all files and save as yourname-lab3.zip
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Overview 5
DOS 10

Review
See class website for information on testing policies for your class
A great way to further review for this test is to review all of your labs.

Directories and Files
Path

[drive:\][directory\]filename.ext (8.3)

Directory (Folder) Commands
List contents

dir

Show structure

tree /f

Change directory focus (open another folder)

cd foldername

Make a new directory

md foldername or mkdir foldername

Remove an empty directory

rd foldername or rmdir foldername

Delete directories, subdirectories, and files

deltree foldername

File Commands
Copy files

copy source destination

»Example

copy a:\test.txt a:\class\test.txt

»Example, destination renamed

copy a:\test.txt a:\class\test.ltr

»Example, copy all .txt files, regardless of file name copy a:\*.txt a:\class\*.txt
»Example, copy all files named homework,
regardless of extension

copy a:\homework.*
a:\class\homework.*

»Example, copy all files

copy a:\*.* a:\class\*.*

»Example, create a text file

copy con filename.ext

Copy files and folders

xcopy source destination /e

»Example, copy all files, folders, and subdirectories xcopy a:\*.* c:\backup\*.* /e
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Copy a diskette

diskcopy source destination

»Example

diskcopy a: a:

Move a file to a different folder

move source destination

Delete a file

del filename.ext

Undelete a file

undelete filename.ext

Set an attribute of a file

attrib action (±) target file

»Example

attrib +h a:\class\test.txt

Rename a file

ren oldname (no path)newname

View or change attributes

attrib [+][-]|[r][a][s][h]target

Batch Files
set the Prompt

prompt $p$g

set the Path to DOS

path c:\DOS

insert a comment

rem note to me

wait to continue

pause

display

@echo off nothing displays

display

echo off nothing displays after this

display

echo on next actions will display

display

echo this displays "this displays"

Utilities
arrange files to a faster loading, contagious state

defrag

check for and repair, errors

chkdsk or scandisk

copies information for safekeeping

msbackup
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Glossary
BIOS
Bit
Boot
Byte
CPU
Disk
Giga...
Hardware
Hertz
Input
Kilo...
Mega...
Monitor
Output
Peripheral
RAM
ROM
Software
A list of all the DOS commands and usage is in the DOS Appendix
Lab 1, getting help, navigation, creating files and directories
Lab 2, copying and renaming files, wild cards, changing attributes
Lab 3, file management, utilities, batch files, replicable parameters
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Note: Command Reference in Appendix A
End chapter 5

Preview of Windows Topics

Chapter 6
Windows A Booting and the Interface
Windows B File/Folder Creation
Windows C File Management
Windows Lab 4
Chapter 7
Windows D File Management parameters
Windows E Control Panel and Variations
Windows F Utilities
 Windows Lab 5
G, H, I Windows 3.1-XP-Vista/Windows 7-Windows 8-Windows 10
Comparison of Program Manager to My Computer to This PC
Shifts in Customizing/Personalizing the Desktop

Chapter 8
Windows J Networks
Windows K OLE
 Windows Lab 6
Chapter 9
Windows Bonus eMail/Web Browsing
Review
Preview of Windows Topics
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Overview 6
Windows A-C

Interface; Files/Folders; File Management; Lab 4

Windows A, Booting and the Interface
Logging In
Desktop
Mouse: left click to select, right click to open shortcut menu
Manage Windows\Menus\Shortcuts
Objects
Dialog Boxes
Help
Shutdown, Log Off, Sleep
Windows B File/Folder Creation
Executable Files
Directories  Folders
Edit  Notepad  WordPad
Create, Edit, Format
Graphics and Paint
Print Screen
Copy Source Destination  GUI
Printing
Windows C File Management
dir  tree  File Explorer and [Folders]
dir /w /p  View options
ren  rename
move or copy
undelete  recycle bin
paths  shortcuts
 Windows Lab 4
Lab 4 Activities
Lab 4 Questions
Note Information about new versions of Windows is in Appendix B
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Windows A, Booting and the Interface
Logging In
Desktop
Mouse
Manage Windows\Menus\Shortcuts
Objects
Dialog Boxes
Help
Shutdown, Log Off, Sleep
Refer to page 8 for information on setting up your Windows computer.

Note: this book does not cover every single feature in Windows, nor does
it cover every version of Windows; the focus is on full-on computers that
use a keyboard and mouse, but I will touch on mobile systems.
Where appropriate I do include screenshots from
Windows XP, (VER Windows 5)
Windows Vista, (VER Windows 6)
Windows 7, (VER Windows 6.1)
Windows 8, (VER Windows 6.2)
Windows 8.1, (VER Windows 6.3)
Windows 10 (VER Windows 10) and
Windows 11 (VER Windows 11)

10 11

The reason I include old versions on occasion is because
1) old versions are still out there, and you may encounter them,
2) to show the progression of tools to explain the current version, and
3) to instill the idea that I am not teaching ONE version of Windows, but
Windows itself… so if you encounter a new version in years to come you
understand not “what button to click,” but where to look for a tool.
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Extending DOS to Windows, or, extending the command line to the GUI,
the Graphical User Interface
All operating systems do basically the same thing, manage resources. To
that end, all operating systems use basically the same kinds of tools…
tools to select storage devices; tools to browse folders; tools to copy,
paste, move, or rename files; tools to manage the computer; and tools to
start and interface with programs. This section begins to bridge the
command line of DOS or Windows to the graphical interface.
DIR was used to display the contents of an individual computer…
In Windows, we now use the Start button to open the Start Menu,
and from the Start button we can choose:
•

“My Computer” (XP) or
“Computer” or “Windows Explorer” (Vista, Windows 7) or
“File Explorer” and “This PC” (Win 8, Win 10/11) to locate storage devices
accessible from the local machine, including hard drives, removable
storage devices, and mapped network drives (Windows chapters J-K).
If you right click the Start button in older versions of Windows, you’d see
“My Computer” and “Computer” were actually called “Windows Explorer.”
If you right click the Start button in newer versions of Windows, you’ll see
“This PC,” is now actually part of “File Explorer.”
All of these are the same tool, they just changed the name.
As this tool works the same regardless of version, I will try to refer to the
tool as File Explorer/This PC.

•

“My Documents” (XP) or “Documents” (Vista or newer) is the default
folder (directory) where files are saved, unless another location is
specified. In a class or work environment, a mapped network drive is a
better choice, as it is available to users regardless of which computer they
are using.
As this tool works the same regardless of version, I will refer to the tool
as (My) Documents.
“My Network Places” (XP) or “Network” (Vista or newer) is used to locate
resources saved on other computers within your domain.
As this tool works the same regardless of version, I will refer to the tool
as (My) Network (Places).
Control Panel is used to modify the computer settings, giving Windows a
graphical tool to upgrade config.sys and autoexec.bat, in order to
inspect and modify the System, and regulate the computer and how it
interacts with the mouse, cameras, network cards, USB devices, etc.
Start/All Programs gives Windows XP-7 users the ability to browse for an
installed program, then select and execute (start the program.) Windows
10/11 you can use Start/All Apps.
A command line required you to name the program to select it, then hit
the enter key to execute or to start a program, such as EDIT.

•

•

•
•

101

DOS and the Art of the Command Line

Overview 6 Using Windows

In Windows you can also start a program by naming it…
Press the Start  on your keyboard or screen, and type the name of
the program you wish to start. When the program displays, press the
Enter key to execute.
We can also use the mouse, if browsing files; A double click is actually the
same as select (1st click) and execute (2nd click).

Some notes
Once a program has been started, we now have icons and buttons, in
addition to menus. Recall in DOS HELP and EDIT, we first chose [Alt] to
access a menu. In Windows, press [Alt] to expose hidden menus.
Arrows or Chevrons or Triangles, such as  or ›› or v or ► or ▼
normally mean more options are available.
… after a menu item such as Print… indicates a dialog box will open when
the menu item is selected in order to pass the parameters needed to
complete the command.
Logging In
Windows 10 Log in screen.

See Windows G-H-I for log in screens for earlier versions of Windows.
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See Windows G-H-I for taskbars of earlier versions of Windows.

Windows10
10Speak Quick Launch
Windows
Speak
or
TypeortoType
Search & Task Bar
to Search
 to desktop

Start/Search

Quick Launch

System Tray/to Desktop

The desktop is your access point to all the computer can do.
• An icon represents an object, that is, a file, a folder, a device, or
anything the computer can manipulate.
• A shortcut is a path to an object, a pointer. You may safely delete
shortcuts without removing files or devices from your computer
• Start button opens the start menu, to browse your computer
You may click the button or press the  key on your keyboard.
• Right click the Start button for a shortcut menu of important tasks
• Quick Launch allows you to start frequently used programs by
placing them on the task bar
• The Folder icon allows you to browse your computer by starting
“File Explorer”/This PC” (formerly My Computer).
• Task bar show programs started by the user
• System notification area shows the clock, calendar, and programs
started by Windows
• The box to the far right if hovered over will allow you to peek at the
desktop; clicking the button switches to the desktop.
• While Windows versions may look a bit different, everything pretty
much works the same… much like driving someone else’s car… you
probably can handle the minor differences.
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Minor differences in the newer Windows interface
While newer versions of Windows are more robust and secure than older versions,
the way the user interacts with the Operating system is not very different… but there
are a few items worth pointing out. See Windows G-H-I for more views of earlier Windows versions
1. The Start button look has changed from a rectangle with the Windows icon and
the word ‘start’ to a variations on the Windows icon the will pop up the word ‘Start’ if
you point your mouse at it..

Remember, arrow like ›› means more options are available if you click on the arrows

Windows 8.1 had a ‘interesting’ Start Menu system, left click to open a “full
screen” Start menu with access to Apps, or right click to access the useful shortcut
menu that was similar to the old start screen.
Left click “Start” from the desktop

Right click ‘Start’ on the desktop

Windows 10/11 returns to the idea of a Start Menu when you left click the
Start button, yet retains the right click to a fully featured menu functionality.
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2. Gadgets on the Desktop to Apps on the Start menu
You could add gadgets like a clock, a sticky note, or performance monitor on the
desktop in older versions of Windows….

In newer versions of Windows, you can place interactive Apps like news/ weather
updates on the Start menu. Aside from full featured desktop programs, you can also
add other mobile device style Apps that are started from the Start menu.

In Windows 8.0, running apps appeared on the desktop as a small window in the top left… swipe with finger or mouse from the
top left to expose them… to switch or close. In newer versions of Windows, apps show up on the Task bar.
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3. Start menu, shutting down.
A minor difference: the Shut Down options:
• Windows 7 you choose Start\Shut down, Shut down is at the bottom right.
•

Windows 8.1 you choose Start and the Power icon

, top right

•

Windows 10/11 you choose Start and the Power icon
, bottom right
You can also right click the Start button to access Shutdown or restart

Windows 8.1 Start page w/ “Charms” visible

Windows 10 resizable Start menu

A brief note on touch screens in Windows 8:
Place your finger on the right side of the screen
and pull to the left to reveal “Charms” to access
Search, Share, and get to Settings on
whatever you are working on. To close an App
drag down from the top. To get info, pull up
from the bottom of the screen.
In newer versions of Windows that do have touch screens, press and hold to ‘right
click. Plugging in a mouse will activate the familiar Windows controls even for apps.
Check Class website or YouTube for a short video similar to Lab3
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4. Hidden Menus
Application menus may be hidden; to reveal the menus, press the [Alt] key

5. Taskbar, [Alt]+[Tab] and [Start]+[Tab]

In Windows XP, pointing your mouse cursor at an item on the task bar generated a small
text box describing the icon; now you get a fairly large thumbnail of the program window.
Since Windows XP, you could press and hold the [Alt] key, then press [Tab] to scroll through
available programs… let go to select the Window you wish to switch to.
Windows 7 Added to that the [Start]+[Tab] sequence to get a large Rolodex style view of
program windows to view… let go to select the Window you wish to switch to.
This feature disappeared in Windows 8.

6. Run, Search, Starting programs by naming them.

For power users who liked being able to start a program using the Run tool, it no longer is
on the main Start Menu… BUT, now there is a Search box instead that can work just like
Run used to: if you search for a program it will execute the program. But you don’t have to
see the Search box… just press the Start key on your keyboard and start typing

the name of the program; hit Enter when the program is selected.
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(I know you probably have the basics, but let’s make sure)

Aside from using the mouse to simply point, use the buttons to choose,
move, or manipulate objects on the monitor.
Left mouse, single click
•select
Mouse
Left mouse, press and hold
movements
•to drag object to new location
Left mouse, double click
•select + execute
Right mouse, single click
•open property inspector
to reveal a shortcut menu
Right mouse, press and hold
•to drag with option to copy,
move, or “make shortcut”
Right click is the answer to most questions, used to reveal a shortcut menu.
Example, right click item to reveal, then use the left mouse button to select.

… or choose [Esc] to close shortcut menu.
To change the way the mouse works, choose Start/Control Panel/Mouse,
then select the tab you wish to use. (Many Control Panel items lead to
Settings items. Both Control Panel and Settings let you configure Windows.)

Mouse pointer shapes indicate what tasks can be performed.
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Manage Windows\Menus
The taskbar acts as a quick launch tool, but it’s primary job is to show
programs that are running. Programs the user has started show in the
middle portion of the taskbar, while programs Windows has started
display in the System Notification Area, also called the Tray. Programs
that are running, but not currently needed, can be minimized to the
taskbar; that is, shrunk to just an icon that represents the running task.
Win 7 users, click Start\Control Panel.
Win 8-11 users right click Start and choose the Control Panel.
Recall, the control panel is used to modify the computer settings.
Minimize the Control Panel window. Double Click the Recycle Bin icon.
You should now have two icons on the task bar.
Minimize; shrink a program window to the task bar
Restore Down; not full screen, the window can be moved/sized*
Close ([Alt]+[F4]); closes the windows and ends the program
Maximize; make the window full screen*
*Maximize and Restore Down share the same spot, if the window is currently
maximized, the Restore Down button shows. If the window is currently not full
screen, the Maximize tool shows.

Maximize the Control Panel. Now, restore down the Control Panel.

While in restore down mode, move to one of the
edges of the window. Resize the window.

Click in the title bar and move the window.
Click on the Recycle Bin icon on the task bar to un-minimize it. Close the
Recycle Bin.
Now, using the Control Panel, choose the Mouse control panel, and
explore the different settings in the Mouse control panel. You may wish to
select ‘Classic View’ to change the way the Control Panel organizes items.

109

DOS and the Art of the Command Line

Overview 6 Using Windows

Menus
Windows 7 Left click Start and choose “Computer”
Newer Windows, Right-Click Start and choose File Explorer (“This PC”)
(Recall these are the SAME program, they just have different names now.)

If your menus are hidden, press the [Alt] key, then choose View,
or press [Alt] and then type the letter ‘v.’
(When you use the [Alt] key and the underlined letter, or mnemonic, you
are using a keyboard shortcut. More on keyboard shortcuts soon.)
Note: … after a menu item … indicates a dialog box will open when the
menu item is selected in order to pass the parameters needed to
complete the command.
Windows 7 View in
“Computer”

Newer Windows View in “This PC”

Switch Views icon is now bottom right

File Explorer View options, Windows 11

Note the path to show the File name Extensions in Windows 10 and 11
Explore different settings for the display. Details is like dir, you may
scroll up/down using scroll bar to the right. List is like dir /w
Note: Arrows or Chevrons or Triangles, such as  or ›› or v or ► or ▼
normally mean more options are available. Point at the icon to get
‘bubble help,’ which indicates what the tool is. Choose the ▼ to the right of
the icon to display a similar menu to the View menu. There are often many different
ways to do the same task in Windows.
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Keyboard shortcuts
Below is a short list of keyboard shortcuts, additional shortcuts are listed
on the class website.
Windows
[Alt] Open the menu if hidden, or to use a mnemonic
[Alt] [Tab] Go to next window, or switch between active windows
[] [Tab] Switch between active windows, Rolodex style (Vista Win 7)
[Alt] [F4] Close active window.
[Alt] [F4] If no window is active, this will shut down Windows.
[Ctl] [Z] Undo
[Ctl] [x] cut selected item (copies into memory, called the clipboard)
[Ctl] [c] copy selected item (into memory, called the clipboard)
[Ctl] [v] paste an item in memory, called the clipboard, into document
Word processing
[Ctl] [s] save
[Ctl] [b] bold
[Ctl] [i] italic
[Ctl] [u] underline
Single click text Select word
Double click text Select sentence
Triple click text Select paragraph
[Shift] [End] select from insertion to end of line
[Ctl] [Shift] [End] select from insertion to end of document
[Shift] [Home] select from insertion to beginning of line
[Ctl] [Shift] [Home] select from insertion to beginning of document
Other tips
If a button is highlighted, pressing the [Enter] key is the same as clicking the button.
Pressing the [Esc] key is the same as choosing [Cancel].
You may move the highlight to other buttons by pressing the [Tab] key.
If viewing Computer/This PC in Details
view, you may right-click the gray
column heading, then select or remove
additional detail items.
If a column heading is too narrow, place
your cursor between the columns.
When the cursor looks like  , hold down
the left mouse button and drag the
column to the left or right to resize.
Click a column heading to sort by that
item. Click the  or to reverse the sort.

111

DOS and the Art of the Command Line

Overview 6 Using Windows

Objects
As mentioned earlier, an icon on your desktop may represents an object;
that is, a file, a folder, a device, or anything the computer can
manipulate. As we move forward, we will stress the ‘anything the
computer can manipulate’ aspect. Understand that an object might be a
snippet of a text that has been copied into memory (called the clipboard),
an image that could be pasted into a different document, a chart created
by a spreadsheet application, or an object may even be another
computer.
When you first choose Computer/This PC, you may be looking at icons for
your hard drive, floppy drive, removable storage devices, or a mapped
network drive that represents a folder on a different computer, etc.

Win 7

Windows 11
Note: the menu bar in Windows 11 has been simplified. The Properties
icon has been removed in Windows 11, but note that the selected item
properties are still listed at the bottom of the screen. Recall, use  or …
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Dialog Boxes
As mentioned earlier, a dialog box opens anytime Windows needs
additional information before carrying out a command, or to change a
dialog box setting.
1. Help [?] on this dialog box
may be a magnifying glass
2. A tab, there may be multiple
3. Scroll bars to view choices
4. A checkbox  and/or 
multiple items can be selected
5. A radio button  or :
only one of group can be selected
6. A dropdown list
7. Default option (or press enter)
8. Cancel (may press [Esc]

Help
There are several kinds of Help in Windows.
Content sensitive help,
Program help,
and online help.
The DOS command Help listed all the commands you could get help on…
The DOS command /? Feature allowed you to get help on a specific
command. Many dialog boxes have a [?] button to get help on just that
dialog box. This [?] is a form of context sensitive help.
Individual Windows applications also have help files on using that
application, called Program Help. This is opened by choosing the Help
menu if available, or clicking the (?) or

Magnifying glass button.

Whatever window is active, by pressing the F1 key on your keyboard,
you can get help on that activity.
Earlier versions of Windows had a “Help and Support” option to list topics
to get help on, plus has a searchable help tool.
In Windows 11, use Start>Tips
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Window 11 Start> Tips

You may also click Search to get online help to get more up to date, and
even let a technician ‘drive’ your computer from a distance.

Click the Magnifying glass to search… search on your
computer for files or apps, or search the Internet. You can also use
Search to locate Cortana, Microsoft’s AI app that can let you search by
speaking to your computer.
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Shutdown, Log Off, Sleep
Depending on your version of Windows, there are slight differences in
shutting down your computer. However they all start by choosing the
Start button.
Windows XP: Start/Shut Down
Windows Vista: Start then choose ► and select Shut Down
Windows 7: Start/[Shut Down]
Newer Windows: Start
With DOS, you could simply power down the computer. In Windows, don’t
just power off, as the programs that are running will not have a chance to
appropriately save and close… you may not think any programs are
running but don’t forget those programs Windows itself started that are
running in the system notification area, also called the tray. The only way
to give all the Windows programs a chance to appropriately close is to
use Shut Down.
If your computer freezes, press [Ctrl]+[Alt]+[Delete] to open the task
manager… you may close the unresponsive program there, or choose
Shut Down.
When can you choose something besides Shut Down?
If you are leaving a network computer and someone is about to sit down,
you should choose Log Off.
If you are leaving your computer, and don’t want anyone else to use the
computer, you may choose to Lock the computer. Don’t lock the
computer if it is a public computer that others may wish to use.
Finally, you may wish to put your computer in Sleep mode if you won’t be
using it for a few moment, but don’t want to shut it down. Sleep is a low
power mode that keeps the computer on and items available in memory,
without using excess electricity.
Don’t choose ‘Sleep mode’ or ‘Hibernate’ if you are not going to be using
the computer for several hours… go ahead and shut it down and be a
green computer user.
Finally, to answer the question: does it hurt to leave the computer on?
While this wastes electricity, it doesn’t really hurt the computer; however,
only the shutdown process completely clears the RAM; eventually a
computer left on too long will slow down as poorly written applications
clog memory. Does it hurt to turn the computer off?
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Windows B File/Folder Creation
Executable Files
Directories  Folders
Edit  Notepad  WordPad
Create, Edit, Format
Graphics and Paint
Print Screen
Copy Source Destination  GUI
Printing
Directories  Folders
In DOS, we used the term directory to indicate an organizational tool
used to allow the user to group files together. In Windows, a directory is
now called a folder, but they behave exactly the same.
Executable Files
While Operating System software is a subset of system software,
Windows includes a fair number of system software utilities (see unit F)
and a few application programs also, most notably a text editor and a
simple word processing application, and even a simple drawing program.
As mentioned earlier, programs and applications are executable files such
as the DOS Edit program, a simple text editor that saved plain text files.
Files created by an application or program are called data files. The
computer can tell the difference between the types of files by examining
the extension.
Programs often end in (.exe), while you may recall a text data file often
ends in (.txt) or (.doc).
Windows goes one step beyond DOS by also assigning an icon to each
extension.

The icon on the left is the Microsoft Word program. Again, the files
created by an application are called data files; the file on the right is a
data file created by Microsoft Word. Often data file icons resemble the
program icon.
Note: Windows is not limited to eight character file names or three character extensions.
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Common Windows applications, and the file types they create
Notepad, the Windows version of EDIT, creates (.txt) files
WordPad, a simple word processor, creates (.rtf) files
Paint, a simple drawing/painting program, creates (.bmp) files.
Note: If your computer has Microsoft Word on it, the icon for (.rtf) files will change to
the Word icon. This is why it is important to NOT hide file extensions, as you cannot rely
on the icon to know the file type. You can still tell Windows to open the file with
WordPad, by right-clicking the icon, and choose Open with…

Save, vs. Save As
Save replaces an old file with a new version. The first time a file is saved,
you must go through the Save As process, where you tell Windows
1) where to save the file*,
2) what you wish to name the file, and
3) what type of file it should be saved as.
Typically, you do not need to change the file type; instead you usually accept the file
type offered, such as Paint offering (.bmp) or WordPad offering (.rtf).

*In DOS we had the ability to go up one directory using cd ..
In Windows you choose the Up button when browsing to do the same.

Windows XP [Up]

Windows 10 [Up]
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Note: When saving files for work or school, it is probably NOT a good idea to
just save the files in the default ‘Documents’ folder, as they will only be
available on that computer.
Instead, select “File Explorer” or “This PC” and then browse to a location that is
available later… such as a network drive, removable storage device, etc.

Edit  Notepad  WordPad
While EDIT and Notepad have a place, many times you may wish to
format your document, that is, change the shape, size or color of the
text, or perhaps add a list, or double space paragraphs. Old typewriters
and text editors did not have this support. Starting with Windows 3.1,
WordPad could format text, making Windows a very appealing option to
home computer owners.
Find WordPad by clicking the Start key and just type wordpad.

Below is a chart of the tools in newer versions of WordPad are…

see section G-H-I for info on previous versions.
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Create, Edit, Format
Creating a text file was fairly easy to do in DOS, you would type in
COPY CON filename and simply type to create your file.
The big difference between using COPY CON filename and using EDIT was
obviously the fact that EDIT would allow you to change text several lines
up; that is, move your cursor off the last line and retype. WordPad can go
quite a bit beyond this. While we learned in DOS that you can copy and
move files, in Windows we can actually apply this sort of housekeeping to
parts of a file.
If you have several lines of text already typed in WordPad, you can cut,
copy, paste, and move text around your screen, or even undo the last
action you performed, using the Edit/Undo menu, [Ctl] [Z], or
button.
Recall in Windows we have to select, then execute. To cut, copy, paste,
or move text, you first need to highlight it by dragging your mouse across
the text.
Cut removes the selected object from the current document and places it
in the clipboard. You can cut using Edit\Cut, right click\cut, or [Ctl] [x]
Copy duplicates the selected object from the current document and
places it in the clipboard. You can copy using Edit\Copy, right click\copy,
or [Ctl] [c]
Paste duplicates an object from the clipboard and places it in the current
document at the point of the cursor. You can paste using Edit\paste, right
click\paste, or [Ctl] [v]
To move text, highlight it and then drag it to a different location in
WordPad by keeping the left mouse button held down. Another useful
keyboard shortcut is [Ctl] [s] to save.
Once you have edited your text, you may wish to change the appearance
of the text, or format. You can change the font face (or shape of the
letters), the font size, or the font color. You can also make text
bold [Ctl] [b], italic [Ctl] [i], or underline [Ctl] [u].
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Graphics and Paint
How Monitors Create Text and Images
There are two real concepts in computer graphics, and they both deal with how a
computer represents a line that used to be drawn on paper.
The earliest attempt at this concept is how a TV screen ‘draws’ pictures. If you look
carefully at a TV, you see the image is actually made up of tiny dots of color, called
pixels.
The proximity of certain dots of light are then interpreted by our
eyes as lines and solid shapes.
The term for this simple collection of dots is bitmapped. Originally computer screens
were very much like typewriters, and could only create predetermined shaped like
letters on the screen.
But as the technology improved, it was decided to mimic TV and represent letter
shapes by a series of dots, and if you could represent a letter, you could also
represent other kinds of shapes and computer graphics were born.
You could now display a picture, or print out a picture, instead of just words.
Bitmapped means that each pixel has a value assigned to it, which is translated by
us as the shape or color. So 111000111 might darken some pixels on the monitor
like this
, or from a distance it might look like - -.
Raster images are where the shades of an image are converted to 1s and 0s at the
place where the shapes covers a particular pixel.
But the problem with this is when you try to magnify the image. A
diagonal line like \ may look fine, until it is 10 times larger, and suddenly
looks like a staircase.
It was never really smooth, so magnifying it makes things worse.
The solution for this is was to stop describing a line with dots, and instead describe a
line with a line, or at least a formula that was understood by the computer to
represent a line. That is tell the computer a line starts at the second pixel on the first
row, and runs at a 35° angle to a particular pixel on the 68th line.
What was nice about this is that formulas can be manipulated to magnify the line
without jagged edges.
And since a letter of text on a screen could be described with formulas for circles
and lines, we could now have scalable text, as with Windows True Type Text.
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Typed Characters (Fonts)
A little bit about text shapes on computers, usually called fonts. A font
is actually a collection of information, such as the shape of the letter,
the thickness of the letter, the attribute of the letter, and the size of the
letter. So Times New Roman, Bold, Italic, Black, and 10 pt. describes
most Microsoft word characters.
(There are 72 points to an inch; so 12 pt is 1/6 of an inch high letters, measured from
the highest point that any letter reaches, to the lowest possible point.
Some letters have extra doodads called serifs, which give a letter more shape,
making it easier to read. A serif ‘g’ is a lot less likely to be read as a ‘q’ that the san
serif version of a ‘g’.

Originally computers used seven 1s and 0’s to represent about 128 different shapes,
or letters to display on the screen.
Example: ‘A’ was 100001 and ‘a’ was 110001.
Today, the Open True Type fonts use Unicode, sixteen 1s and 0s, which can
represent tens of thousands of different shapes, to include not only English, but
Russian, Japanese, Arabic, etc.
A final note, while True Type fonts improve scaling
and display, the monitor is still a series of dots…
limiting the ability to display smooth curves. This can
be overcome to an extent, using partial shading of
pixels to simulate smooth lines and curves… this is
called anti-aliasing.

Finally, for the words and images to be printed, a ink jet printer sprays ink onto
paper, using magnets to guide the ink. Laser printers use a laser to change the
magnetic properties of a rolling drum where words are to appear; the magnetic toner
sticks to the drum until paper passes under it, where the toner is transfer to the
paper, and set with heat by a fuser.
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Paint
DOS could not really handle graphics too well, so there was no real built
in program to edit images. This changed with Windows.
See section G-H-I for older versions of Paint.

Find Paint by clicking the Start key and just type paint.

Windows 10 version

Windows 11 version,
simplified menu means use Zoom at
the bottom right, and keyboard
shortcuts to copy and paste

Select File\Image Properties to set your canvas size. Feel free to
experiment with Paint. Perhaps set your canvas size to be 72 pixels high
by 72 pixels wide to keep the file size down. You may save your file,
preferably on your network drive or removable storage device is
available; the default file type for Paint is 24 bit bitmap, or (.bmp), but
the new version can also save as jpg, gif, and png.
Note: with the selection tool you can select parts of an image to cut or
copy.
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Print Screen
From time to time, there will be
something on your screen that you will
wish to save. If you choose the
[Print Screen] key, whatever is displaying
will be copied to the clipboard. From
there it can be pasted into Paint, or other
program, and saved.
To save just the active window, press and
hold the [Alt] key, then press
[Print Screen] and let go of both keys.
The active window will be copied to the
clipboard. From there it can be pasted
into Paint, or other program, and saved.
Copy Source Destination  GUI
While we have already covered copying just part of the text in a WordPad
document, Windows offers us much more granular control of what can be
copied… as mentioned earlier, we can also copy part of an image.
Using your selection tool in Paint, select just part of your image, then
choose Copy. Open WordPad, and choose Paste, as WordPad can also
deal with text and graphics.
What we are doing in Windows is exactly what we would do in DOS, in
order to copy or move, we first must specify a source, and then we must
specify a destination.
In Windows, we select some text or part of a graphic, and then choose
copy in order to call the copy command and specify the source. Then we
choose a different location in the same file, or a different file, and choose
to Paste… delivering to Windows the destination for the copy or move
command. It is the same functionality, just implemented by using the
mouse or a highlight to indicate the source, and later the destination.
Further, obviously we can cut, copy, paste, and move files, too. Open
File Explorer, select a file, then choose Copy. Browse to a different folder
or device to select a new location, choose paste.
(See page unit C, starting Windows -29-, for more on managing files.)
The easiest way to copy, move, or paste is to use the right mouse button.
To me, the answer to most questions in Windows is ‘right-click.’
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Printing
As we saw earlier, when it is time to print we normally open a dialog
box.

To print a document first select the printer you would like to use, if there
are multiple printers available (item 3). Choose which pages you would
like to print (All, the current page, or a range of pages, item 5). Then
choose how many copies of those pages you would like printed on the
specified printer (item 6). You can get Help with item 1 [?]

or F1

To issue the now fully formed Print command, (7) press [Print] or the
[Enter] key. If you do not wish to print, (8) choose [Cancel] or the [Esc]
key. Either will execute your intention, and close the dialog box.
Note: If you press the [Apply] key, this will execute the command indicated in the dialog
box, but instead of closing the dialog box, [Apply] will leave the dialog box open for
further implementations of the command.
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Windows C File Management
dir  tree  File Explorer and [Folders]
dir /w /p  View options
ren  rename
move or copy
undelete  recycle bin
paths  shortcuts
dir  tree  “File Explorer” or “This PC” and [Folders]
File management is about organizing files and folders in a hierarchy so
that information is easy to locate.
In order to manage file then, you need to be able to:
create and name/rename folders to organize your storage devices
create and save files by choosing a file name files and storage folder
delete, or rename, copy, or move files to other named folders
You should also be able to browse your storage devices and folder to
locate files. We could do that in DOS with DIR or TREE.
Windows also lets us search for files, or create a shortcut (path) to a file,
a folder, or any other object.
Note: DOS and earlier Windows used directories (folders) to physically organize files on
a drive. Starting with Windows 7, specially created folders called libraries and favorites
are used help you logically organize files, regardless of where they are physically stored.

md make a folder in Windows In “File Explorer” or “This PC”
Home tab: click New Folder or right click a blank spot- choose New\Folder
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Using “File Explorer” or “This PC”
Properties icon in Windows 10, below; icon removed from Windows 11

Windows 10

Click the … to access

Simplified in Windows 11
The other buttons available in Windows are
 Back, only available if you have browsed from some other device or
folder, choosing Back returns you to the last storage location viewed.

, Reverses a  Back; and again, Up is exactly like cd ..
Search, the Magnifying glass, is used to locate a file based on file name,
or contents of the file, or file size, or when created.

Recall, you can also search simply by pressing the Start key, and start
typing what you are looking for.
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Menu Items In Windows
Pressing the Alt key followed by the underlined mnemonic opens the
menu, just as in DOS, such as Alt + F opens the File menu.

In some programs, some menus may be hidden; press Alt to reveal.

Browsing for files

In a network environment, normally you will not save your files on the
computer, but rather on a removable device or network drive. To locate
these storage devices, start by selecting “This PC” in the left pane; you
may have to scroll to find this.
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dir /w /p  View options
Once you have located your file, you may find out additional information
about the file by changing views, much as you did in DOS.
dir by itself generated a listing of the file name, file size, and file creation
date.
dir /w just displayed filenames, without the other details, and often
displayed the filenames in columns.
dir /p paused the display after a page full.
In Windows, with its scroll bars, we don’t need to worry about /p, but we
often still need the functionality of the details.
By selecting the View tab at the top of
the screen you get the additional
options in Windows 11

The left option changes to Details
while the right option is a large
icon view.

Windows 10 view

To find info about a file not in Details view, right click and choose Properties.
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The Details option can be further tweaked to give you even more info on
your files; right-click on the gray column heading bar (the area the arrow
is indicating below) to add or remove items listed in the detailed list.

Further, you may resize the columns by pointing your cursor at the
dividing line between columns… when the cursor changes to  you click
and drag the column to a different width.
ren  rename
There are several ways to rename a file in Windows.
Choose the Home menu, then
Rename
Right-click the file, and choose
rename
Click one on a file name to
select the filename and pause;
click once more on the filename,
and the filename should go into
rename mode.
Note: you normally do NOT
change an extension when
renaming a file.
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move or copy
In DOS, you always had to choose a command first, such as
copy source destination. As we have seen in Windows, you usually
start with the selection to choose the source, then choose the command.
While describing the various methods to copy (or cut, or paste), the move
was included in that discussion.
A slightly faster variation to ‘right-click copy’ followed by
‘right-click paste’ is simply dragging a file by clicking on a file, keeping
the left mouse button down, then moving the file to a new location.
However, dragging a file from one folder to another folder on the same
drive behaves differently than if you are dragging a file from one storage
device to another. To avoid confusion, drag using the right mouse
button. This prompts you to choose whether you intend to move, copy, or
even create a shortcut.

After dragging to the new location, use the left mouse button to choose:
Copy Here, Move Here, Create Shortcuts Here, or Cancel.
More on shortcuts shortly.

You may also select multiple files to copy or move.
• Using the mouse draw a box around the files in File Explorer or on
the desktop to select multiple items.
• Click on one file in a column, press and hold the [Shift] key, and
click another file in the column to select all files between the two
items
• Click on one file, press and hold the [Control] key, and click to
include additional files into the selection. Release the key when
done.
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undelete  recycle bin
In DOS, we had the potentially useful, but unreliable, UNDELETE. Undelete
attempted to reintegrate recently ‘deleted’ files by updating the File
Allocation Table, or FAT. This typically was only successful if the deletion
attempt was carried out before there was any other disk activity that
might over-write the file, making undelete impossible.
In Windows, a similar process occurs, but using the Recycle
Bin, the chances of successfully recovering a recently ‘deleted’
file are very high.
Your recycle
bin icon may
differ.

This is because the file is often NOT deleted at all.

Methods to ‘delete’ a file or folder include:
• selecting the file(s) or folder(s), then pressing the [delete] key,
• select the file(s) or folder(s), choose the File menu and Delete
• right-click the file(s) or folder(s) and choose Delete on the menu
Methods to restore a file or folder in the recycle bin
• Immediately after deleting, choose Edit/Undo or [Ctrl] [Z]
• Open the recycle bin, select the file(s) or folder(s), right-click and
choose Restore. The items will be returned to the original location.
What happens when the recycle bin is full?
The recycle bin is actually a folder. When you ‘delete’ file(s) or folder(s)
from a hard drive, instead of being removed from the computer, they are
moved to the recycle bin for safe keeping. This gives you time to decide if
you need to restore them later.
Emptying the recycle bin.
Eventually the recycle bin will get full, and won’t be
able to protect additional files. If nothing is done,
then next time a file is ‘deleted’ it will be moved to
the recycle bin, but the oldest file already in the
recycle bin will actually be deleted, with no way to
restore. To prevent the recycle bin from getting full,
you can right click the recycle bin and choose to
empty it, after making sure you don’t need the files
or folders that currently occupy the recycle bin.
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When the recycle bin won’t work.
Normally when you choose the ‘delete’ a file, you get something like the
following message:

The confirmation message may differ from that shown.

The recycle bin only protects files that are ‘deleted’ from a hard drive, or
a device that acts as a hard drive, such as a USB memory stick. Files
deleted from network drives, or floppy disks, or re-writable CDs, are not
moved to the recycle bin.
You can compensate for this by first moving potentially un-needed files to
the hard drive, then ‘deleting’ them to the recycle bin.
You can also bypass the recycle bin and actually delete a file immediately
by first selecting the file, then press and hold the [Shift] key as you
choose the [Delete] key. The confirmation message may differ from that shown.

Note: Choosing to empty the recycle bin on your desktop may also empty
recycle bins on removable drives and other hard drives on your computer.
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paths  shortcuts
As previously discussed, an icon represents an object.
Sometimes what appears to be an icon is actually a
shortcut. A shortcut differs as it include an arrow
A shortcut is just a way to locate an object quickly. You might not want to
physically move a file to your desktop, but you could add a shortcut to a
file on your desktop, making access much easier. Later, you can delete
the shortcut without actually removing the original file from the system.
In short, a shortcut is a path to an object. Just as we used the path
command to tell DOS where the DOS commands were, or just as we used
a full path in a command to tell DOS where the source or destination
items were, we use shortcuts to tell Windows where to find something.
When you make a web site a ‘favorite’ or a ‘bookmark,’ again basically
you are simply copying the path to that site.
Creating Shortcuts, aside from dragging with right mouse button
Windows 10 and earlier
Select the file you wish to make a shortcut:
• Right click the file
• Choose Copy
Choose where you wish the shortcut to be
• Right click the location
• Choose Create Shortcut

Windows 11

to make a shortcut,
right click and copy the object
Right click where you want the shortcut, and select
Show more options, in the popup window,
Select Paste Shortcut

When you wish to create a shortcut on the
desktop
• Select the file you wish to make a shortcut to,
right click the file
• Choose Send To\Desktop (create shortcut)
When you want a shortcut in a different folder
• Select the file you wish to create a shortcut to
• Right click the file
• Drag the file, with the right mouse button
held down, to the desired location
Options
o Move here
o Copy here
o Create Shortcut here

You may watch a short video on this topic on the class web site.
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 Windows Lab 4 See Appendix C for help with Lab 4
Lab 4 Activities
Lab 4 Questions
Make a folder named Lab4 on your thumb drive or network drive; ie f: or o:

At the end of this process, you will be taking a quiz based on the following
questions. So, to get the best score, fill in all the answers in this document first.
Documentation
What is does an icon represent?
What does a shortcut represent?
What is on the Start Button?
What is on the Task Bar
What is
What is

What is

What is
What is “File Explorer” or “This PC” used for?
Discuss Windows Help and Support, Program Help, and context sensitive help.
Discuss the Control Panel
What does ... as in Print ... mean?
What does a triangle or ▼ mean?
What does Double Click Mean?
What does Right Click Mean?
Windows Activity:
Folders
Open the lab 4 folder you made a moment ago.
Note: Be able to discuss creating opening folders.
Topic: Copying Info, not just files

Make sure “File Explorer” or “This PC” is open; you will be switching between it and WordPad;

Open WordPad and save a file named yourname-lab4.rtf in your lab4 folder,
Type some text; experiment with formatting.

DO NOT CLOSE WordPad, you may minimize WordPad if you like.
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Open Paint
Create a bitmap image in Paint;
I suggest you choose Image\Attributes, and make it 300 pixels by 300 pixels
(use the File menu to choose Properties.)
Just doodle, preferably using different colors, shapes, and brushes.

Use the rectangular selection tool to highlight part of your image
Use Right-click and choose Copy, or
press and hold the Ctl key, touch the C key and let go
This copies the image into memory… the Clipboard.
You may save the image in your lab4 folder, or
simply close Paint.
Switch to WordPad. (Experiment with [Alt]+[Tab] )
Place your cursor at the end of the first line and press Enter.
Then Right Click and choose Paste, or hold down the Ctl key, touch the letter V,
and let go.

This should paste the copied image into your WordPad document.
Save this document, to avoid losing your work.
You should now have some formatted text, and an image in yourname-lab4.rtf,
as shown above.
Leave WordPad open.
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The Control panel
Open the Mouse control panel
Note: Be able to describe how you open the Mouse control panel
In the Mouse Control Panel, change from tab to tab, and test the use of making
different choices.
Open the Pointer Options tab.
Your Mouse Options may look different.
Press and hold the Alt key, then press the PrtScn
or Print Screen key and let go of both keys.

This copies the active window into memory,
the Clipboard.

Switch to WordPad
Make sure your Paint image is not selected by
clicking to the right of the image...
Press the enter key to start a new line.
Right Click/Paste or
hold down the Ctl key, touch the letter V, and
let go.
This should paste the copied image into your
WordPad document.
Save this document, to avoid losing your work.
You should now have a your copied Paint image and the mouse screenshot, plus
some formatted text in yourname-lab4.rtf as shown above.
Leave WordPad open.
Views in “File Explorer” or “This PC”
Make sure you have opened your lab4 folder in “File Explorer” or “This PC”
Use both the View option and the icons at the bottom right to change the view
to Icons, to Details, then back to Icons
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Note: Be able to describe how you can change how you view file details.
Right click a file, and choose Properties
Get properties of yourname-lab4.rtf
Note: Be able to describe how you get properties of a file.
Copy files
Copy yourname-lab4.rtf, paste the copy into the same folder
Note: Be able to describe how you can copy a file.
Rename files
Rename the copy of yourname-lab4.rtf, to lab4-yourname.rtf
Note: Be able to describe how you can rename a file.
Shortcuts
Create a shortcut to yourname-lab4.rtf in the lab4 folder.
Restore down “File Explorer” or “This PC” so you can see the desktop, if needed.
Drag the shortcut to the Desktop using the right mouse button.
Choose to make a copy on the desktop, then
Delete the shortcut on the desktop.
Note: Be able to describe how you can delete and 'undelete' files, folders, or
shortcuts.
Make sure all the files were created
Switch to “File Explorer” or “This PC”
to view your Lab4 folder’s contents
Note: Be able to describe what do you have to
do to resize a window?
Then resize the Window until it is about
5 inches wide,
Alt+PrtScn to copy that window.
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Switch back to your yourname-lab4.rtf, in
WordPad.
Paste the “File Explorer” or “This PC” screen
shot into your file.
You should now have a some formatted text
your copied Paint image, the mouse screenshot,
the File Explorer This PC screenshot showing
-your file
-the copy of your file
-the shortcut to your file
in yourname-lab4.rtf ,
as shown on the left.
Save this document, to avoid losing your work.
You may now close WordPad.

Note: Be able to describe how you close all open Windows, and shut down your
computer
Lab Hands-On Questions
Are the following True or False?
• “File Explorer” or “This PC” views files like the DOS CD command.
• “File Explorer” or “This PC” can change to directories the DOS CD
command.
• In previous versions of Windows, could the [Folders] button can open a
pane that is like the DOS TREE command
• The [Up] folder button in “File Explorer” or “This PC” is like the DOS
CD .. command
• You can enter commands or start programs with the Start Menu Search,
much like the DOS command prompt
• You can control the list in “File Explorer” or “This PC” using View, similar
to the DOS DIR /W or DIR /P command
Submit files and quizzes as directed
See page 57 for details if taking a Collins class. Zip and save as yourname-lab4.zip

Note Information about new versions of Windows is in Appendix B
End chapter 6
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Overview 7
Windows D-I

Folder Management; Control Panel; Utilities; Lab 5; 3.1-XP-10

Windows D File Management parameters
Favorites
Folder options
More Disk, Folder, and File details
Personal Folders in (My) Documents
Customize personal folders
Zipping
Windows E Control Panel and Variations
Desktop Properties
Time and Date
Fonts
Scheduling tasks
Taskbar/Start Menu
Windows F Utilities
Diskcopy  in Windows
Scandisk Defrag in Windows
Disk Cleanup
Roll back/Restore
Add Remove
Command Prompt
 Windows Lab 5
Lab 5 Activities
Lab 5 Questions
G, H, I Windows 3.1-XP-Vista/Windows 7-Windows 8-Windows 10
Comparison of Program Manager to My Computer to This PC
Shifts in Customizing/Personalizing the Desktop

Note Information about new versions of Windows is in Appendix B
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Windows D File Management parameters
Favorites
Folder options
More Disk, Folder, and File details
Personal Folders in (My) Documents
Customize personal folders
Zipping
Favorites
As mentioned earlier, a Shortcut is simply a path to an object, whether
that object is a file, a program, or a web site. In the case of a shortcut to
a web site, that is often called a favorite, and is accessible as a list in
your web browser.
To create a Favorite, you must first open the object you wish to add as a
favorite… if you wanted http://www.templejc.edu to be a favorite, you
would first open the web page, then 1) choose the  icon
2) select Add to Favorites

To return to that web site later, choose the Favorites icon, and choose
the proper item from the list.
Pinning, a quick way to a favorite folder in “File Explorer” or “This PC”
In Windows XP and Windows 7 (though not always in in Windows Vista),
you could also make a folder a favorite also. As before, you would first
open the folder, and then choose to [Add to Favorites].
In Windows 10, once you open a folder you use a lot, you can click the
Pin to Quick access, so that folder is listed at the top of your folder tree.

The Pin to Quick Access is on the Home tab
In newer versions of File Explorer, the Quick Access tool shows you recently used items.
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Folder options
As discussed at the beginning of the Windows section, a very helpful place to make
a few changes is Tools/Folder options. Earlier we discussed how many Windows
computers are set up to hide known file extensions and how confusing this can be.
To view the full file name in Windows 11
Open File Explorer
select the View menu
select Show
then chose File Name extensions

To set your computer to display the entire file name in earlier versions of Windows:
Open “File Explorer or “This PC” and select the View tab.
Turn On extensions by selecting to show [ ] File name extensions
Note: You can also select to show hidden files.

As so many people still have access to Windows XP and Windows 7,
• Choose the View tab, then click off the check mark next to
'Hide extensions for known file types', then click OK
Typically, this is the only change that you may
need to make on the View tab, aside from
perhaps showing hidden files.
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Earlier we learned that you can
right-click a file or folder in
“File Explorer” or “This PC”
and choose Properties.
You can get tons of info, such as
creation and access dates, the
size of all the files in the folder or
see the attributes. Or, select
[Change…] to choose a different
program to open a certain type of
file.
More on the registry soon.
Note the information available on
the General tab, and when
[Advanced…] is selected.
What is really powerful is if you
open up
“File Explorer” or “This PC” and
right click on a hard drive or
storage device.

The properties for a disk show:
tabs to more information at the top,
the volume label,
the file system, usually not FAT

(Windows NT was the first non FAT OS from
Microsoft, and all modern versions of
Windows are based on the NT File system, or
NTFS.)

a usage graph,
and access to Disk Cleanup.
More on Disk Cleanup and Tools tab
will be covered later.
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Personal Folders and Quick Access
Personal folders have changed quite a bit (see Chapters G-H-I for
comparison of Windows XP, Windows Vista, and Windows 7).
In Windows 10/11, if you open “This PC”, and select the This PC icon on
the left, a collection of folders will display at the top right of the screen,
including the default locations to save Documents, Music, Pictures, and
Video, as well pinned or quick access items. Below those are local and
network storage locations.
Note: your folder shapes, network, and local storage locations may vary.

Note, the folders aren’t the usual folder shape… they have visual clues to
indicate what is saved in each folder.
It is strongly suggested you don’t save files in these personal folders if
you are on a network, as they will ONLY be available when you sit at that
machine. For portability, you may wish to save files on thumb drives or
network drives.
When doing File\Save As, make sure you verify where you wish to save
the file, as well supplying a file name and choosing the file type, if
applicable.
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Customize personal folders
This leads us to the next topic. You CAN change many of those plain
folders, so they too are easy to recognize, by customizing them.
While some versions of Windows do a good job of displaying an empty
folder vs. a folder with documents, vs. a folder with images, as below, we
can still do more.

Right-click the folder you wish to modify, select Properties and choose
Customize.

You can choose a File to display on the folder, or you can choose
[Change Icon…]
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Zipping
Since the beginning of the semester, you may have been zipping folders
to place in a dropbox. The steps are:
• Right click the file or folder you wish to zip
• Choose Send To/Compressed (zipped) folder
• A new file with the zippered folder icon will be created… you may
rename the file if you like.
There are several reasons this zipping is done.
First, you cannot attach a folder and its contents to an email, nor can you
upload a folder and its contents to Desire2Learn (D2L).
By zipping the folder, it is changed to a package that can be attached to
emails or uploaded.
Note: While zipped, the contents of the file are not really for editing or
even for viewing… they are just packed up for the time being.
Zipped items need to be Extracted in order to really use the files.
(Right click the zipped item, and choose Extract All)
But the real reason to zip items is because of compression.
Zipping reduces file size, called compression. But some files are
compressed when saved, especially images.
Again, compression is about reducing file size; smaller files take up less
space on hard drives, and download faster. Basically, there are two ways
to compress a file, to remove redundant or superfluous data.
Redundant data is repeated data; as computers are very good are
detecting and repeating patterns, this is a favorite method of
compression.
Example: Let's say we point a digital camera at a white board, and snap a
picture. The camera detects colors at various points, usually by dividing
the image to be captured into rows and columns, then collecting color
information at the intersections. VGA resolution is 640 points along the
horizontal, and 480 rows, for just over 30700 pixels, or picture elements.
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Below is a magnified view of a line on that white board, so you may see
the pixels that make up the image.

Each pixel is represented by a series of 1s and 0s that dictate the color...
some cameras will assign twenty four 1s and 0s to each pixel, allowing up
to 16.7 million colors to be represented at that single point. That means
you have 640 x 480 x 24, or a total of 7372800 1s and 0s for that one
image. That is just over 7 megabytes! Obviously, we need to compress
the image, and one way is to get rid of the redundancy. On the rows that
are just white pixels, instead of saying 'white pixel,' 'white pixel,' 'white
pixel' over and over, why not just tell the computer to repeat the white
pixel 640 times.
And if you have 400 or 500 similar rows, why not tell the computer to
repeat the 'white row' 400 or 500 times? This immediately gets rid of a
lot of 1s and 0s, making the file smaller. The file has not changed, just
how we describe it. This is called loss-less compression.
Another way to compress a file is to remove 'extra' information.
Example: consider 2+2=4. Is there any part of that statement that does
not need to be stored? The computer can add 2+2, so why store the
answer? The answer will not change the next time it is added, to the
answer is superfluous, or extra.
Now, consider a picture of a rainbow. Can you really detect the 16.7
million shades, or would 256 shades get your point across? Moving from
24 bit color (24 ones and zero to describe each pixel)
to 8 bit color (8 ones and zero to describe each pixel), removes a ton of
the 1s and 0s that indicate color; thus you can compress a file by
removing the 'extra' color information, and rid yourself of a lot of 1s and
zeros that make up the file. The file has changed, but perhaps not in a
meaningful way. This is called lossy compression.
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The image below on the left is a jpg; while still compressed, it is still a
good image. However, on the right, that image has been stripped down
too far; it is too grainy, and no smooth transition between shades. This
would NOT be a good compression, as TOO much info was removed.

In images, a .bmp file is lightly compressed, and not good for say
Internet downloads as the files stay large. So instead, you could use .gif,
if your file is limited to 256 colors, as in a pie chart. If it is a photograph,
as above, use .jpg which allows for more colors, but still has good
compression. (A .png version is a larger file, really better for print.)
PS, that 7 MB picture of the white board can compress to
900 KB (24 bit 16.7 million shades bitmap image),
or 37 KB (monochrome bitmap image)...
or a 5 KB jpg file...
but since we don't need a lot of colors, it is best suited to be a gif, which
comes in at mere 1.7 KB!
From 7 MB to 2 KB without losing the meaning of the image... that is
about 2400% improvement in storage space, and download time. That is
great compression!
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Flashback

While this chapter is concerned with Windows 10 and 11, and there are several pages in chapters G-H-I on
older versions, the fact is many of you may be using an older version of Windows, so we really need to include
a quick comparison of Windows XP to newer versions: My Computer vs. Computer and This PC

Up/Back: Used to retrace steps, similar to the DOS cd ..
Search: used to locate files by name, contents, size, etc.
Folders icon: XP, toggle between a tree view and a info screen
Folders button: Vista, toggle between a list of ‘favorite’ storage areas,
and tree of all storage areas…
View: Choose to view files or folders as icons, a list, or detailed list, etc.
XP version

Vista version
Up

Search

Folders Views

In newer Windows, there is no
need for a [Folders] icon or button
to switch between tree & property
view, as they are both always
visible.

Windows 10

Windows 11 does not have the Properties icon, just right click an item
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Windows E Control Panel and Variations
Desktop Properties
Time and Date
Fonts
Scheduling tasks
Taskbar/Start Menu
The Control Panel is a powerful tool to configure your system, but a few items
formerly only in the Control Panel now have space in the ‘Settings.’
Left click the Start button, select All Apps and scroll to Settings.
Use the Start button to access the Control Panel.

A few notes: File History is the current way to back up hard drives.
Backup and Restore (Windows 7) is a legacy backup tool..
Backup used to be located with the
Error Checking (ScanDisk or Chkdsk) and
Optimize and defragment (Defrag) utilities;
accessed by right clicking a hard drive, selecting
Properties, and then selecting the Tools tab

Also, Some Control Panel items lead to Settings items.
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Desktop Properties (Windows 10 variations discussed in class)
There are many things that can be configured on the desktop, the background
image (or wallpaper, as it is often called), the color of the windows, the size of
icons or the icon label text color, which optional items aside from the recycle bin
appear, which screen saver pops up and when, and even setting the controls for
the monitor and video card. You can even make a change to all of the above, by
selecting a ‘theme.’
There are many ways to get to the tools that allow you to customize the
desktop, or examine what is currently set. One method is to use Control Panel,
and select Display. To manage the video card, you might need to choose
System, and dig down into the Hardware tab, and the look through the Device
Manager… or, you could right click the desktop and select Personalize!

In Windows 10 (See G-H-I for previous versions)
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You return to the main menu by clicking , top left, by “Settings”
There are options to change your Background, and how to fit the image

Not all versions of Windows let you change accent colors
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I find Themes to be the most useful selection, as a theme lets you
change many aspects simultaneously, such as background, colors,
sounds, mouse options, etc. PS, Click into the Desktop icon settings

Sounds Associating sounds with events that happen in Windows

Note Playback/Recording tabs. Your options may differ.
Other tools: Lock Screen Controlling what is displayed if the computer
is idle, including Screen saver.
I personally dislike Screen savers, why make the computer work while
you are away? I can see using them to cover sensitive work if you step
away for a moment, but I prefer to use the Change Power settings option
to shut down the monitor if idle.
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Fonts
Previously we learned how formatting of text is possible because the computer
can now control the size, color, and typeface of various fonts.
The different fonts that are installed on your computer are organized by type in
the Fonts tool, located in the Control Panel.
VGA fonts are similar the bitmap font that DOS used. They were called bitmap
fonts because they were made up of dots, little bits of light, mapped to a
particular location on a monitor. It wasn’t an ‘A’ as much as it was a series of
dots that looked to our eyes like an ‘A’. However, notice how poorly these scale
to large sizes. This limited early printers as well.

Recall, it was the introduction of fonts that scaled that lead the Windows
revolution. Those were called True Type fonts, and these print well.
True Type fonts include hundreds of additional characters beyond what is
available on the keyboard, to support languages other than English. Notice how
smoothly the font scales as font sizes get larger.
Start/Run or Start/Search charmap to view these additional characters.

Open Type (Open True Type) fonts can include thousands of additional
characters beyond what is available on the keyboard, to support languages
other than English. Notice how smoothly the fonts scale to larger sizes. Some of
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the fonts are 32 bit, compared to the 8 bit bytes used by DOS.
Start/Run or Start/Search charmap to view these additional characters.

Other items you can personalize

You can also open a program, right click the taskbar icon, and
Pin to taskbar
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Note options on personalizing the Start menu

We’ll discuss Recovery in a bit.
If you use the Find a setting, you can find the “Device Manager” to view
the state of devices on your computer… but often only administrators can
make changes to those devices.
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We’ll discuss using Device Manager, and it’s equivalents, to update
drivers in a bit. A driver is software that tells Windows how to interact
with hardware.

Scheduling tasks (bonus reading)

Some jobs, such as defragmentation or error checking, should not be run while you are
using the computer… use of the computer actually interferes with the task. One option to
accomplish the task then is to schedule the computer to run the task when you aren’t
using the computer. Note: the computer must be on for a scheduled task to run.
To start the scheduler:
In Windows 10, tasks are scheduled in the Administrative Tools Control panel, or of
course Start and begin typing Task Scheduler.

After naming the task and entering a basic
description, you choose a trigger, such as Daily, or
when the computer is started. Monthly is good for
error checking or defragmentation. Once you set up
the trigger time you choose to start a program… then
browse to the program you want.
Difficulties with scheduler.
First, one must remember to leave the computer on,
so the schedule will trigger. Next, if an error occurs,
you aren’t there so tell it what to do next. An
example is error checking; sequence can be
important… you should run error checking before you
defragment. A thorough defragment will stop if it
encounters an error. Then you computer is just sitting
there, waiting for you to show up Monday.
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Other ‘scheduled’ tasks.
Further, error checking doesn’t like to examine the location of the system- files.
If you want the whole disk checked, the Error Checking tool itself will ask if you
would like to run the tool the next time you start the computer.
While not technically a scheduled task as with the control panel tool, it has the
same net effect. Basically this will be added to a batch file that will run AS
Windows boots up.
Windows Booting
When Windows first starts, it really is a lot like DOS. This is called real mode. As
more and more of the ‘OS’ is loaded into memory, Windows shifts into protected
mode, then loads the full graphical user interface. Protected mode means each
program is assigned its own chunk of memory, and Windows builds a wall
around itself to prevent programs from crashing other applications, or the OS.
While in protected mode, error checking is blocked from the OS files, but in real
mode which is very DOS like, an updated scandisk can run easily.

Then when scandisk is finished, the
computer finishes booting and loads
the protected mode part of the OS,
and full graphical user interface.

There are problems here, too. What if there is a short brown out just after you
‘schedule’ the scandisk for the next boot, and suddenly your computer is reboots
now… instead of at the end of the day, when you wanted it to occur? Scandisk
can take many, many hours to run, effectively blocking you from using your
computer.
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Windows F Utilities
Diskcopy  in Windows
Scandisk Defrag in Windows
Disk Cleanup
Roll back/Restore
Add Remove
Command Prompt
In DOS we discussed format a: to prepare a disc for use; in Windows, if
you have a floppy disk, you could choose “File Explorer” or “This PC” ,
then right click the Floppy Disk Drive (A:) then, choose Format…

Your icons may differ slightly
The same goes for diskcopy
Just above the Format… menu item is Copy Disk…

Just like diskcopy a: a:
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For the remaining items in this section, right click the hard drive icon, and
choose Properties. Your icons may vary.

The C: Properties window

The C: Properties window displays the volume label, disk usage and file
system type. Note DOS used FAT, Windows typically used NTFS.
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To run the Windows version of basic DOS utilities, choose the Tools tab
scandisk  in Windows
is started using
Error-Checking
Thorough checks may
require being run at boot
defrag  in Windows
is started using
Defragmentation
msbackup  in Windows
is run using
Backup
The Backup feature has
been moved to in later
Windows.

Return to the General tab, and choose Disk Cleanup
Disk Cleanup is used to remove
‘garbage’ from the hard drive to
increase free space, by letting
users remove installer files,
temporary Internet files (cache),
emptying the recycle bin, etc.
Disk cleanup also can remove
temporary files that should have
been removed by programs, but
were not.
Note, Disk Cleanup only free hard drive space; it does not remove items
from memory, or delete applications.
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Restore computer setting
Modern versions of Windows are ‘plug and play’ systems, meaning that
Windows itself can often detect new software, and configure the computer
to use the hardware automatically. But that doesn’t mean the system is
foolproof. Typically, the most vulnerable time for your computer is when
you install new hardware or software, leading to problems even starting
computer. While the previously mentioned Backup tool can let you rebuild
your computer to the way it was, there may be some other options.
Your first indication of a problem might be a screen at boot indicating
there is an issue, and offering you the option of starting the computer
using the ‘last known good configuration.’ While troubleshooting is
beyond the scope of this text, choosing the previous configuration can
bypass a lot of work, though the new hardware or software may not
work, at least you have use of the computer.
To verify you have a ‘good’ configuration to choose, research backing up
your registry. (The Registry is the Windows list of hardware and software
that is installed on your computer, and how Windows can use those
items.)
If the computer won’t boot normally at all, for Win 7 is to press F8 when
booting; this boots to Safe Mode. Safe Mode starts the computer without
all the peripheral devices, one of which may be incorrectly set up and
now interfering with the boot process; while in Safe Mode, Windows can
often repair itself, allowing you to boot normally thereafter. In Windows
10, a failed boot leads to options; advanced options leads to start up
setting, which include Safe Mode. In Windows 11, Click Start, select the
‘Power’ button, and the hold down the Shift key and click Restart.
Error Checking can prevent some file corruption, but is not always
successful in recovering files that may have become corrupt. If some
Operating System files have become corrupted, you may be able to
simply ‘repair’ the OS by copying files from your install CD; however, any
patches and service packs may need to be reinstalled to bring your
computer back to the way it was. (Or, you could restore from backup.)
Your computer may also be able to set up ‘restore points;’ this commits
hard drive space to keeping track of changes made on your computer.
While tempting, typical users rarely remember to set these restore points,
so this may be a program to schedule. (Search Windows Help and
Support for the specifics on your computer if you wish to learn more on
‘Repairing your OS from CD,’ ‘Restore Points,’ or ‘Automated System
Recovery.’)
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Note: many computers have a Reset option, either as a vendor program,
or a separate partition storing the info on the computer’s hard drive;
these options will reset your computer to the way it was the first day you
started it, and should be avoided… because you have been making your
own backups, right?
Restore Hardware
While Plug and play works for many devices, newer devices may come
with a CD that needs to be run to update the Windows Plug and Play
database with addition instruction on how to recognize and use hardware.
These instructions telling Windows how to use a piece of hardware are
called drivers.
From time to time, a device may fail to work or stop working, even If the
computer boots normally. If you can rule out hardware failure, the driver
may be to blame. This type of situation requires the use of the Device
Manager, which was discussed earlier.
Your first action is to typically try to update the driver. You’ll be prompted
to insert a disk, or browse the Internet. If the current driver is the newest
version, you may wish to rollback to a previous driver, as the older driver
may be more stable. Another option is to delete the device, and reinstall,
either using the CD or plug and play.
Device drive codes
(X) Device is not working
(!)
Device may need attention.
(?)
Device is disabled
Some devices simply will not get along, or different users may not need
to load all the drivers for devices they don’t use; for those times you may
be able to use different, savable configurations.
That is, build one configuration for José uses the scanner,
and build a different configuration for Joanne who uses the
external DVD that doesn’t work well with the scanner
plugged in.
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Software
These days, new programs have installer software, and part of the job of
the installer is to update the Registry. That means if you simply delete an
application, the Registry has wrong information, and may lead to
Windows crashing.
Example, installing a trial version of Microsoft ‘Word’ reassigns the WordPad file
type (.rtf) to now open with ‘Word.’ If you simply deleted the ‘Word’ program at
the end of the trial period, the next time you double click a file that ends with
.rtf, the computer will generate an error as it can no longer find ‘Word.’ Instead,
the program must be uninstalled to reassign .rtf back to WordPad in the
Registry. This uninstall action is handled in the Control Panel.

Variations on add/remove, and installing Windows software.
In Windows XP, the Control Panel item you look for is
Add or Remove Programs
In later versions of Windows, the Control Panel item you look for is
Programs, or Programs and Features.

Click the item you wish to modify or uninstall.
Installing software.
As most programs now come with an installer that loads the software and
updates the registry, you typically don’t need the help of “Add Software,”
unless you want to add a Windows feature, such as a game that comes
on the Windows disk, or load a program from a network.
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Command Prompt
Start/All Programs/Accessories/Command Prompt
Windows Help
If using Windows command prompt, the HELP screen will look similar to:
C:\>help
For more
ASSOC
AT
ATTRIB

information on a specific command, type HELP command-name
Displays or modifies file extension associations.
Schedules commands and programs to run on a computer.
Displays or changes file attributes.

CD

Displays the name of or changes the current directory.

CLS

Clears the screen.

COPY
DATE
DEL
DIR

Copies one or more files to another location.
Displays or sets the date.
Deletes one or more files.
Displays a list of files and subdirectories in a directory.

FORMAT

Formats a disk for use with Windows.

This is not the full list, just what may fit on the screen.
To find usage, use HELP command-name or command-name /?
Note: You may use lower case or upper case when typing commands.

While similar to DOS, this is the full power of Windows, accessed from a
command prompt. (When you can choose how you interact with the OS,
you are said to be choosing ‘shells.’)
Note: Windows command prompt does not support deltree or undelete
Task Manager
By Pressing
at the same time, you can then Log off,
Switch Users, or access the Task Manager. The task manager lets you
view running Applications (and force them to quit if needed), or see how
hard your computer is working by selecting the Performance
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 Windows Lab 5 See Appendix C for help with Lab 5
Lab 5 Activities
Lab 5 Questions
Documentation 3 points each
Right Click Desktop; choose Personalize, then Themes

1.
2.
3.
4.
5.
6.

What does the Theme area control?
Explore other menus
What does the Desktop Background area control?
What will the Change Desktop Icons let you add to the desktop?
What does the Fonts area control?
What are some of the Lock screen options?

Customizing the Task Bar
7. What are the options available if you right click the Task Bar?
Customizing the Folders
8. What can you add to a folder icon? Can you replace the folder icon?
Windows activity, questions 3 points*, screen shots 5 points.
1. Using “File Explorer” or “This PC” select a storage device you can save files to.
If there is not a folder called ‘Lab 5’ there, create it. Yourname-lab5.rtf should be
created inside ‘Lab 5,’ using WordPad.
2. In order to add a web page to Favorites, what must you do first?
Choose the best answer
a) Right Click it. b) Open it c) Change Views to Details d) Unhide the folder
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3. Matching:
XP version
Vista version

Windows 10

Match the following
Button 1.
Button 2
Button 3
Button 4

Search
Like cd .. Up or Back
Used to change from displaying icons to lists
In earlier versions of Windows, used to get properties, or switch to
property view from Folder view

Note: In Windows 11 there is no Properties icon, select the item to see properties
displayed at the bottom of the windows, or right click item to open Properties
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Lab 5, continued
Changing the Desktop. Right click the desktop and Personalize.
4. Place the Icon for the Network
on the Desktop (icon, not shortcut).
a. Press PrtScr (or Snip) to capture the
desktop showing this change.
b. Paste the image in your lab5.rtf document
c. Change the desktop back, so the
Network icon is not on the desktop.
5. Explore the Themes setting, and discuss what can be changed.
6. Search for Display settings. Discuss how to change resolution of your desktop.
7. Discuss how you could add the Microsoft Word icon to your Start menu or
Taskbar
8. If you had a floppy drive, in “File Explorer” or “This PC” , if you right click
a. What actions can be performed on the floppy?
9. Right click the hard drive to open the properties with the pie chart of the hard drive.
a. Press Alt+PrtScr (Print Screen) to capture this window.
Paste the image beneath the other image in your lab5.rtf document
b. While in the same dialog box, click the Tools tab and get a screen capture
with Alt+PrtScr (Print Screen) to capture this window of the items on the
Tools tab; paste this image below the other images in your lab5.rtf
document
10. Get to the Control, and open the control panel item to ‘add or remove software’
(It will have the name ‘Programs and Features in the Control Panel item).
a. Press Alt+PrtScr (Print Screen) to capture this window.
Add below the other images
11. In File Explorer, right click your hard drive. Which Disk properties tab is the Disk
Cleanup button on?
12. Save document as yourname-lab5.rtf in your lab 5 folder.
You may Print your document, but it is not required.
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Hands On 6 points each
Be prepared to discuss:
1. Compression
2. Disk Clean Up
3. Fonts
4. Scheduling Tasks
5.Disk Property Tools and Right Click Disk options
Your lab5.rtf should look something like the following, when you are finished:
Desktop with Network
icon

Pie Chart Window

Tools tab

‘Add/remove’ Programs
and Features control panel

Submit files and quizzes as directed
See page 57 for details if taking a Collins class. Zip and save as yourname-lab5.zip

Note Information about new versions of Windows is in Appendix B
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G, H, I Windows 3.1-XP-Vista/Windows 7-Windows 8-Windows 10
Comparison of Program Manager to My Computer to This PC
Shifts in Customizing/Personalizing the Desktop

Windows 3.1, a graphical interface that ran on top of DOS

Note the lack of a Start Button… PIF was to run DOS programs in a window.
Windows 95, the first consumer Windows product that did not rely on DOS.

The interface remained very similar until Windows 8
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Windows 95 was followed by Windows 98, Windows 2000, Windows ME,
Windows XP, and then Windows 7. Starting with XP, the consumer version and
server version shared much of the same kernel, Windows NT 5.

Differences in the Log in screen
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Differences in the Start button

Windows XP Start button, quick launch, task bar, and system notification area

Vista Start button, quick launch, task bar, and system notification area

Win 7 Start, quick launch w/ browse, task bar, system notification area, to desktop button

Win 8.1 Start, quick luanch w/ browse, task bar, system notification area, to desktop button

Win 10 Start, Search, quick launch, task bar, system notificaiton area, to desktop

Differences in the Start Menu

A minor difference: the Shut Down options:
• XP you choose Start\Shut Down
• Vista you should choose Start then click the ►to the lower right to select Shut
Down
• Windows 7 you choose Start\Shut down.
Windows Vista
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Earlier versions of WordPad

Earlier versions of the Up button, and the icon to change icon Views

Up, equivalent to the DOS cd.. to move out of the current folder
and up the tree structure. Not available in Windows Vista or
Windows 7, but occasionally the  Back button accomplishes
the same thing.
Views, to change from Details, to List, to Icons, or
Thumbnails. Thumbnails display the image if a photograph
instead of an icon. More on views in the next section.
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Earlier versions of Windows Help
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Earlier versions of “File Explorer or “This PC”
Windows XP My Computer/Windows Explorer
Note: you had to select the [Folders] button to change from Property view on
the left, to the Tree view, as shown in the image on the right. Vista is also seen

Windows 7 Computer/Windows Explorer
Note: the Tree view is always available on the left, properties on the bottom.
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Earlier versions of Browsing to Network or Thumb drives

Windows XP

Windows Vista

Windows 7

Change View icon in earlier versions of Windows which was on the top tool bar,
compared to newer view options that are at the bottom right of the screen.

There were several ways to rename a file in earlier versions of Windows.

Choose the File menu, then Rename
Right-click the file, and choose rename
Click one on a file name to select the
filename and pause; click once more on the
filename, and the filename should go into
rename mode.
Note: you normally do NOT change an
extension when renaming a file.
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Changing file extensions in earlier versions of Windows.
You can also ‘fix’ icons for files that are opening with the wrong program, using the
[File Types] tab. For example, if you have Microsoft Word installed, the icon for (.rtf)
files changes from WordPad to Word.
By selecting File Types, you can browse to .rtf and choose WordPad to open that
type of file.

You can also change the look of a folder. Right-click the folder you wish to
modify, select Properties and choose Customize.

You can choose a picture to display on the folder, or you can choose
[change Icon…]
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Personal Folders in (My) Documents
When you save a file, unless you specify a different location, the file is
usually saved in one of your personal folders. The folders have several
names, such as Documents, Pictures, Videos, and Music.
In Windows XP, if you choose Start and then My
Documents, you will see the pictures, music, and
other personal folders are stored inside My
Documents.
Other programs may also set up personal folders
within My Documents.
In Windows Vista, all the personal folders are
saved separately, but there are often shortcuts to
the folders inside of (My) Documents. You can
locate all of the personal folders in the left pane.

In Windows 7, the personal folders are located
under libraries
in the left pane.

Again, these personal folders the icon isn’t the regular yellow folder.
Instead they’re descriptive of the contents.
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Desktop Properties (Windows 7 and earlier)
There are many things that can be configured on the desktop, the
background image (or wallpaper, as it is often called), the color of the
windows, the size of icons or the icon label text color, which optional
items aside from the recycle bin appear, which screen saver pops up and
when, and even setting the controls for the monitor and video card. You
can even make a change to all of the above, by selecting a ‘theme.’
There are many ways to get to the tools that allow you to customize the
desktop, or examine what is currently set. One method is to use
Start/Control Panel, and select Display. To manage the video card, you
might need to choose Start/Control Panel, and then select System, and
dig down into the Hardware tab, and the look through the Device
Manager… or, you could right click the desktop!
In Windows XP, once you have right-clicked the desktop,
you choose Properties. In Windows Vista, you choose Personalize.
XP tabs for the Display properties
Themes include coordinated
• desktop wallpaper,
• screen savers, and
• window appearance settings
Desktop controls
• how the wallpaper is displayed
• [Advanced] button to add icons

Notes
1. Change desktop icons
is used toScreen
add or Saver controls
• if a screen saver is used
•
remove Windowswhen
icons the screen saver shows
•
Advanced
control of the monitor
2. Display is to change your
power settings
Appearance
controls how
monitor settings
• Window are colored
3. Window Color links to
• How big icons are
• WhatSettings,
text is used with icons
Advanced Appearance
• Which optional icons appear
Settings
controls
where you
can change
icon
• the color depth
size, tool bar•color,
etc.
Resolution,
and
• Advanced control of the monitor
and/or video card

Vista items in Personalize (desktop)
Windows Color and Appearance
controls how
• Window are colored
• How big icons are
• What text is used with icons
• Which optional icons appear
Desktop Background controls
• how the wallpaper is displayed
Separate Sounds and Mouse options
Screen Saver controls
• if a screen saver is used
• when the screen saver shows
• Advanced control of the monitor
power settings
Themes include coordinated
• desktop wallpaper,
• screen savers, and
• window appearance settings
Top left: option for optional icons
Display Settings controls
• the color depth
• Resolution, and
• Advanced control of the monitor
and/or video card

Use the following guide to explore desktop options for Windows XP-Vista
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Desktop Properties, side by side comparison of XP and Vista
Customizing the Windows XP Desktop Customizing the Windows Vista Desktop

Choose Properties

Choose Personalize

Contents:
Themes
Desktop (Vista Desktop Background)
Screen Saver
Appearance (Vista Windows Colors
and Appearance)
Settings (Vista Display Settings)

Contents of note:
Change Desktop Icons (XP
Appearance\Customize)
Windows Colors and Appearance (XP
Appearance)
Desktop Background (XP Desktop)
Screen Saver
Themes
Display Settings (XP Settings)

XP Themes

Vista Themes
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XP Desktop (Vista Desktop Background) Vista Desktop Background (XP Desktop)

XP Desktop, con’d [Customize Desktop]

Change Desktop Icons (top left)
(XP Appearance\Customize Desktop)
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XP Screen Saver

Vista Screen Saver

XP Appearance
Must click Advanced... to change other

Vista Windows Colors and Appearance
Open 'Classic appearance properties...'
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items

Must click Advanced... to change other
items

XP Settings (Vista Display Settings)

Vista Display Settings (XP Settings)
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Again, these items can be accessed via the Display tool in the Control Panel.
Below is a side by side comparison, in Classic view, of XP and Vista control panels.
XP Control Panel

Vista Control Panel

Note: Add or Remove Programs

Note: Programs, or Programs and Details

To start the Task scheduler in earlier versions of Windows:
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In Windows XP, you choose Control Panel/Scheduled Tasks.
In Windows Vista/7, while technically a Control Panel item, the fastest
way to start the program is from the Start Button, using Search. After
typing ‘tas’ in the search box, you’ll see the Task Scheduler listed at the
top of the Start menu. Once running, choose Action/Create Basic Task…
Or, go to the Control Panel\Administrative Tools\Task Scheduler.

Earlier Windows Start Menu Properties tab, and Customize options

The Notification Area tab in earlier versions of Windows
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The central Taskbar displays
programs that users start. The
System Notification Area, also
known as the tray, displays the
programs Windows has started,
such as Antivirus software.
This means the a large part of
the taskbar could be consumed;
instead by selecting ‘Hide
inactive icons,’ you cut down
the space used for displaying
the tray, freeing the space for
the programs the user started.
Toolbars tab…Your choices will vary

See http://www.windowsitpro.com/article/windows-7/windows-7-workarounds.aspx for
great information on customizing Windows 7

Note Information about new versions of Windows is in Appendix B
End chapter 7
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Paste Special
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Lab 6 Activities
Lab 6 Questions
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Windows J Networks
Shared Folders
Mapped Network Drives

Networks

You could compare a computer to a book. While it contains a lot of useful information, a library would
have even more information. Thus, if you could connect computers to other computers, the increase in
information would be dramatic. This is the idea behind LANs, or Local Area Networks. A collection of
LANs is called a WAN, or Wide Area Network. The Internet is a collection of WANs...
There are several kinds of networks... Peer to Peer is where a regular computer shares info with another
regular computer. This bogs down though, if too many computers get involved. For larger networks,
typically something called a client-server network is used.
A client-server network involves a special computer that like a waiter, serves to you, the client, what you
requested.
To allow the computers to communicate with each other they need the basics for any communication: a
sending device, a communication channel, and a receiving device. Typically at home, the sending and
receiving device are a modem, and the communication channel is a telephone line. Many broadband
users now tie into the coax cable TV network.
In a business that has a LAN, the most common type of network is called Ethernet; the sending and
receiving device types are called a NIC (network interface card) and the communication channel is what
is called cat 5 (category 5) wire. Cat 5 is suitable for slower 10 Mb connections, or faster 100 Mb
connections, which are often referred to as 10Base T or 100BaseT.
The server and client wires normally connect to each other through a hub of some sort, in a topology
called a star. Other topologies include stars and bus designs.

Dial up Phone line
(Cat 3 Twisted Pair)
uses RJ11connectors
Ethernet network line
(Cat 5 or Cat 6 Twisted Pair)
uses RJ45 connectors

Coax (coaxial) cable & connector;

Fiber Optic cable (many cables bundled) & FDDI
connector
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About your Network drive
At Temple College, I have an O:\ drive and an H:\ drive; these are folders
that is not on the computer’s hard drive, but a server’s hard drive. That
makes the O:\ drive accessible from any computer on the network.
In order for you to use a network folder, two things have to occur… the
administrator of the network has to create and then share the folder, and
then map a ‘network drive’ on your computer.
How to share a folder in Vista
Due to security issues, many students are not allowed to ‘share’ folders
on their school computer, so you must memorize the following steps.
Right Click a folder, choose Properties, then Sharing
(on some computers, you may also be able to right click a folder and
choose Sharing and Security, or something similar)

Choose the [Share…] tab (it may be labeled Share or Sharing)

Choose the [Share] button. You then choose who to share the folder with,
and set security on the folder, such as passwords.
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The icon for a shared folder may look like a ‘server’ bringing it

or like a folder with multiple faces, to indicated others can see it

Due to the ability to customize folders, there may not be an icon
showing the folder has been shared; but for the test… know the icons!

For those with computers at home that have multiple users, you may
wish to experiment with sharing a folder, so a different user will be able
to open the shared folder. However, this requires a bit more know-how
than is covered in an Intro to Operating Systems class, such as being
able to locate the shared folder within the hierarchy of the file system.
But, the point is, sharing folders is exactly the key concept of Networking.
Servers have controlled access of the shared folders, so only specific
users can use the folder, and access is normally given via passwords.
Mapping a drive so the user doesn’t have to search for the shared folder
is coming up in just a moment, but even more on shared folders and
mapping network drives is covered in the Network Server class many of
you may take.
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About Mapping drives
In a local drive, such as C:\, the files and folders are actually stored in a
disk within that computer. A mapped network drive is a path to a shared
folder on another computer.
Due to security issues, many students are not allowed to ‘map’ network
drives to shared folders on other school computers, so you must
memorize the following steps.
Earlier Windows, Start/ Computer, choose the Tools menu.
(You may need to press the [Alt] key to reveal the Tools menu.)
Choose Map Network Drive…
Newer Windows, Start/’This PC,’
Click This PC in the left bar,
then click the … in Windows 11, or Computer in Windows 10
then click Map network drive

Windows 11

If you were to see a $ at the end of your folder, that means the shared
folder is hidden, and no one can find the folder by browsing.
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1. Select the O: drive*
2. Note the path to your O: drive
3. Note the generic form of the
mapped network drive
\\server\share (shared folder)
4. If you wish to make a new
network drive, you may be able
to [Browse] to the shared folder
5. If you wish to continue using
the mapped network drive, select
Reconnect at login
Do not make changes to your O: drive

You will NOT make any changes here, just examine what has been set up.
DO NOT CHOOSE [Finish], instead you will choose [Cancel]
Browsing the computers within our network
Again, you may not have sufficient permissions to browse the network.
If not, Memorize the following:
Windows XP  Start/My Network Places

Under ‘Other Places’, choose Entire Network.
Choose Microsoft Windows Network.
Choose TCNET, some other available network to see some of the computers within your
network.

Newer Windows: Choose  Start/Network or This PC, and select Network.
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You may get a popup asking if you wish to load the Network Discovery
feature of the Network and Sharing Center… if so, you will need to
provide an administrator’s username and password for the machine.
Check with the Instructor for this information, if available.

You will NOT make changes here
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Windows K OLE
Paste Special
OLE: Object Linking and Embedding
OLE stands for Object Linking and Embedding; you should be familiar
with objects… an object basically is anything a computer can manipulate.
When we did lab 4, we didn’t copy the entire Paint file, we selected and
copied only a portion of the file… and that portion became an object. In
Spreadsheets you can create a chart… the chart is a component part of
the file, and it can be manipulated, so a chart is another example of an
object. Each screenshot you made and pasted into your word processing
documents was an object.
And, you already know about the embedding concept, but not perhaps
with that name. Every time you copy and paste you are embedding a
static copy of an object into a different document.
The problem with embedding becomes obvious if you think again about
the chart object.
Scenario, a chart has been created in Excel. The chart is selected, then
copied. The user then opens Microsoft Word, and chooses to Paste
(embed) the object.

After a moment, the user realizes that one of the Excel values is
incorrect. They change the value, and the chart in Excel automatically
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changes, but NOT the chart in Word, as it is a static snapshot that was
embedded.

The solution is to LINK, rather to the object, rather than embed a static
copy. A link is nothing more than a PATH to an object.
To link you still select and object and copy, but the secret to linking is
to choose Paste Special. We have finally encountered a time when
‘right click’ fails us.
In Word, choose the  beneath Paste.

Then choose Paste Special.

Then choose Paste Link
and finally, select

As: Microsoft Office Excel Chart Object

If both documents are save in the same folder… any changes made in the
Excel chart will show up in the Word document. To verify it is up to date,
right click the Word chart, and choose Update Link.
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 Windows Lab 6
Lab 6 Activities This is typically a GUIDED activity
Lab 6 Questions
Documentation 30% (Fill this sheet out, later you may submit in a quiz.)
As discussed on page 189, open Map Network Drive…

1. True or False: a mapped network drive
is a shared folder on a server that can be
accessed from your computer.
2. What is the path to your O: * drive?
3. What is the generic example of a
mapped network drive?
4. If you wish to make a new network
drive, is there a way to locate the shared
folder available? If so, what is it?
5. What must be done if you wish to
continue using this network drive?
Do not make changes to your O: drive

Windows Activity 1:
Create a folder called lab6.
Open Microsoft Word, NOT WORDPAD
then start Excel. 1) Add the following to the Spreadsheet:

2) Select the cells by dragging the mouse over and down;
3) using the Insert Menu, click to add a pie chart;
4) Save the worksheet in lab6 as yourname-lab6.xlsx.
5) Right click the chart, and choose copy.

6) In Word on the Home Tab
[Paste] Paste Special – Paste Link Microsoft Office Excel Chart Object

To test and verify that the chart is linked and not embedded: make a change in the spreadsheet, this should
change the chart. In Word, right click the chart, do you see “! Update Link” ?
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Windows Activity 2:
Open Network as described earlier, browse the Entire network, if allowed.
If not, just get a screenshot showing you tried to browse the network.
Use Print Screen, then Edit/paste to embed that image in your word
document, save the file with the chart and screenshot
as yourname-lab6.docx. (Do even if nothing show for you in network.)
Your lab 6 folder contents should now look similar to this:

Your Word document, yourname-lab6.doxc, should look similar to this:

A
B
C
D
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Lab 6 Hands On Q&A 30% (Fill this sheet out, later you may submit)
What is a client server network?
What is a peer to peer network?
Describe the process of sharing a folder (from book material).
What is different about the icon for a shared folder in
Windows XP or Windows Vista?
What is a network mapped drive?
XP Shared folder above
Describe the process of mapping a network drive.
Newer shared folder icon
What does OLE stand for?
What is an object?
How is linking different than embedding?
How do you update a link?
Note, the process of zipping may break the link between Word and Excel,
so your faculty member may wish to view your Word document and test
it to see if the chart is in fact linked before you submit this work.
Submit files and quizzes as directed
See page 57 for details if taking a Collins class. Zip and save as yourname-lab6.zip

Note Information about new versions of Windows is in Appendix B
End chapter 8
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Windows Bonus Material
Browsers
eMail
Networks  Internet

Earlier we discussed Networks, and how they were a series of computers that
could share information. Most networks are closed, that is, you have to
physically connect your computer to the network.
A Local Area Network (LAN) is a geographically compact network, such as a
room, or building.
A group of LANs that can share information, such as two different campuses of
the same school might be a Metropolitan Area Network, or MAN.
A group of MANs, across a large geographical might be a Wide Area Network, or
WAN.
Some networks allow ‘guest access’ to parts of the information stored on their
network… which lead to what we now call the Internet… the Internet is for all
practical purposes a network made up of thousands of WANs.
To access this huge WAN, you typically use a Browser, such as Firefox, Safari, or
Internet Explorer.

Browsers: Internet Explorer 11 or similar
Refresh (F5)
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URLS
An Internet Address (URL, or Uniform Resource Locator) is made up of
many parts. Just as a mail carrier starts with the zip code and works
backward to the street, then an individual stop on that street, a URL has
similar information
stamp
1st class

house street
2600 S. First, Temple, TX

Zip code
76504

protocol
http://

host
www

Top level domain
edu

domain
templejc

Other Top Level Domain Names: .com, .org, .net, .mil, .gov, or
country codes, such as .us, .uk, .ca, or .tv
Other protocols: https:// or ftp://
Tools\Internet Options
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Searching the Web
To increase the precision of your search results, many search engines require that
most of the words in your search string be present in the result documents. So, it
may be better to start by listing just a few key words, and add additional terms to
refine searches.
To gain even more control over your results, please read through the following hints.
•
•

•

Most search engines support full Boolean capability; Boolean terms are AND,
OR, & NOT.
Use AND to connect a series of keywords you would expect to be in your
documents, this forces the search engine to include that word in documents.
Example: War AND Peace
will return documents that contain both the word War and the word Peace, not
just one or the other as with a simple series of words.
Use OR to retrieve documents that include either of the search words
Example: encryption OR cryptography
will locate documents that either include the word encryption or the word
cryptography.

•

Use NOT to indicate a word that must not appear in the documents. Example:

•

dolphins NOT NFL
will deliver searches on the mammal, rather than the football team.
Some browsers use + and - instead of AND or NOT; you may use a + (plus) to
indicate words that must be present in the documents and a - (minus) for those
that must not be present. Examples:
+dolphins -NFL
+recipes for +cake -nuts

•

•

Use quotes around specific phrases to focus your search on occurrences of the
actual phrase.
Example
“War AND Peace”
will return documents with the phrase "War and Peace" (such as discussion of
the book by Leo Tolstoy), instead of random pages on conflict and quiet; thus
you can use quotes to force the search on the phrase, rather than individual
words,
Slowly add additional words in your search if the results are still too random, but
don't do this too early... you may be putting blinders on the search engine, and
miss good results. The often, the more words you enter, the more on target your
results will be.
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Cookies
A cookie is a file left on your computer from the web site you are visiting. The intent
was perfectly legit. Preferences can be stored here, to make a faster interaction
possible. Or they may just sit there, taking up valuable disk space (along with tons of
other files in your cache (which is worthy of another article...).
Or those cookies can release those preferences, and other info, to other web
master for less honorable purposes. But there is hope, go and delete all those extra
cookies in your cache!
Tools/Internet Options/General/Browsing History
Using Browsers maybe covered in more detail in class
Security/Privacy
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Identity

Advanced

Note: You may wish to investigate the Control Panel RemoteApp
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eMail

Also available are condensed versions of
MS Word 2013, Excel and PowerPoint.

Log into your account

Remember passwords are case sensitive.
What is your USER NAME? Your username consists of your last name plus first letter of your first
name and the last 3 numbers of your Temple College ID number.
Example: Nora Jones has Temple College ID number 0003234, so her username is: jonesn234

The top navigation bar is how you get to your email, calendar, and other applications

Select Outlook to access your TC email
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The first time using Outlook, a window asking for language and time zone appears.

Then click save

Parts of Outlook in Office 365
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Reading email messages
•
•

Above figure shows no messages in the "Inbox"
Below shows messages received

Deleting email messages
Keep mailbox current and eliminate clutter
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The message was moved to the Deleted Items folder
•
•
•

To select multiple messages move the pointer arrow over the area to the left of the sender's
name
When the arrow turns to a hand, click once to select
After multiple messages are selected, the reading area displays options

messages were moved to the Deleted Items folder

Sending a message using Office 365
Click on new mail to compose a new message to send
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Discard option

Adding attachments
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Spell checking your composed message
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Message formatting tools
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Bold

Italic

Underline

Bullets

Numbering

Decrease
Indent

Increase
Indent

Highlight

Font
Color

Remove
Formatting

Align Left

Center

Align
Right

Insert
Hyperlink

Remove
Hyperlink
Add
Alternate
Text to
image
More

Insert
Table

Superscript

Subscript

Strike
through

Left to
Right

Right to
Left

Undo

Redo

Remember to sign out when through
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Netiquette and a Smiley (Emoticon)
Netiquette is about not what you can do, but what you should do. The Core Rules of
Netiquette were written by Virginia Shea, and discuss how you, as an Internet User,
suddenly have a lot of power... and why you shouldn't let it go to your head!
Below are the 10 rules Virginia Shea developed, and my quick take on them.
Rule 1: Remember the Human (you aren't dealing with machines, you are dealing with
people who put information on machines; just because you can't see them doesn't mean
they don't exist. All other rules relate to this one. Remember this Mantra: Treat others as you
wish to be treated)
Rule 2: Adhere to the same standards of behavior online that you follow in real life (Don't
hide behind the anonymity of a made up username, and forget everything you mother taught
you! Behave on line as you would in the non-virtual world. Treat others as you wish to be
treated)
Rule 3: Know where you are in cyberspace (It is illegal for people in Saudi Arabia to have
pictures of bikini models... so don't email one there. You have to contend with import/export
and local laws, as well as laws of places you visit electronically)
Rule 4: Respect other people's time and bandwidth (Every file you get uses someone's
computer power, and takes up bandwidth, which they may have to pay for. Just be aware of
the implications. Treat others as you wish to be treated)
Rule 5: Make yourself look good online (Electronic communication lacks the nuances of
body language and inflection, be sure of what you are communicating... look for double
meanings, and use spell check!) More on this topic below...
Rule 6: Share expert knowledge (What makes the system work is the idea of 'you rub my
back, I'll rub yours.' Treat others as you wish to be treated)
Rule 7: Help keep flame wars under control (If someone is an idiot, they deserve to know.
Once. Don't swamp their mailbox with insults every day for the rest of your life. Treat others
as you wish to be treated)
Rule 8: Respect other people's privacy (If you don't want folks looking in your medicine
cabinet, return the favor. Treat others as you wish to be treated)
Rule 9: Don't abuse your power (You could look through other folks files, you could tie up
their server, you could ruin their mail box... don't. Treat others as you wish to be treated)
Rule 10: Be forgiving of other people's mistakes (You will make mistakes. How do you want
to find out about it? A flame, or a friendly hint? Treat others as you wish to be treated)
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Smileys and trying to communicate with email

Many people retain information according to the following rates:
10% of what they read
20% of what they hear
30% of what they see
70% of what they see and hear...
The problem with email is that you have eliminated 90% of communication when you
are stuck with just reading. To try and overcome this shortcoming, many people try
to use emoticons or abbreviations.
Emoticons (Emotion Icons), or smileys, are keystrokes to represent your body
language when sending a phrase. If someone in person asks me how a student is
doing... reading 'just fine' has a completely different meaning than if I said it in
person, and I rolled my eyes. So to convey a smile, a frown, etc. people use smileys.
To read a smiley, you have to turn your head 90° to the left.

So, :) Looks like

Some Programs, such as Microsoft Instant Messenger
actually convert the keystrokes into pictures, to take away
the guessing.
And guessing can be a problem, when people use nonstandard, complex emoticons, such as (8u{)>. (That's
me... but since it didn't convey anything until I said that, it
is an example of how NOT to use them, as they don't help
communication.
Many people will also use abbreviations and acronyms to try and improve
communication. A lot of you know that LOL is laughing out loud, and that IMHO is In
My Humble Opinion, but a lot of these also get to complex to be useful. It is so much
easier to just say what you mean, re-read it for clarity, and then send it!
But just in case, here is a short list of common chat acronyms (or chaq, pronounced
"chalk") :
BFN or ttfn, bye or tata for now; BRB, be right back
BTW, by the way
CWOT, complete waste of time
DIY, do it yourself
RTM, read the manual

A more detailed list is at http://www.sharpened.net/glossary/acronyms.php
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Review
Before continuing, verify you are caught up; ask your instructor on how you can
check.
Feel free to copy and email answers to your instructor... Theywon't give you the right
answers necessarily, but they’ll let you know where you still need a little work.
Note: This test is a little more challenging
PS, The first part of the final will include the same information as Test 2.
There are suggestions on studying, on the class web site

•
•
•
•
•
•
•
•
•

What does the left mouse button do?
What does the right mouse button do?
What is minimize?
What is maximize?
What is restore?
What is a dialog box?
What types of Help does Windows have?
What key gets help?
Why should you ‘shut down’ a computer?

•
•
•
•
•
•
•
•
•
•

Name three ways to start a program.
Name three formatting options
Discuss cut, copy, and paste
How do you view the tree/folders structure in Windows?
How do you create new folders in Windows?
How do you rename folders in Windows?
How do your delete folders in Windows?
How do you undelete in Windows?
What is a shortcut?
How do you create a shortcut? On the desktop?

•

How do you change file viewing options? Name two.

•
•
•
•

How do you change the desktop?
If the button is not there, look for [Advanced] [Customize] [Options]
Name three changes you can make to a desktop
Discuss tasks that may be scheduled, and why.

•
•
•
•

How do you format a floppy?
How do you copy a floppy?
How do you ‘clean up’ a disk?
How do you find out all about your hard drive, such as getting a pie chart
of usage?
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•
•
•
•

Name two tools for disks
Should you just delete a Windows program? Why or why not?
Can you enter DOS commands? How?
Is this really DOS?

•
•
•
•

What is a URL?
What is Back?
What is a favorite?
Where do you set your home page, or privacy, etc?

•
•
•
•
•
•

How do you get to the school email?
What is a CC? A BCC?
Can you unsend?
What is an emoticon?
What is an address book? How can you add addresses to it?
How can you organize your mail?

•
•

Discuss protecting your identity.
How do you know if a site is secure?

•
•
•
•
•
•

What is a client server network?
What is a peer to peer network?
Describe sharing a folder.
What is the icon for a shared folder?
What is a network mapped drive?
Describe mapping a network drive.

•
•
•
•

What does OLE stand for?
What is an object?
How is linking different than embedding?
How do you update a link?

Note Information about new versions of Windows is in Appendix B
End Chapter 9
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Linux Intro
About Linux
Setting up Linux
Reduced DOS-Linux guide
Sample Linux Session
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About Linux
Linux is a UNIX like operating system, meaning that while the programming that built
the operating system differs from Linux, it behaves in a similar fashion.
UNIX originally came out of ATT’s Bell Labs in the 1960s from teams working on
time sharing operating systems for main frame computers. It was reinvented in 1972,
this time around being based in the C programming language.
But when UNIX really took off was when some college kids started using UNIX for
research, and to play computer games on a network… but that is another story.
In the early 1990s. Linus Torvalds created an operating system that behaved like
UNIX, but could run on personal computers. Further, he release this operating
system as ‘open source,’ meaning anyone could use it, and even modify it, for free.
Another unique feature, at least to Windows users, it the choice of how the user
interacts with the operating system.
The Kernel is the most basic part of an operating system. In DOS, the only way to
access the kernel was using the DOS command prompt. But newer operating
systems have options on how to interact with the kernel… these are called shells.
Example: Windows can be interacted with via the command line or the graphical
user interface.
But in Linux, there are many, many shell options, allowing the user to interact with
the kernel in many different ways.
The Bourne shell replaced the Thompson shell in 1977, becoming the default UNIX
shell
C shell uses C language-like syntax is, and is an interactive shell, mainly used to
write programs called shell scripts
The KornShell is a complete, powerful, high-level programming interface for writing
applications
The Bash shell, Bourne Again SHell, is an updated version of the Bourne shell, and
is now the default shell for Linux
Notes:
•Everything in UNIX/Linux is treated as a file
-rwxr-xr-x the – at the beginning indicated the items is an ordinary file
drwxrwxr-x the d at the beginning indicated the items is a directory
crwxrwxr-x the c at the beginning indicated the items is an character device
brwxrwxr-x the b at the beginning indicated the items is a block device
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While you may be using Linux on a stand alone computer, it can also be
accessed via remote connections. To set up the UNIX client, you must
first start an emulator program, such as putty.exe or Cygwin.
Skip the following if using Cygwin
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All you worry about is the Host Name (or IP address), an example might be 10.3.50.50,
then choose Open
If you get a message about a key, choose [Yes] to trust the host and cache (save) the updated information

For Collins students using remote access only

If you are a day student, your log in name is the linux+machine number (two digits)+a
If you are a night student, your log in name is the linux+machine number (two digits)+b
Your password will be Password2 (note the capital P and the number 2)...
your password WILL NOT DISPLAY when typing
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While most standalone systems use gEdit, an editor released under the GNU
open licence agreement, some systems are accessed remotely may require
using the VI command line text editor.
Step 1, type vi filename
You are now in command mode. Go to step to start inserting text
Step 2, to insert text, type the letter "i" …i…
You are now in insert text mode. Type your name …Craig…
When you have finished typing, you must escape from insert mode
Step 3, when finished editing, hit <ESC>
Step 4, to save and exit type (upper case, hold down the shift key) …ZZ…
More about using VI available on Google, etc.

Introductory Linux Commands
•
•
•

paths use / instead of \ such as \home\user
command are case senstitive
command parameters use – instead of / such as ls –R

•
•
•

directory listing
long directory listing
tree like directory listing

ls
ls-l
ls-R

•
•
•
•
•
•
•
•
•

make directory
change directory
create a file
edit file
display file
copy file
move or rename
delete file
remove directory

mkdir foldername
cd
touch filename
gedit or vi filename
cat filename
cp source destination
mv source destination
rm filename
rmdir foldername
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Sample Linux Session
Desired action
See full path to current directory
Brief directory listing
Make a directory called junk
Brief directory listing
Long, detailed directory listing
Create an empty text file
Long, detailed directory listing

Command given
pwd
ls
mkdir junk
ls
ls -l
touch test.txt
ls -l

Overview 10 Linux Intro

Result (your result may differ)
/home/linux01a
(nothing to display)
(nothing to display)
junk
drwxrwxr-x
junk
(nothing to display)
drwxrwxr-x
junk
-rw-rw-r-test.txt
(vi opens; insert, save/close)

vi test.txt
or gedit test.txt
ls -l
drwxrwxr-x
junk
Long, detailed directory listing
-rw-rw-r-test.txt
You may see a back up file
-rw-rw-r-test.txt~
created (test.txt~)
rm test.txt~
Remove backup file, if there
(nothing to display)
ls -l
drwxrwxr-x
junk
Long, detailed directory listing
-rw-rw-r-test.txt
shows back up file created (~)
cat test.txt
Display the contents of test.txt
(contents display)
cp
test.txt
junk/new.txt
Copy test.txt into junk
calling the copy new.txt
ls -R
drwxrwxr-x
junk
Recursive directory listing
-rw-rw-r-test.txt
Edit text file (see vi on p.C-6)

Change into the junk directory
Remove new.txt
Use arrow keys to run ls
Go up one directory
or
Change into the home directory
Remove the junk directory
Long, detailed directory listing
Rename test.txt to fred.txt
Long, detailed directory listing
Delete all files in this directory
Long, detailed directory listing

cd junk
rm new.txt

junk
-rw-rw-r-new.txt
(prompt changes)
(nothing to display)
(no file to display)
(prompt changes)

cd ..
or
cd $HOME
rmdir junk
(nothing to display)
ls -l
-rw-rw-r-test.txt
mv test.txt fred.txt
ls -l
-rw-rw-r-fred.txt
rm *.*
(nothing to display)
ls -l
(nothing to display)

Try Calendar command cal to display current month
Try Calendar command cal 12 2010 to display December of 2010
Try Calendar command cal 9 1752 to display September of 1752
Note Full DOS-Linux guide is in Overview 11
End chapter 10
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Linux Commands
DOS/Windows -Linux guide
Graphical User Interface quick start
Linux Lab 7
Linux Commands
Linux Activities
Linux Questions
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Linux Commands
DOS/Windows -Linux guide
Graphical User Interface quick start

DOS

UNIX (*Linux)

help

man command

command /?

whatis command

Help commands

end session with q

apropos keyword

Clear screen
cls

clear

To Display the present working directory
prompt $p$g

pwd

Root directory
\

/

Directory Listing Commands
dir
detailed
dir /w
just file names

ls -l
ls

detailed
just file names

tree

ls -R

all directories and files

cd

basic command

cd ..
cd /

move up one directory
move to root directory

cd $HOME

to \home\your home

all directories and files

Change Directory/Folder commands
cd
basic command
cd ..
cd \

move up one directory
move to root directory

Used to make directories/folders
mkdir directoryname

mkdir directoryname

md directoryname

UNIX (*Linux)

DOS

File creation
copy con filename

use [Ctrl] + [z] to end

touch filename
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255 characters
allowed
avoid spaces and hyphens as first
character
'hide' a filename with . for first character
('see' w/ ls -a)

8.3

Used to specify multiple files
* or ?
wildcards

*

or ?

metacharacters

Text Editing
edit filename.txt

vi filename.txt

Display the contents of a text file on the monitor
type filename

cat filename

File Manipulation
move source
destination
rename source
destination
copy source
destination

move
rename
copy

ex copy aa.txt fld\aa.txt
File deletion
del filename

delete

Folder deletion
rd foldername
must be empty
rmdir foldername
must be empty
deltree foldername will delete w/contents

mv source
destination
mv source
destination
cp source
destination

read only, archive, sys,
hidden

copy

rm filename

remove

rmdir foldername
rm -rf foldername

must be empty
will delete w/contents

File properties
attrib ± ? filename

rename

ex cp aa.txt fld/aa.txt

UNIX (*Linux)

DOS

move

chattr ± ? filename
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From Intro to Computer classes, Powers-of-two number line.
210

29

28

27

26

25

24

23

22

21

20

1024

512

256

128

64

32

16

8

4

2

1

Folder Properties

chmod ugo ± ?
foldername

chmod 755 foldername

read, write, execute
for user, group, or
other
standard web
permissions
d rwx r-x r-x
rwx
421
read=4
write=2
execute=1
7==4+2+1, r+w+x

To redirect output, such as from the monitor to a file
>

example:

type aa.txt > lpt1

>

example: cat aa.txt > lpt1

To sequence commands; take the output of one command and use it as the
input for another
|
example: (pipe)
example: (pipe)
dir | more |
ls | more
Day and Month
date

cal
cal mm yyyy

Windows

UNIX (*Linux)

End Command Line session
exit

exit

Automatically replace typed text with predetermined text
alias xx=command
auto correct

Windows

Searching
search
search contains

UNIX (*Linux)
find filename
grep word
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End program
X
File\Close
[Ctrl]+[Alt]+[Del]
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q
kill

UNIX specific items
passwd

command &

[Ctrl]+[z]
Database features
join
find
grep
uniq
diff
tr

Other useful info
nice [command]
[command];[command]
[command] &
[Ctrl] [z]

Other useful info
df
ps
free
dd
tar

change password
(must change at least 3 items)
required aspects
minimum 6
minimum of 1
minimum of 2 letters
characters
number
ex Password1
starts command, but will run in background
pause

To combine records, or files
search for files in a directory hierarchy
print lines matching a pattern, to search for words within files
remove duplicate lines from a sorted file
find differences between two files
translate or delete characters, such as changing from upper
case to lower case
runs the command as low priority
use the ; to start multiple programs
start process in background (fg will bring it back to the
foreground)
suspend process
continued
show free disk space (see man df for other options)
show processes (see man ps for other options)
show remaining RAM
convert, then copy a file... used when using Windows to
download a Linux distro
create a compressed format backup file, i.e. tar -cvf

/home/archive.tar /etc

where archive is the file created in the /home directory, and is a
backup of /etc
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If using a standalone Linux box, you will have to be able to locate the terminal, the command
line shell. So here is a quick primer on the GNOME 3 Linux Interface
The Desktop is fairly barren, to the Menu bar on the top, especially on the right

Accessibility settings, Volume, Network Connection, and user options

Enable the network connection, if there is an X showing on the Network icon,
click to turn on
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Much like Windows 8, to access info, Press the ‘Start’ key
You will now see two options, Windows and Applications.

Quick Launch on the left for browser, and browsing files.
Switch windows is on the right.
If you have applications running, you switch by selecting on the Windows screen.

Right click a menu on a program window to maximize, minimize, or restore down.
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Click Applications to browse for programs or to search, in this case find TERMINAL.

Finished? Click on the User options icon top right.

Press the Alt key….
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 Linux Lab 7
Linux Commands
Linux Activities
Linux Questions
Documentation 30% (Fill sheet out, later you may be submiting your answers)
man
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
How do you end the man session
ls
What does the command do?
What is the DOS equivalent?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
After doing the activity, come back and fill in the examples
Write out one example of how the command was entered into Linux in this lab
mkdir
What does the command do?
What is the DOS equivalent?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command was entered into Linux in this lab
cat
What does the command do?
What is the DOS equivalent?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command was entered into Linux in this lab
cp
What does the command do?
What is the DOS equivalent?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command was entered into Linux in this lab
rm
What does the command do?
What is the DOS equivalent?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command was entered into Linux in this lab
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rmdir
What does the command do?
What is the DOS equivalent?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command was entered into Linux in this lab
mv
What does the command do?
What is one DOS equivalent?
What is the other DOS equivalent?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command was entered into Linux in this lab
chmod
What does the command do?
What is the syntax for the command?
(Syntax does not include specific drives or directories)
Write out one example of how the command was entered into Linux in this lab
Linux Activity 40% (Fill sheet out, later you will submit your answers in D2L)
Log into the Linux account, and make sure you are in your home directory
(~ folder)
Create a folder. ITSC 1305-01 students will call this folder test1.
1305-02 students will call this folder test2.
Exact command typed into Linux to create folder:
______ ___________
Change into the new folder. Exact command typed into Linux:
___ __________
Use touch to create a file called test.txt. Exact command typed into Linux:
touch test.txt
Start a linux editor, Exact command typed into Linux:
gedit test.txt
Now edit the file to include your name in the text file. Save and exit.
Display the contents of your text file. Exact command typed into Linux:
___________ ___________
Create a folder named web. Exact command typed into Linux:
___________ ___________
Display a simple directory listing. Exact command typed into Linux:
______
Should look something like youraccount@myserver ~ $
web
test.txt
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Copy your text file into the folder called web. Exact command typed into Linux:
__________ ___________
Run a recursive directory listing to see the contents of all directories, Exact
command typed into Linux:
___-___
Should look something like youraccount@myserver ~ $
web
test.txt…
web ……………………..
web ……………………..
test.txt……………………..
Change into the web folder. Exact command typed into Linux:
___________ ___________
Rename the text file in the web folder to index.htm. Exact command typed :
___ ________ ________
Change from the web folder to your test folder. Exact command typed:
cd ..
Set the web folder to standard Internet folder permissions. Exact command:
_____ ____ web
Display a detailed directory listing to verify the permissions were set.
Exact command typed into Linux:
__-__
Display the Calendar for September of 1752. Exact command typed into Linux:
_____ _____ ___________
Change into the web folder. Exact command typed into Linux:
__ ___________
Command used to delete your index.htm file. Exact command typed into Linux:
_______ ____________
Command used to move from web folder back to your 'test' folder.
Exact command typed into Linux:
__ ___
Command used to delete empty web folder. Exact command typed into Linux:
_________ __________
Command used to delete your test.txt file. Exact command typed into Linux:
__________ _________ (do not use wildcards for this)
If there are extra files, such as a test.txt~ file, make sure you delete that, too;
perhaps rm *.*
Move out of your test1 or test2 folder to your home folder .
Exact command typed into Linux:
cd $HOME
Command used to delete your test1 or test2 folder. Exact command typed:
__________ _________
There should be nothing left in your starting folder… remove all strays.
Command used to log out
___________________
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Hands On Q&A 30% (Fill this sheet out, you may be submitting this later)
Use the class website, or whatis to get a description of a command, or apropos
to search for keywords to locate a command
Command or character used to search for a file ____________________
Command /character to take the output of man ls and use it as the input of the
more command: man ls ___more
Command or character used to redirect output, say from the monitor to a printer
_________
Command or character used to search for words or phrases within files
____________________
Command or character used to remove duplicate lines from a file
____________________
Command or character used to show differences in files
____________________
Command or character used to change lower case to upper case
____________________
Submit files and quizzes as directed
See page 57 for details if taking a Collins class

Check Class website or YouTube for a short video similar to Lab7
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Note Full DOS/Windows -Linux guide is at the beginning of this Overview
End chapter 11
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Linux Graphical User Interface
Similarities to Windows
Standard features
Versions
Installation
Exploration
Linux Lab 8
Linux Concepts
Linux Activities
Linux Questions
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Linux Graphical User Interface
Similarities to Windows
Standard features
Versions
Installation
Exploration

Similarities

All modern operating systems do the same thing, they manage resources… in our
case, primarily hardware and files. As they do the same functions, the way they
handle the tasks can be very similar.
All modern graphical user interfaces have the following:
a main menu
a bar for quick launching applications and tracking open applications
the ability to switch between windows, and some sort of method to resize windows
many support the equivalent of right click
many use … to indicate a dialog box will open
many use arrows to indicate ‘more options’
something like “File Explorer” or “This PC”
something like the Control Panel
and the use of icons, menus and a mouse (or touch)

Graphical Linux

The Linux GUI is derived from the MIT X-Windows system (UNIX GUIs started in
1978), and is actually fairly close to the Xerox Alto computer (1972; the 'first' PC with
GUI). (Windows started life as Interface Manager in 1981 and also copied many
ideas from the Alto.)
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The Linux GUIs that most people know (GNOME, KDE) are derivatives of HP-VUE
(from the early 1990's).

Alto

X-window

HP-VUE

KDE

The OSX Apple operating system is called AQUA, and runs on a UNIX kernel,
though they released their first GUI based system in 1984. More on Apple soon.
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Views of the Red Hat 9 Server: Gnome
Home is like
(My Computer)
Start and the Red
Hat are like the
Start button
Trash is like the
Recycle Bin

This panel is like
the Task Bar
Note arrows still mean
More Options

In any GUI OS, somewhere you
will find something like the
Windows Control Panel

Note … still means a
Dialog box will open

All the features you would expect
from a graphical user interface
are present, just not exactly
where you would find them in
Windows
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System Monitor is like the Task Manager, Terminal is the Command Prompt.

There will be a tool like My Computer to browse folders, minimize, maximize, close
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Popular Linux distros and some of the included software

http://www.ubuntu.com/
Mozilla Firefox web browser and Open Office/Libre Office Productivity software

http://fedoraproject.org
Mozilla Firefox web browser and Productivity software

Other Popular Linux distros
See also http://www.linux.org/dist/list.html for

Slackware

Linux is UNIX like, so what about UNIX?
http://www.unix.org/what_is_unix.html
In 1994 Novell (who had acquired the UNIX systems business of AT&T/USL)
decided to get out of that business. Rather than sell the business as a single entity,
Novell transferred the rights to the UNIX trademark and the specification (that
subsequently became the Single UNIX Specification) to The Open Group (at the
time X/Open Company). Subsequently, it sold the source code and the product
implementation (UNIXWARE) to SCO.
You also wish to Google BSD (foundation of Apple Darwin kernel), Solaris, HP-UX,
and AIX
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A later versions of Red Hat, this is Fedora Core 13; note the panel has been split so
only the ‘task manager’ is at the bottom. The Red Hat replacement for the Start
button is now a Fedora logo/Applications, and at the top of the screen. Places is like
File Explorer, and System is like the Control Panel. GNOME 2

The Fedora minimize button, maximize button, and close button are very similar to
the Windows buttons. Not exactly the same, but similar.
You can Right click to get a shortcut menu, you can Alt Tab between windows.
Almost every version of Linux includes open source software such as AbiWord or
Open Office or Libre Office, and often a nice array of games.
Of course you can’t get Microsoft Office, or iTunes, or Turbo tax for Linux, but you
can often find a lot of free, open source software, and using RPM or Yum can make
installing software fairly easy.
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Ubuntu
One of the most popular versions of Linux is Ubuntu.
Note: while Fedora and Ubuntu both use Gnome as the desktop shell, there are
differences. The Applications menu logo is different, and the top panel includes a
shut down button on the top right.
A bigger difference is the minimize button, maximize button, and close buttons have
changed shape and are placed differently.

Another nice feature in Fedora and Ubunu is the Live disk option.
Simply insert the disk and boot, and use a the OS without installing it… when you
shut down and remove the disk, you can restart back to your old OS.
The installers are very good, and many installers can add Linux to your system and
leave Windows in place, letting you choose which OS to use when you boot… but
please note that if you do install Linux on your computer at home, there is a chance
that it REMOVE Windows… so install at home at your peril.
More on GNOME 3 on page 227.
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While Gnome is still very prevalent, GNOME 3 was not well received.
Ubuntu created their own interface, called Unity.
This created an opening in the market for something that was similar to both
GNOME2 and GNOME 3… the Cinnamon interface in Mint.
Press the Start key on the keyboard and it behaves like GNOME 3
Press the Menu icon on the desktop, and it behaves like GNOME 2.
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 Linux Lab 8
Linux Concepts
Linux Activities
Linux Questions
Check with your instructor on Installation
The Linux GUI
1. True or False:
Most Linux installations are free
2. True or False:
You can download many Linux installation program files from the
Internet, then burn them to CD
3. True or False:
The Graphical User Interface is required in order to use Linux
4. True or False:
You can easily add Linux to your computer without worrying about
Windows
5. True or False:
Linux requires a more powerful computer, called a Workstation, to
run
Hands On 30%
Be prepared to discuss:
1. Does right click in GNOME work?
2. Do Maximize, minimize, restore down work in GNOME?
3. What do you use, instead of the Start button in GNOME?
4. What Graphical Internet Browser is installed in most Linux systems?
5. What Word Processor is installed with many version of GNOME?
I strongly suggest you take a LOT of Notes as you explore the different systems
(the more notes you take on Fedora and Ubuntu, the easier the capstone lab will be to write…)

Submit files and quizzes as directed
See page 57 for details if taking a Collins class.

End chapter 12
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Web Pages; Lab 9

Linux Web Pages
Similarities to Batch files/scripts
Standard web structures
Using gedit
Using Firefox
Web Page creation in HTML
Linux Lab 9
Linux Compression
Linux network usage
Preview Lab 9
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Linux Web Pages
Similarities to Batch files/scripts
Standard web structures
Using gedit
Using Firefox
Web Page creation in HTML
Windows has batch files… commands in a plain text file save with the .bat
extension. Linux has scripts, basically commands saved in a text file but
instead of changing the extension, the X permission is turned on. But
rather than create scripts, it might be more interesting to create another
plain text document that can deliver instructions… a web page.
Plain text files cannot have color, cannot have attributes such as bold or
italic, and cannot include images… but a web page can. How can a plain
text document do that? The answer is be delivering instructions to a
browser on how to render the page, and where to find images. The
instructions to the browser go between < and >, and are called tags.
In Microsoft Word, to make a word bold, you select the word first, then
click the [B] button. This actually is marking the beginning and the end of
the area that can be made bold.
In web pages, text to be formatted is surrounded by two tags… on to
start the instruction or command, if you will, and one to end the
instruction… so the entire page won’t be bold, for example. It would look
like this: <b>Hi</b>
One more item before we get started… once you save a text document
with a .htm extension, many Linux text editors will actually start color
coding the commands, attributes, and values in the tags.
Check with your instructor for addition details.
Making a web Page with gEdit in Linux
All browsers need to be instructed as to what type of file to they are
about to deal with, so the first tag set that we need to type in your text
editor identifies the page as a Hyper-text document. Type in:
<HTML> </HTML>
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I usually type in both the starting tag <HTML> and the ending tag </HTML> at
the same time, this way I don't forget the ending tag later. Next, place
the insertion point between the tag set, and hit the enter key a few times
to give you space to work. What is typed in between these two tags will
be part of the web page.
<HTML>
</HTML>

Next, we need to know that there are two parts of the web page, the part
the computer reads, and the part the users read. We'll insert the
computer's part next. Just as Microsoft Word has parts of the document
reserved for page numbers, etc., web pages also have something similar
to a header section, called the head.
Between the two <HTML> tags, add the head section, as follows. Don't
worry about how many spaces or how many lines are between
things…browsers ignore this "white" space. It also doesn't matter if you
use capital letters or not.
<HTML>
<HEAD>
</HEAD>
</HTML>

Usually, the only thing that goes in between the head tags is something
to create a title. So add the following so that your entire page looks like:
<HTML>
<HEAD>
<TITLE>
</TITLE>
</HEAD>
</HTML>

Now, just as in Microsoft Word, we need to add the section where all the
words go; just as Microsoft Word has a body area, web pages also have
something similar, also called the body.
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<HTML>
<HEAD>
<TITLE>
</TITLE>
</HEAD>
<BODY>
</BODY>
</HTML>

Notice the two HTML tags surround the entire document. Within the
document you have a HEAD section and a BODY section. And within the
head, you have an area for a TITLE. We are now ready to save this
document, which will be the starting point for all of your web documents.

Choose File\Save As
save as test1.htm in the default user folder.

Now modify test1.htm by inserting a title between the <TITLE> tags. Call it
something like My 1st page.
<HTML>
<HEAD>
<TITLE>
My 1st page
</TITLE>
</HEAD>
<BODY>
</BODY>
</HTML>
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Now click the File menu item, and then select the save option. (Not save
as, the file already has a name.)
Next, minimize your text editor window; DO NOT CLOSE THE WINDOW,
as we will be switching back to it.

Linux Users:
Open your 'home' folder, locate test1.htm, and right click it.
Choose Open with Firefox.
Firefox is the default web browser on most Linux systems.

This should launch the browser, placing test1.htm in address text box.
It may look like nothing is being displayed, but look above the main
browser window, in the title bar. It should read "My 1st page". This is
appropriate as we have only put in a title.

Next, leave the browser running, but switch back to your text editor.
Try using Alt+Tab…
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Between the <BODY>tags, type Hi.
<HTML>
<HEAD>
<TITLE>
My 1st page
</TITLE>
</HEAD>
<BODY>
Hi
</BODY>
</HTML>

Save your text editor file, click on the browser icon, then click on the
refresh/reload button. You should now see the word Hi displayed.

Switch back to your text editor, and highlight the word Hi by clicking just
to the left of the word, and drag across it with the mouse button sill
depressed. When the word is highlighted, press down the [Ctrl] button
and hold it down. Now tap the [c] key and let go of both. Now press the
[End] key. This will break the highlight, and place the cursor at the end of
the line. Press the [Enter] key to create a new line below the word Hi.
Now, press down the [Ctrl] button and hold it down. Now tap the [v] key
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and let go of both. A copy of the word Hi should now be pasted in below
the original. (You could also have used the edit menu.)
<HTML>
<HEAD>
<TITLE>
My 1st page
</TITLE>
</HEAD>
<BODY>
Hi
Hi
</BODY>
</HTML>

Save the changes, and switch back to your browser. Refresh/reload
(Internet Explorer can be refreshed by using the [F5] key. )
You should now have two Hi's, but are they one on top of the other?
No. I'll bet they are side by side.

Why? Because the browser ignored the white space separating the two, and thus
they are displayed side by side.
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In Microsoft Word, you start a new line by inserting a line break... so let's force a line
break here. In your text editor, make the following change, and save.
<HTML>
<HEAD>
<TITLE>
My 1st page
</TITLE>
</HEAD>
<BODY>
Hi <BR>
Hi
</BODY>
</HTML>

Notice that the break tag <BR> does not have an ending component, as
this tag is not surrounding text in order to format the text for display. You
don't start breaking your leg, then finish breaking your leg later... it is
just a break! Save your changes.
Switch to your browser, refresh, and you should now see the two Hi's
displayed in stacked fashion.
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Now, when we read a newspaper, we know when a new story starts,
because of headlines. Headlines are different sizes, bold, and always are
on on a different line than the story. So, let's try to add one of the 6
headlines by make the following changes, and note the results in your
browser. Remember, every time you make a change in your editor, save
your document, switch to your browser, then refresh/reload.
Recall also, tags normally surround the text that they will format for the
browser.
Only the <BODY> section will be changing this time, but the other tags
must still be on your document.
First we'll get rid of the <br>, and surround the first word Hi with a
headline size 6 tag set.
1. <HTML>

<HEAD>
<TITLE> My first web page </TITLE>
<BODY>
<H6>Hi</H6>
Hi
</BODY>
</HTML>

You should see a really small first line now, as h6 is the smallest
headline, and this tag surrounds the first word Hi.

Now, let's try a headline size 2, by replacing the h6 tags with H2 tags.
Recall from above, we don’t need a line break after a headline
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2. <HTML>

<HEAD>
<TITLE> My first web page </TITLE>
<BODY>
<H2>hi</H2>
Hi
</BODY>
</HTML>

This is the second largest... I avoided using H1 tags, as they look a
little too much like Hi, but you can try an H1 set if you like!
In the steps below, DO NOT ADD ADDITIONAL BODY TAGS! Simply
edit the existing body tag to reflect the changes. From this step on,
the items are being inserted between the "<body" and the ">" in
<body>... again, ALL of these changes made are BETWEEN the < and the >.
Also and use the number "0", not the letter "o"
Changes to be made are in bold. Don't forget to save after each change, and
refresh/reload your browser.
•NOTE: Do NOT use curly quotation marks, such as ”; only use

straight quotation marks, such as ".

We are about to modify a tag to alter its behavior. These modifiers are called
attributes. Attributes are followed by a value structure (="value"), to indicate
how the modification will work. Instead of having a white background, we are
going green. So we will change <body> to <body bgcolor="green">
attribute
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3. <HTML>

<HEAD>
<TITLE> My first web page </TITLE>
<BODY BGCOLOR="green">
<H2>hi</H2>
Hi
</BODY>
</HTML>

Again, this modifies the background color to be green. The modifier is
called an attribute, and attributes are followed by ="value",
in this case, bgcolor="green"

4. <HTML>

<HEAD>
<TITLE> My first web page </TITLE>
<BODY BGCOLOR="#00FF00">
<H2>hi</H2>
Hi
</BODY>
</HTML>

Think of a room with 6 lights, 2 red, 2 green, and 2 blue. If 0 is off,
and F is fully on, then #00ff00 means
no red light, lots of green light, and no blue light... making the
background green. Try this now.

5. <HTML>

<HEAD>
<TITLE> My first web page </TITLE>
<BODY BGCOLOR="#000000">
<H2>hi</H2>
Hi
</BODY>
</HTML>

Did you guess that if no lights are on, that the room would be black? If
the background is black, let's make the text white. Again this is all
between the <body and the >, even though I am adding another
instruction on the next line down.
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6. <HTML>

<HEAD>
<TITLE> My first web page </TITLE>
<BODY TEXT="#FFFFFF"
BGCOLOR="#000000">
<H2>hi</H2>
Hi
</BODY>
</HTML>

What else goes in web page?
Oh yes... now, let's add a picture.
Open Google and select to search for Images. Type in something, such as
money or Lincoln, and search. You will be presented a list of images;
right click one of those images, and choose Save Picture As...
Save the picture in the same folder as the web page you are
working on, and give it a short, memorable name.
(I'll call mine 'prez.jpg'). Again, save the picture in the same folder.

NOTE, this is 'fair use' of a copyrighted image, since only you are viewing
it. You may NOT use this image on web pages that you post to the
Internet.
Now, switch back to your text editor and insert the following line.
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<HTML>
<HEAD>
<TITLE> My first web page </TITLE>
<BODY TEXT="#FFFFFF"
BGCOLOR="#000000">
<H2>hi</H2>
Hi
<img src="prez.jpg">
</BODY>
</HTML>

Then, switch back to the browser, and refresh.
Finally, we'll create a link, using the anchor tag. An anchor tag allows you to not
only move to another site, but to later return to sight you came from by using
the back button, hence the anchor name. Just as the image tag required the
source attribute to point to the location of the image, the a tag requires an
href attribute to point to the hypertext reference of the site you wish to link to.
And just as the H2 tag set needs to surround the text to render as a headline,
the a tags need to surround the text that will become the clickable link.

You could replace the blude URL below with a favorite web site, such as http://www.google.com. (You must
include the http://)

<HTML>
<HEAD>
<TITLE>My First Web Page</TITLE>
</HEAD>
<BODY TEXT="#FFFFFF"
BGCOLOR="#000000">
<H2>hi</H2>
Hi
<img src="prez.jpg"><br>
<a href="http://www.templejc.edu"> Clickable Text </a>
</BODY>
</HTML>
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 Linux Lab 9
Linux Compression
Linux network usage

After completing the web page, close your browser and editor. Locate the
two files in the filing system, and select both file.
(Hold down the control key when selecting items to add to the selection.)
Right click the selection and choose the Compress option.
The default file type is .tar.gz, but change it to .zip.
Note the shape of the ‘packaged’ folder, which could be submitted.
Continue exploring the Linux systems.
•
•
•
•
•
•
•

Older systems could mount and browse a floppy, then unmount the floppy
(mount unmount equivalent)
Locate the System Monitor, a Windows Task Manager (ps equivalent)
Under the System setting, note the Windows Control Panel style items of
Preferences and Administration
On the Filing system menu, look over the Network item, the My Computer type
items, Search, etc.
Open your users HOME folder (cd $HOME equivalent) and view any contents in
the folder (ls equivalent)
Right click to create a directory there, using your name (mkdir equivalent)
Experiment with OpenOffice or Libre Office.

Submit files and quizzes as directed
See page 57 for details if taking a Collins class. Zip and save as yourname-lab9.zip

Check Class website or YouTube for a short video similar to Lab9
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Preview of Lab 10
Lab 10 is a short term paper (1000 word+) in which you will compare DOS to
Windows to Linux.
This will be done by listing the strengths and weaknesses of DOS, the strengths and
weaknesses of Windows, and the strengths and weaknesses of Linux.
You will the recap key points, and then choose an OS for a certain type of user…
using the recap to bolster your conclusion.
This is not a research paper… you do not go online or go to the library to look things
up… you review your notes to write the paper.
You will have
a cover page
a 1000 word + paper, double spaced, 1” margins, 12 point font
The paper should start with an introduction and overview,
followed by at least 6 good paragraphs, where you list the strengths of DOS, the
weaknesses of DOS, the strengths of Windows, the weaknesses of Windows, the
strengths of Linux, and the weaknesses of Linux.
To make grading easier you will clearly label each section, such as
Strengths of DOS
Do NOT include items that affect all operating systems… such as malware, virus,
etc. as ALL operating systems can get a virus. All of them.
End with your recap and conclusion.
Again, I am looking for a circumstance, your choice of OS and why, and bolster your
choice by recapping key points you made earlier.
An example might be,
as a user of Microsoft Office, I would choose Windows because…
or
as I have an old computer that can’t run Windows I would choose Linux because…
Many faculty members will have you submit this paper to plagiarism detection, to
verify that you wrote the paper, and didn’t simply copy other people’s work.
End Chapter 13
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Other Operating Systems
Apple Macintosh
Windows replacements
Chrome based
Android based
Apple Macintosh
Below is a sneak peak at a Mac, a UNIX variant that runs the Aqua
graphical user interface.

The biggest things to remember about a Mac are:
1) there is one title bar… it stays at the top and changes based on what is
selected as the active window,
2) the keyboard is different and there are different keyboard shortcuts
3) the mouse has one button, you use Control+Click instead of right-click
4) you can close a windows and leave the program running… so you must
Quit programs when finished with them.
While more similar to Ubuntu than Windows, I’ll bet you could drive it.
But just like driving someone else’s car where you may have to look
around to find the lights, you might have to click a few menus to find the
right item to do the job. Remember, Operating Systems all do the same
thing, so they by nature are very similar in how you use them.
Therefore don’t choose an OS because you like the OS, choose the OS
that runs the software you want to run.
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iPads and iPhones
The iOS operating system is based on the same UNIX kernel as the
desktop operating systems, but has been geared for smaller screens and
more touch controls. There is only one button, the home button, and it
takes you to your primary screen of your desktop.
The desktop of an iPad or iPhone may be scrollable, meaning you can
swipe left or right to access more items, or Press and hold to select.
To search, swipe down with one finger.
To switch to other programs, swipe up with four fingers… to close one of
the tasks you see running, use one finger to swipe the mini window up
and off.
You can only get small programs for these devices, called apps, from the
Apple store.
A few silly tricks: if you prefer to thumb type, place one finger on each
side of the keyboard and pull the keyboard apart. Return it by dragging to
two parts back together.
For those of you who may remember the Etch-a-Sketch, you erased by
shaking. If you shake your iOS device, it will ask if you wish to undo
typing.
You can press and hold an icon to delete it, or drag one icon on top of
another to create folders. Drag all the items out of the folder and the
folder disappears. You can also pinch screens to resize.
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Windows Replacements
Many people still have computers running Windows XP, and haven’t
upgraded because their older systems aren’t suited to newer Windows,
and they feel uncomfortable trying Linux.
For these folk, a group is working on an open source operating system
that will behave in a similar fashion to XP, and run Windows software…
much as Linux behaves like UNIX but is a completely different OS.
At this writing, the REACT OS is still in Alpha testing.
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Chrome
Chrome, for all practical purposes is an scaled Ubuntu Linux operating
system whose primary job is to run a web browser… and almost all
activities in the system run in the browser. (Recall, Linux is open source,
and anyone can reconfigure and redistribute the operating system.) So,
your word processing uses Google Docs online, etc. While easy to interact
with, and there is little maintenance or configuration to worry about,
Chrome is pretty useless if you are not online.

Android
Android is also based on the Ubuntu distro of Linux, and is primarily for
smart phones and tablets. About the biggest difference being the touch
screen interface, which in many ways is similar to iOS; though it should
be noted that Android beat iOS to multitasking.
A few key difference for iOS:
1) The hand gestures while similar, do differ… such as pressing the
Recent Apps button at the bottom of the screen to switch apps, instead of
the hand swipe.
2) Each manufacturer can further modify the OS
3) Android can not only get apps from Google Play, but can run apps from
other sources… which may or may not be a good thing.
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 Lab 10 Review
DOS strengths and weaknesses
Windows strengths and weaknesses
Linux DOS strengths and weaknesses

Lab 10 is a short term paper (1000 word+) in which you will compare DOS to
Windows to Linux.
This will be done by listing the strengths and weaknesses of DOS, the strengths and
weaknesses of Windows, and the strengths and weaknesses of Linux.
You will the recap key points, and then choose an OS for a certain type of user…
using the recap to bolster your conclusion.
This is not a research paper… you do not go online or go to the library to look things
up… you review your notes to write the paper.
You will have
a cover page
a 1000 word + paper, double spaced, 1” margins, 12 point font
The paper should start with an introduction and overview,
followed by at least 6 good paragraphs, where you list the strengths of DOS, the
weaknesses of DOS, the strengths of Windows, the weaknesses of Windows, the
strengths of Linux, and the weaknesses of Linux.
To make grading easier you will clearly label each section, such as
Strengths of DOS
Do NOT include items that affect all operating systems… such as malware, virus,
etc. as ALL operating systems can get a virus. All of them.
End with your recap and conclusion.
Again, I am looking for a circumstance, your choice of OS and why, and bolster your
choice by recapping key points you made earlier.
An example might be,
as a user of Microsoft Office, I would choose Windows because…
or
as I have an old computer that can’t run Windows I would choose Linux because…
Many faculty members will have you submit this paper to plagiarism detection, to
verify that you wrote the paper, and didn’t simply copy other people’s work.
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Purpose: To allow the student to evaluate the operating systems covered in class, based on what
they learned. This isn’t a research paper, you use your notes, not the Internet.
Due the last class period before finals.
The paper must be typed using these guidelines: (Plagiarism will result in a ‘0’ for this lab)
•
•
•
•
•
•
•
•
•
•

Title/Cover Sheet
A 1000+ word report created using Microsoft Word. Will be about 3 pages, double spaced.
Must be double spaced using a 12-point Times font and no more than 1 inch margins.
Must include an introduction and overview.
Must include a bold, clearly labeled section on the strengths of DOS
Must include a bold, clearly labeled section on the weaknesses of DOS
Must include a bold, clearly labeled section on the strengths of Windows
Must include a bold, clearly labeled section on the weaknesses of Windows
Must include a bold, clearly labeled section on the strengths of Linux
Must include a bold, clearly labeled section on the weaknesses of Linux
The conclusion should include a recap of the high points of the paper, to bolster an
expressed opinion of which OS is best for a situation, based on what you learned in class.

Content

points

Intro
Overview
DOS Weakness: BOLD Label
DOS Weakness Content
DOS Strength: BOLD Label
DOS Strength Content
Windows Weakness: BOLD Label
Windows Weakness Content
Windows Strength: BOLD Label
Windows Strength Content
Linux Weakness: BOLD Label
Linux Weakness Content
Linux Strength: BOLD Label
Linux Strength Content
Recap
Conclusion

3
5
3
5
3
5
3
5
3
5
3
5
3
5
5
10

Delivery

points

Coversheet
1000+ words, 12 pt font
Double spaced
1" Margins
Total

3
20
3
3
100

Do not include malware…
ALL Operating Systems
can get a virus…

Format Requirements
The following is a sample to use as a format for your term paper. Please follow these guidelines
carefully. Failure to do so will result in a lower total score. See also Tips on writing a term paper on
the class web site.
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Title Page

Jane Doe (student's Name)
R. Craig Collins (Instructor's Name)
ITSC 1305 (Course)
[Due Date]
OS Comparison (title)

[Body of report...Double-spaced,12 pt font, 1" margins, at least 1000 words (about three full pages)]
Intro and overview xxxxxxx
xxxxxxxxxxxxxxxxxxxxxxxxxxx
xxx
In this paper, I will discuss
topic 1, topic 2, and topic 3. xx
xxxxxxxxxxxxxxxxxxxxxxxx
Strengths of DOS
xxxxxxxxxxxxx
xxxxxxxxxxxxxxxxxxxxxxxxxxx
xxx
xxxxxxxxxxxxxxxxxxxxxxxxxxx
xxx
xxxxxxxxxxxxxxxxxxxxxxxxxxx
xxx
xxxxxxxxxxxxxxxxxxxxxxxxxxx
xxx
Weaknesses of DOS
xxxxxxxx
xxxxxxxxxxxxxxxxxxxxxxxxxxx
xxx
xxxxxxxxxxxxxxxxxxxxxxxxx
xxxxxxxxxxxxxxxxxxxxxxxxx
xxxxxxxxxxxxxxxxxxxxxxxxxxx

Jane Doe p. 2

Jane Doe p.3

Strengths of Windows xxxx
xxxxxxxxxxxxxxxxxxxxxxxxxxx
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Overview 14 What’s New

Linux Review
Before continuing, verify you are caught up with the class Feel free to copy this to a word
document and send it to me... I won't give you the right answers necessarily, but I'll let you know where you still need a little
work.
Hint: highlight the questions on the web page version of this document.
Now that you are mastering the theory, it is time to ramp up the tests a bit..This will
be a fairly challenging test.
Just as there are no multiple choice job interviews, the third test is designed to see
not what you recognize, but what you have learned. The test and review below, have
more picky fill in the blank and short answer /short essay questions, where you have
to write out a short phrase or a short paragraph to answer the question. You'll have
40-45 minutes for the test, so you will need fairly rapid recall to finish in the allotted
time. Go over your completed review frequently, though, and you'll do just fine!
Don’t forget, there are study suggestions on the class web site.
PS, The third part of the final will include the same information as Test 3.

Linux (can you supply the Linux version of the following DOS commands?)
DOS
help (end session w/ 'Alt' F X)
/?
(Keyword search of help commands used in Linux?)
cls
$p$g
\
/
dir
dir /w
tree
cd
md or mkdir
copy
copy con filename
edit filename
type
move
rename
del
rd
deltree
exit to logout of command prompt session
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Linux Concepts
attrib ±x file

Overview 14 What’s New

chmod ugo±rwx folder
ugo=user (owner) group others (such as web visitors)
chmod 755 foldername Shortcut to set standard web settings
ugo
444 read
2-- write
111 execute

passwd (must change at least 3 items)
Required aspects to UNIX password:
2 characters; 1 number; min 6; caps are different
sample: Password1

Linux as a database commands

A command used to merge files to the screen, or simply view a file on the screen
A command used to combine items
Command or character used to search for a file
Command or character used to search within a file
Command or character used to run multiple commands
Command or character used to take output of one command as the input of another
Command or character used to redirect output
Command or character used to compare files
Command or character used to remove differences in files
Command or character used to change lower case to upper case

Be prepared to discuss

Shells (types, such as bash, C, or Korn; allows interaction between user/kernel)
The types of users that permissions apply to (user/owner, groups, and others)
How UNIX treats everything (as a file, - is regular file, d is directory, c is character or I/O
device, or b for block, as in drives)

Be prepared to discuss, in the GUI

GNOME is based on ____________ licensing
Start Menu equivalent / Task Bar equivalent
Do right-click, windows controls, 'Alt' 'Tab' work the same? Help? Using a floppy?
Mozilla browser

End chapter 14
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Overview 15
Wrap up

Finish Lab 10

Lab 10
DOS strengths and weaknesses
Windows strengths and weaknesses
Linux DOS strengths and weaknesses
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See the last chapter for details on Lab 10
Tips:
DOS can run on old computers, but can’t run modern software
Windows has the most software titles available
Linux can run on computers that might not run Windows, and is free
Again, no one should choose an operating system because they like it,
you choose the system that can run on your computer, and run the software you
want to use.

Submit all work as specified
End chapter 15
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Overview 16
Final Thoughts
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Overview 16 Final Thoughts

Notes: a great way to prepare for a final exam is to review each of the labs
Lab 1 getting help in DOS, basic navigation, and file and folder creation
Lab 2 external commands, wild cards, attributes, file management
Lab 3 Sequential instruction execution and batch files
Lab 4 getting help in Windows, basic navigation, file and folder creation, copying
Lab 5 customization of the desktop, disk management, control panel
Lab 6 sharing on the small scale: OLE, plus sharing on the large scale: networks
Lab 7 getting help in Linux command line, basic navigation, and file and folder
creation, permissions, file management
Lab 8, the Linux Graphical Interface and installation
Lab 9 Instruction execution in web pages, using the Linux system
Lab 10 Comparing the strengths and weaknesses of DOS, Windows, and Linux

End chapter 16

274

DOS and the Art of the Command Line

Begin appendix A
DOS reference
DOS COMMAND REFERENCE
ATTRIB
CD
CHKDSK
CLS
COPY
DATE
DEFRAG
DEL
*DELTREE
DISKCOPY
DIR
ECHO
FORMAT
LABEL
MD
MOVE
PATH
PAUSE
PROMPT
RD
REM
REN or RENAME
TIME
TREE
TYPE
*UNDELETE
VER
VOL
XCOPY
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ATTRIB
Command Name
Purpose
Syntax
Common parameters
Example
CD
Command Name
Purpose
Syntax
Common parameters
Example

Appendix A DOS Reference

ATTRIB
used to display or change attributes
ATTRIB [±R or A or S or H] [path\][filename]
n/a
ATTRIB +R file1.txt

CD
To change directories
CD [drive:\][directory-name\] directory name
n/a
CD TEST
CD .. to change out of the current directory
CD \ to change to the root directory

CHKDSK, used to display a status report of a disk, or
Fix errors in the File Allocation table
Syntax CHKDSK [drive:] [/f]
Replaced by SCANDISK
CLS
Command Name
Purpose
Syntax
Common parameters
Example

CLS
Clears the screen
CLS
n/a
CLS

COPY
Command Name
Purpose
Syntax
Common parameters
Example

COPY
Duplicates files
COPY [path\]source [path]destination
n/a
COPY file1.txt file2.txt

DATE, used to display or change the system calendar
Syntax DATE [mm-dd-yy]
DEL
Command Name
Purpose
Syntax
Common parameters
Example

DEL
To delete a text file
DEL [drive:\][directory-name\] file-name
n/a
DEL TEST.TXT
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DEFRAG used to defragment files into contiguous (adjacent) sectors
Syntax DEFRAG [drive:]
*DELTREE, not available in Windows, used to remove non-empty directories
DANGEROUS, use with caution
Syntax DELTREE [path]
DISKCOPY
Command Name
Purpose
Syntax
Common parameters
Example
DIR
Command Name
Purpose
Syntax
Common parameters
Example
ECHO
Command Name
Purpose
Syntax
Common parameters
Example

DISKCOPY
Duplicates floppy disks
DISKCOPY source destination
n/a
DISKCOPY A: A:

DIR
Generates a directory listing
DIR [drive:\][directory-name\]
/w (wide directory listing)
/p (directory listing pauses after each full screen)
DIR or DIR /w or DIR /p
ECHO
To control what displays on the monitor
ECHO [off] [message] [on]
n/a
@ECHO OFF immediately suppresses display,
not even @ECHO OFF will be seen
ECHO OFF will suppress the batch file
display immediately after the command
ECHO off is run.
ECHO HELLO will display HELLO, even if
the ECHO is off
ECHO ON reverses ECHO OFF

FORMAT
Command Name
Purpose
Syntax
Common parameters
Example

FORMAT
To prepare a disk for use
FORMAT drive:
/q (quick format on a previously formatted disk)
FORMAT A: or FORMAT A: /q
Note: You have the option to label the disk
277

DOS and the Art of the Command Line

Appendix A DOS Reference

LABEL, used to change a disk’s volume label
Syntax LABEL [drive:] [new volume label]
MD
Command Name
Purpose
Syntax
Common parameters
Example
MOVE
Command Name
Purpose
Syntax
Common parameters
Example
PATH
Command Name
Purpose
Syntax
Common parameters
Example

MD or MKDIR
Makes a directory
MD [drive:\][directory-name] directory-name
n/a
MD TEST

MOVE
Move a file to a different directory

MOVE [path\]directory-name [path\]directory-name

n/a
MOVE dira\file1.txt dirb\file1.txt

PATH
Directs the OS to external commands.
PATH [external file storage location]
n/a
PATH C:\DOS

PAUSE, temporarily halts a batch file execution,
and displays the message Press any key to continue
Once a key is pressed, execution resumes
PROMPT
Command Name
Purpose
Syntax
Common options
Example
RD
Command Name
Purpose
Syntax
Common parameters
Example

PROMPT
Displays info in the system prompt
PROMPT [option 1] … [option n]
$P Current Drive AND path
$G > (greater than sign)
PROMPT $p$g
includes the directory Path and a >
RD or RMDIR
To remove an empty directory
RD [drive:\][directory-name\] directory name
n/a
RD TEST
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REM
Command Name
Purpose
Syntax
Common parameters
Example

Appendix A DOS Reference

REM
To prevent a line in a batch file from executing
REM [DOS command]
n/a
REM CLS
tells the batch file to skip CLS
Or
REM $T is to add time to the prompt

Can be a note to you to explain PROMPT $T
REN or RENAME
Command Name
Purpose
Syntax
Common parameters
Example

REN or RENAME
Renames files
REN [path\]source destination
n/a
REN file1.txt file2.txt

TIME, used to display or change the system clock
Syntax TIME [hh:[mm:[ss]]]
SCANDISK, used to check and repair a drive
Syntax SCANDISK [drive:] [autofix]
TREE
Command Name
Purpose
Syntax
Common parameters
Example

TREE
To display a tree structure
TREE [drive:\][directory-name\]
/f (will display directories and directory contents)
Tree /F or tree a:\ /f

TYPE
Command Name
Purpose
Syntax
Common parameters
Example

TYPE
To display the contents of a text file
TYPE [drive:\][directory-name\] file-name
n/a
TYPE TEST.TXT

* UNDELETE, not available in Windows (replaced by the recycle bin)
May be able to recover recently deleted files
VER, used to display the DOS or Windows version
Syntax VER
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VOL, used to display the volume label
(labels are normally set with FORMAT, and changed with LABEL)
Syntax VOL [drive:]
XCOPY
Command Name
Purpose
Syntax
Common parameters
Example

XCOPY
Duplicates files and directories
XCOPY [path\]source [path]destination
/e
XCOPY dir1\*.* dir2\*.* /e

Notes
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Appendix B New in Windows

Begin appendix B
New in Windows
Touch Screen
Windows 8 was the first Microsoft OS to really embrace the touch screen
interface, though Vista and supported tablets… but those earlier operating
systems primarily relied on a stylus.
A great way to learn the touch gestures in Windows 8 was to swipe in from the
edges…
running apps would display if you swipe from the top left, charms would display
if you swipe from the bottom right, the start menu would appear if you swipe
from the bottom right, etc. You could also swipe up from the bottom on the
Start screen to see more apps. Press and hold an app to resize or move.
You can lock an open app into the right or left third of the display by tapping the
app and dragging it to the left or right edge of your screen until a thin vertical
bar appears, then open another app in the remaining space. Resize by dragging
the vertical line. Before the X button was added to close an app, you could close
apps by dragging your finger down from the top of the screen until the app
minimizes and begins to disappear into the bottom edge. And as in other touch
bases systems, you can Pinch to zoom in or out.

Check Class website or YouTube for a short video on using Win 8.1

Voice and facial recognition
Starting in Windows 10, the Cortana voice recognition system was added,
allowing you to say “Hey Cortana” and then add something like “What’s the
Weather?” or search for something on the Internet, or add reminders to your
calendar.
If you have a web cam, it can start to recognize you, so perhaps in the future
passwords may go away.
More will be added to the online version of this appendix as time goes on.
End appendix B
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Begin Appendix C
Misc. Odds and Ends
Additional help on completing the Hands on portion of ITSC 1305 Lab 4...
Highlights only... sequence may vary from Lab.
1. Open File Explorer
the easiest way is to
press the Start key on your Keyboard

or click the Start button on your screen

and then just start typing File Explorer
or
click the File Explorer icon on the taskbar

2. Make a folder
Right click a blank spot in the place your wish to make the folder,
or click the New button, and select Folder
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While the name of the folder is still highlighted blue, change the name as specified.

3. Open Wordpad
Select Start, and type WordPad. In WordPad, type some text, then select the text;
now format the text to change the font face, the font size, and the font
color

4. Start Paint (as you did with WordPad)

You can adjust how big the image is using File>Image Properties, and you can zoom in and
out using the slider at the lower right hand corner.
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Create something… even a scribble.

Use the selection tool to draw a box around part of the image.
Note how the Cut, Copy, and Paste tools become available now.

5. Copy your selection.
There are three ways to copy:
Right click and choose Copy
Keyboard shortcut [Ctrl]+[C]
or the menu item
6. Switch back to Wordpad...
minimize Paint, or
if you can see part of the Wordpad image, click it, or
if you see the icon on the Taskbar, click it, or
Press the [Alt] key and hold it down, then tap the [tab] key until Wordpad appears, and let
go.
The selected part of the image is now in RAM, on the clipboard.
In Wordpad, make sure your text is not selected and paste... there are three ways to paste...
Right click and chose Paste,
Keyboard shortcut [Ctrl]+[V], or menu item.
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The selected part of the image is now pasted into Wordpad.
(You may close Paint; no need to save the image.)
7. Open the Control Panel. Start\Control Panel
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I prefer to change from Category view to Large Icons. Click the arrow next to View by to see
the options.

After exploring the tools available, click the Mouse control panel icon, and look through the
options
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Click on the Pointers tab. (Your options may differ.)

Press [Alt]+[Prt Scrn] to copy the active window to the clipboard. Switch to Wordpad, as
before
8. In Wordpad, make sure nothing is selected, and paste the contents of the clipboard, as
before.
You should now have formatted text, the copied Paint object, and the screenshot showing
you were on the Mouse
control panel. Your items may be in a different sequence.
9. Save As the file as directed in the proper folder.
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10. Open File Explorer, and browse to your folder, and open it.
Copy the file.

Select the file, and Menu item copy or [Ctr]+[C] or Right Click and Copy
11. Paste the file in the same folder

Menu item paste or [Ctr]+[V] or Right Click and Paste
Rename the newly copied file.
12. Make a shortcut of the file, in the same folder.
To make a shortcut in a different place, you can drag a file with the right mouse button to
another folder, and chose Move, Copy, or create shortcut
But, to make a shortcut in the same folder, copy as above,
Right click and select Show more options, in the popup window, Select Paste Shortcut
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You should now have three items in your lab4 folder...

13. Resize the window to be smaller, get a screenshot using [Alt]+[Prt Scrn], as before.
14. Switch to Wordpad as before.
Make sure nothing is selected, and Paste the screenshot into your file

15. Save the changes in your Wordpad file. Close all the programs, then zip your lab4
folder, call it yourname-lab4.zip.
16. Submit the file to the Lab4 dropbox
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Additional help on completing the Hands on portion of ITSC 1305 Lab 5...
Highlights only... sequence may vary from Lab. Review Lab 4 for additional help.
1. Open File Explorer
the easiest way is to
press the Start key on your Keyboard

or click the Start button on your screen

and then just start typing File Explorer
or
click the File Explorer icon on the taskbar

2. Make a folder
Right click a blank spot in the place your wish to make the folder,
or click the New button, and select Folder

While the name of the folder is still highlighted blue, change the name as specified.
3. Open WordPad
Select Start, and type WordPad. In WordPad, use File>Save as to appropriately create your
file in your new lab folder. Minimize WordPad.
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4. Right click your desktop, and select Personalize

Explore the items

After opening a menu, you return to the main menu by clicking , top left, by “Settings”
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There are options to change your Background image, and how to fit the image

Not all versions of Windows let you change accent colors
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I find Themes to be the most useful selection, as a theme lets you change many aspects
simultaneously, such as background, colors, sounds, mouse options, etc.

Select Desktop icon settings

Select Network, click okay, and close the Properties window.
Get a screenshot of the now newly added Network icon that is now on your desktop.
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You could use [Alt]+[Prt Scrn] to copy the active window to the clipboard, but this would get
the whole screen. You might want to try the Snipping tool, instead.
Switch to Wordpad, and paste your image with the Network icon.
Save your changes.

5. Open the Control Panel. Start\Control Panel

I prefer to change from Category view to Large Icons. Click the arrow next to View by to see
the options.
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After exploring the tools available, click the Programs and Features control panel icon, and
look through the options

In previous versions of Windows, this was called Add Remove Software, but most Windows
software now comes with an installer… so the tool is primarily to remove programs and
clean up the registry.
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Get a screenshot and paste into your Wordpad file.
6. Open File Explorer, browse down and select This PC

Right click the C: drive, and select Properties.
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Notice the label of the drive (recall, the format command includes adding a label to a drive.)

Get a screenshot, and paste into your WordPad file.
7. Select the Tools tab.
This is where some of the old DOS utilities live; the Backup is now in the Control panel.

Get a screenshot, and paste into your WordPad file.
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You should now have the four following items in your file:
A screenshot of your Network icon
The Programs and Features screenshot where you could remove software
The General tab of the Properties of your hard drive
and the Tools tab of the Properties of your hard drive…
8. Save your changes, close WordPad. Browse to the folder, zip, and submit.
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Notes:
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C:\> ommand line

WORKBOOK

Why learn Command Line?
The command line is often the fastest way to accomplish a job, and the only way to
apply a command to multiple objects, such as renaming hundreds of files at once. In
some environments, the command line is the only method of taking control of the
task at hand, such as troubleshooting, or advanced networking. The command line
can make you a better Windows user, and these skills apply to other operating
systems, as well.
DOS+Windows Command Prompt Quick Reference
Get help
C:\> HELP
close help
[Alt]+F, then S
Get help on a known command
Command /?
Prepare a floppydisk (NOTE: THIS WILL ERASE A USED DISK)
C:\> FORMAT A:
Change to focus to floppy disk
C:\> A:
Search the disk for directories and files
A:\> DIR
or dir /p or dir /w
Make a directory
mkdir
or
md
change to a directory
cd
back up the directory tree
C:DOS\> CD ..
repeat a command
[F3]
display the directory tree
A:\> TREE
display the directory tree and files
A:\> TREE /f
create a text file
copy con filename (8.3 file convention)
Enter text
{Ctrl]+[z] (will display as ^Z)
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